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Introduction 

ePS Metrix is an industry-leading job planning engine that transforms big data into actionable data in the most 
proven end-to-end integrated solution with a holistic view into manufacturing. With over 1,200 Metrix users in 25 
countries and 17 years of continuous, aggressive development, Metrix is recognized as the de facto industry 
standard for dynamic, intelligent production planning and automated imposition. 

The Complete Planning and Imposition Solution 

The ePS Metrix solution stores your presses, finishing equipment, stock, folds, users’ logins and permissions, 
along with your manufacturing standards. Centralizing this information ensures uniformity, efficiency, and 
ultimately error-free planning and imposition across your entire organization. The ePS Metrix solution 
automatically and dynamically determines how many press sheets you need, the optimum layout for each press 
sheet, and even figures out the most cost-effective printing method, press, and sheet size. 

About This Guide 

Metrix comes in four major versions: Standalone, Commercial-Suite-Integrated (Monarch), Fiery-Integrated, 
Packaging-Suite-Integrated (Radius), and Midmarket-Suite-Integrated (Pace). This guide covers the first two 
only. If you have one of the other versions of this product, please see the documentation for your version of the 
product. 

Contact Information 

ePS Support 

Web Site: communities.efi.com 

US Phone: 1.855.EFI.4HLP (1.855.334.4457) 

UK Phone: +44 (0) 800.783.2737 

EU Phone: +49.2102.745.4500     

E-Mail: metrix.support@efi.com 

Metrix Support hours are 8AM CET to 5pm ET Monday – Friday. You may contact support at the above numbers 
or via our customer portal at communities.efi.com. 

Note For problems involving infrastructure (e.g., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. ePS cannot support these types of 
issues. 

ePS Professional Services 

US Phone: 651.365.5321 

US Fax: 651.365.5334 

E-Mail: ProfessionalServicesOperations@efi.com  

Note ePS Professional Services can help you perform ePS software installations, upgrades, and updates. 
This group can also help you implement, customize, and optimize your ePS software plus offer a range 
of training options. 

 

 

  

https://communities.efi.com/s/?language=en_US
mailto:metrix.support@efi.com
https://communities.efi.com/s/?language=en_US
mailto:ProfessionalServicesOperations@efi.com
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Metrix 22.1 

Metrix optional modules 

• Auto Plan 

• Capacity Plus 

• N-Up Binding 

• Automation Pro 

• Automation Lite 

• Irregular Shapes 

Metrix key features 

• Maximum sheet dimension- (W x H): 984.25” (25,000 mm) 

• Maximum products handled by Auto Layout: 16 

• Maximum products per project: 100 

Feature Included or Optional 

Plans/imposes flat, folded, and bound jobs Included 

Automatically determines the most cost-effective Production Method, 
Press, and Sheet-Size (Auto-Production) 

Included 

Automatically matches new layouts to saved profiles (Standards) Included 

User Permissions, Logins, and Passwords Included 

Handles chop cuts automatically (Auto Bleed) Included 

Print reports Included 

Imports JDF Included 

Imports Metrix XML and CSV data Included 

Exports Imposed PDF  Included 

Exports Metrix XML Included 

Exports JDF Imposition / JDF Stripping Included 

Exports JDF/CIP3 Cutting data Included 

Exports JDF/CIP3 Folding data Included 

Exports JDF Binding data Included 

Site Licenses available Included 

Super Wide Format  Included 

Barcodes module Included 
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Display Graphics module Included 

Content Previews module Included 

Auto Plan module Optional 

Capacity Plus module Optional 

N-Up Binding module Optional 

Automation Pro module Optional 

Automation Lite module Optional 

Irregular Shapes module Optional 

  

Optional Modules 

Auto Plan Module 

• Automatically and dynamically determines how many layouts are required for the products in the project 

• Plans and simultaneously imposes across multiple press sheets and even multiple presses 

• Uses real costing data from the Metrix database 

• Applies standards where appropriate 

• Uses proprietary and sophisticated algorithms to consider dozens, hundreds, or even thousands of 
options to find the most cost-effective project solution 

Capacity Plus Module 

• Allows for projects of greater complexity – more products for Auto Layout and Auto Production 
calculations, and more products per project 

• Up to 2000 products allowed per project, regardless of the number of press sheets 

• Up to 200 products allowed for Auto Production and Auto Layout calculations 

N-Up Binding Module 

• The N-Up Binding module automates the setup of products that print, fold, and bind 2- or 3-up on a 
press sheet. 

• Allows for the n-up folding of some signatures in a bound product, even allowing you to fold together 2 
or 3 signatures from different bound products. 

• Customers who need this functionality normally own finishing equipment that can accommodate 2- or 3-
up binding, such as a book saw or specialized knife-trimmer. 

• This module provides instant visual feedback on how the project will fit on a press sheet with the new 
manufacturing configuration. 

• The Metrix N-Up Binding module is easy to work with – even editing the options is easy. 

• Metrix takes care of all the details like shingling/creep compensation automatically. 
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Automation Pro or Automation Lite Module 

• Automation Pro (or Lite) is an advanced, hot-folder driven module for Metrix which accepts MXML files 
and fully automates their processing in Metrix. 

• MXML files arrive in the Automation hot folder, a Metrix project is created, settings are applied, tasks 
are performed and output (JDF, PDF, etc.) can be automatically exported. 

• Commands can come from one of two places. You can load them from an MXML commands file or you 
can embed them in incoming MXML project files. 

• You only need to select “Automation Mode” from the File menu, and Metrix automatically switches to 
the Automation user interface. 

• Many projects can now travel through Metrix with zero operator involvement. 

Differences between Automation Pro and Automation Lite 

The Automation Lite module is similar to the Automation Pro module, but with two differences. 

1. Automation Lite does not allow you to embed scripting commands in incoming MXML files 

2. There is no requirement to maintain an MSA. 

Irregular Shapes Module 

• Metrix supports irregular shape products, nesting them to maximize sheet usage. Multiple Contour 
Lines can be defined for cut, crease, perforation, etc.  

• Die-cutting tools and multi-up die standards use the geometry of customer-supplied multi-up dies. 

• Plans projects that contain a mix of irregular shape and other types of products. 

Notes Metrix plans die-cut products to a separate layout from other types of products. 

 If the Irregular Shape products contains a rotated PDF, then an error message will appear 
because Irregular Shape products may not correctly render rotated PDFs.  

Platforms 

Features and functionality of Metrix on Windows and Mac are identical. However, the appearance of user 
interface elements may vary. Keystroke differences, where they exist, are noted. 

Note This document uses screenshots from Mac and Windows user interfaces. 
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Windows Interface 

 

Mac Interface 

 

Installing and Configuring Metrix Software 

For detailed information on installing and configuring Metrix, see ePS Metrix 22.1 Installation Guide. For 
information on Metrix eFlow Licensing, see ePS Metrix 22.1 Installation Guide. 

Logging in to Metrix 

When you start Metrix, you will see a Login window. 

1. If you already have a user name and password, select your name and type your password. 
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2. If you are starting Metrix for the first time, or if you do not have a personal user role, assigned by an 

Administrator, select one of the following default logins: 

Login Password 

Administrator a 

Guest guest 

Senior senior 

Junior junior 

 

Note See the Metrix Setup Guide for information on how to set up users and user roles. 

3. Click OK to launch Metrix. 

Auto Login 

Metrix 22.1 allows you to set up Auto Login to automatically log in using your system user name without requiring 
a password. (Previous versions required entry of User Name and Password on each login.) 

To set up Auto Login 

1. Select Settings > Database > Users. 

2. Click Auto Login. 

Note If your system user name already exists in the Database window, the next time you start Metrix 
you will be automatically logged in. If your user name does not exist in the Database window, 
follow these steps to add it: 

 – Click Auto Create user as (role) and select an assigned user role. 

  

 – Click Close and exit Metrix. 

 – Restart Metrix. Metrix will open without requiring you to select a user name and password. 

 You will now see the system user name in the Database with no password assigned. 

 

Support Archive 

Metrix allows users to export a “support archive” zip file that contains the open project, marks, mark sets, content 
files, the database resources and equipment, metrix.properties file, Metrix 2022.1.Properties file, and the log 
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files from the last 48 hours. This helps Metrix Support diagnose problems without requiring users to send their 
entire database.  

To export a Support Archive 

1. Open the appropriate project.  

2. Select Support Information from the Help menu. 

3. If you want to include content files, select Include Content Files.  

4. Click Create Support Archive and then click OK.  

 

Note The support archive is saved in the user’s MetrixExports folder: /Users/(username)/MetrixExports 
(Mac) or C:\Users\username\MetrixExports (Windows). 

To submit a Support Archive to ePS Support 

1. Name the archive with the case number and your company name using the format 
CaseNumber_CustomerName.zip.  

2. Contact Metrix Support and they will give you a location where you can upload your zip file.  

3. When the upload is complete, send an email to metrix.support@efi.com to let them know you’ve 
uploaded your Support Archive zip file.  

 

  

mailto:metrix.support@efi.com
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The Metrix User Interface 
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The Metrix User Interface Overview 

The Four Metrix User Interface (UI) areas 

Use the following illustrations for quick reference. 

 

Note When you select a layout, there is a property called Press Inspection Zone. You can use the Press 
Inspection Zone field for specific digital presses; however, they are disabled for presses that do not 
support this feature. 

Interaction and display of the four UI areas 

 

 

Status Area 

 

View 
Area 

 

Properties 
Editor 

 

Project 
Explorer 

 

Layout 
Object 
List 

starts 
here 

 

Layout 1 

View Area 

 

Layout 1 

Properties  

 

Layout 1 

Status Area 

 

Layout 1 
Selected 
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The View Area and the Object List 

 

The View menu 

You can alter the view according to your preferences by selecting View on the Metrix menu. The following 
options are then available. 

 

Properties 

for Door 
Hanger 

 

Select Page 1 

in Object List 
or View Area 

 

Product 
Bleed 

Plate 

Sheet 
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The Assembly View – Bound Products only 

 

The Status Area – Explanation of symbols 

As shown above, the Status Area is open at the bottom of most windows. You will see the following symbols 
there. This is what they indicate. 

= The rule has been satisfied. 

= The rule has been violated and caution is advised. This warning will appear, for example, when Allow
 Nesting is activated. 

= The rule has been violated and corrective action may be required. 

Important Metrix will prohibit exporting when rules are violated, unless the option to “Allow Export with Errors” 
is set to True in the User Roles in the Database. For more information, see Exporting with Errors.  

Enlarging the View Area to full-window size 

You can expand the View Area of the Metrix window to full-window size—horizontally, vertically, or both. The 
“full-window” is relative to the Metrix window, and not the full screen of the computer. 

You can click the small triangles at the upper and lower left-hand corners of the View Area to enlarge or shrink 
the size of the View Area. 

The following is an illustration of the View Area at normal size, with the triangles identified. 

Page List 

Assembly 

View 

Product A 

selected 
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The following is an example of the same View Area, but with the Area expanded both horizontally and vertically. 
To achieve this, click View > Full View. To cancel Full View, unselect the checkbox from the same menu. 

 

Note You can use the triangles to re-size the View Area horizontally or vertically, or you can toggle between 
the normal size and the expanded size (both horizontally and vertically) with CTRL-SHIFT-F on 
Windows, or CMD-SHIFT-F on Mac. 

The Metrix Toolbar 

Button Functionality Menu Path 

 
Creates a new project and opens it for 
editing. 

File > New Project 

 

Opens the database of existing 
projects. Also used to delete existing 
projects. 

File > Open Project 

 

Saves the current project. File > Save Project >and 
File >Save Project As… 

Horizontal 
Sizing 
Triangles 

 

Vertical 

Sizing 
Triangles 
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Opens the Standards Manager window, 
where you can open, duplicate, edit, 
save, or delete standards. 

File > Standards Manager 

 

Opens a navigation window for 
selection of a JDF, MXML, or CSV 
project. 

File > Import JDF/MXML 
Project… 

 
Opens a navigation window for 
selection of a JDF, MXML, or CSV file 
containing one or more products. 

File > Import 
JDF/MXML/CSV Product 

 
Opens the Export window. Export data 
types depend on the Metrix edition 
purchased. 

File > Export… 

 
Opens the Send Product to Metrix 
Automation window. Gives the operator 
access to all Automation Workflows 
currently available on the network. 

File > Automate… 

 

Opens a Report window for viewing and 
printing of the Metrix report. The report 
shows many details of the current 
project. 

File > Preview Project 
Report… 

 

Accesses the New Product Wizard to 
create a new product in the current 
project. 

Project > Add New 
Product… 

 

Accesses the New Layout Wizard to 
create a new layout in the current 
project. 

Project > Add New 
Layout… 

 
For the selected layout, calculates the 
optimum positioning and number of 
instances needed to produce the 
required quantity of each product. 

Layout > Automatic 
Layout 

 

For the selected layout, calculates the 
Printing Method, Press, and Sheet Size, 
as well as the optimum positioning and 
number of instances needed to produce 
the required quantity of each product. 

Layout > Automatic 
Production Method… 

 
Calculates and creates the number of 
layouts required for all products and 
product components, the assignment of 
components to the layouts, and for each 
layout calculates the optimum 
positioning and number of instances 
needed to produce the required quantity 
of each product. 

Project > Automatic 
Production Plan… 

 
Applies the standard previously saved 
for this type of layout, when Metrix finds 
a match to certain properties. 

Layout > Apply Standard 

Note Auto Plan is an optional module for Metrix. 
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The Layout Toolbar 

Button/Tab Functionality Menu path, if any 

 
Indicates which layout is selected and is 
being displayed in the Layout View 
window 

none 

 
Opens the Component Picker window 
for sorting, selecting, editing, and saving 
components. 

none 

 
When highlighted, indicates that side 1 
of the layout is displayed in the layout 
window. 

View > Side 1 

 
When highlighted, indicates that side 2 
of the layout is displayed in the layout 
window. 

View > Side 2 

 

The Scale menu allows you to select a 
percentage size at which to display the 
layout, or to type in a custom size. 
Selecting Scale to Fit scales the layout 
to fit the Layout View window. 

none 

 

Displays the assigned PDF content for 
the products. Toggles between 
Previews and regular layout view. 

View > Previews 

 

Opens the Dimensions window. Marks > Dimensions 

 

Scales the layout to fit in the Layout 
View window. Will be unavailable if the 
layout is already scaled to fit. 

Layout Toolbar > Scale 
Menu > Scale to Fit 

 

Zooms in on the layout, making the 
layout image larger, showing less of the 
image, but in greater detail. 

none 

 

Zooms out from the layout, making the 
layout image smaller, showing more of 
the image, but in lesser detail. 

none 

 

Returns the cursor to the regular arrow 
shape for use as a selection tool. 

none 

 
Changes the cursor to a Marquee Tool 
magnifying glass. Click and drag to 
select an area of the layout to expand to 
the full size of the layout window. 

none 

 

Turns the cursor into a grab hand cursor 
for dragging the layout in the Layout 
View window. 

none 

 

Clicking this icon toggles the cut lines in 
a layout on and off. 

none 

 
The horizontal gutter amount, from trim 
edge to trim edge. If the components 
overlap horizontally, the distance will 
appear as a negative number. 

none 

 

The vertical gutter amount, from trim 
edge to trim edge. If the components 
overlap vertically, the distance will 
appear as a negative number. 

none 
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The distance from left trim edge to left 
trim edge. When you select two 
components, the distance between the 
left trim edges of the two components 
will appear to the right of the icon. 

none 

 

The distance from bottom trim edge to 
bottom trim edge. When you select two 
components, the distance between the 
bottom trim edges of the two 
components will appear to the right of 
the icon. 

none 

 

The distance from right trim edge to 
right trim edge. When you select two 
components, the distance between the 
right trim edges of the two components 
will appear to the right of the icon. 

none 

 
The distance from top trim edge to top 
trim edge. When you select two 
components, the distance between the 
top trim edges of the two components 
will appear to the right of the icon. 

none 

Locating Layouts and Components 

Finding the layout that a component has been assigned to can sometimes be difficult for those who perform a lot 
of manual layout manipulation. This is especially true when there are multiple products and layouts. 

Note For more refined location, filtering, and editing of components in a project, please see Component 
Picker. 

Locating the layout for a component 

To find the component’s assigned layout: 

1. Right-click the component (CTRL-click on Mac) and select View Layout. 

 

The layout is now highlighted, and the component is selected on the layout in the View Area. 
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Viewing a component from a layout 

Sometimes the details of a component on a layout can be so small it makes it almost impossible to know which 
component is selected. 

For an effortless way to view a component from a layout: 

1. Select the component on the layout, then right-click the component (CTRL-click on Mac). 

2. Select View Component from the contextual menu. 

 

The layout with that component will open, and the component is highlighted and displayed in the View 
Area. 

Highlighted 
Product 
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Using the Marquee Zoom Tool 

On the toolbar, you will find three magnifying glass tools used for viewing the Layout window. The magnifying 
glasses with a plus or minus on them are for zooming in or out on the layout respectively. 

The third tool is a blank magnifying glass with a dotted marquee symbol around it. This is the Marquee Zoom 
Tool. Clicking this tool and then dragging it around an area in the Layout window allows you to increase the 
selected area to the size of the Layout window. 

Here are some steps that you can try to get familiar with the tool. 

1. Click the Marquee Tool icon in the toolbar. Your cursor will turn into the Marquee Tool icon. You can 
also turn your cursor into the Marquee Zoom Tool temporarily by holding down 
CTRL+ALT+SPACEBAR on Windows, or CTRL+OPTION+SPACEBAR on Macintosh. 

Note Depending on your operating system, the keystrokes may work in some sequences, but not 
others. Try different sequences until you find one that works in your system. 

2. Click and drag around the area you wish to view at a larger size. 

 

3. Release the mouse button. The selected area displays in the Layout window at a larger size. The size 
depends on the shape of the selected area. 

Step 1 

Step 2 
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The selected area displays with either the top and bottom or the left and right sides matching the Layout 
window, whichever does not cut off any of the image. The rest of the layout displays around the 
selected image at the appropriate proportional size. 

You can switch back to your regular arrow-shaped cursor by clicking the Select icon—the cursor-
shaped icon to the left of the Marquee Tool in the toolbar. 

Contextual Menu Shortcuts 

Right-click (or CTRL-click on the Mac) the item to open a contextual menu. Examples of some contextual menus 
follow. 
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Metrix Properties 
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Metrix Properties Overview 

This chapter lists and describes all project, product, component, page, and layout properties. 

All Metrix project nodes have editable (white) and non-editable (gray) properties. 

Clicking any of the nodes in the Project Explorer displays its properties in the Properties Editor. Clicking any of 
the product instances within the View Area displays its properties in the Properties Editor. 

 

Project properties 

 

 

View Area 

Status Area 

Properties 
Editor 

Project 
Explorer 
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Project Properties 

Property Explanation 

Project ID The ID for the project. You can enter it when creating the project or 
Metrix reads it when importing the project. 

Name Project Name. 

Description Project description. 

Notes Project notes. 

Type Production / Estimate / Template 

The project’s stage of production, or suitability for use as a template. A 
tag only. You can set the default in User Preferences window. 

Needs Attention True / False 

The project requires operator intervention. True indicates that a flag is 
set when projects are processed by Metrix Automation Server. 

Rampage Job Template (None) / Template Name 

Either no Rampage Template is applied, or the name of the Template to 
be applied is listed. 

Stop Bleeds Overlapping True / False 

Automatically clips bleeds on butting product instances when they 
overlap. 

Determine Number Out Auto­Calculate / User­Define 

You can set the default for this property in User Preferences window. 
Auto-Calculate enables Metrix to find the number out of each product 
based on the required quantity. User­Define enables you to determine 
the number out for each product. 

JDF Job ID The first JDF ID of the first job imported into Metrix. JDF Job IDs of 
subsequent imports will not be read. 

Bundling (None) / Bundling Type 

The type of Bundling applied to the project.  
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Product properties 

 

 
Product Properties 

Property Explanation 

Total Count The total number of products in this project. 

Active Count The total number of active products in this project. 

Total Sizes The total number of different product sizes in this project. 

Active Sizes The total number of different sizes of active products in this project. 

Total Product Groups The total number of product groups in this project. 

Active Product Groups The total number of product groups for active products in this 
project. 

Total Placement Groups The total number of placement groups in this project. A project may 
contain up to 10 Placement Groups. 

Active Placement Groups The total number of placement groups in this project. A project may 
contain up to 10 Placement Groups. 

Total Component Stocks The total number of stocks for all the products/components in this 
project. 

Active Component Stocks The total number of stocks for all the active products/components in 
this project. 

Page Bleeds The page bleed amounts for all edges of all pages in this project. 

Empty when the project contains any variation in page bleed 
amounts. All folded products with bleed will have variations in page 
bleed amounts 

 

Products Properties 

Products 
selected 
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Bound product properties 

 

Bound Product Properties 

Property Explanation 

ID The ID Metrix assigns to the product. You can only change this 
property by moving products up and down in the list (right-click > 
Reorder Up or Reorder Down). 

Type Bound / Flat / Folded / Diecut 

The product type. 

Name The product name. 

Description The product description. 

Notes Product notes. 

Due Date The product due date. It can be any string of text. 

Customer Req. Date Delivery date required by the customer. Date formatted field with pull-
down calendar. 

Production Date Date formatted field with pull-down calendar. The user determines the 
purpose. 

Content (Populated) 

The product has PDF file(s) assigned. 

(None) 

The product does not have any PDF file(s) assigned. 

Binding Number Up 1-Up / 2-Up / 3-Up 

The number of products to bind together and then trim apart. N-Up 
Binding is an optional module available only in Metrix Base. 

1st-Up Content Orientation Head to Jog (High Folio Lap) / Foot to Jog (Low Folio Lap) 

The orientation and order of the 1st-Up content relative to the jog 
edge. Default is Head to Jog. 

N-Up Content Orientation 

(N-Up Module only) 

Head to Foot 

The positioning of the 2nd-Up (and 3rd-Up when applicable) is head to 
foot with the 1st-Up. 

Foot to Foot 

Type of product selected 

Product 
properties 
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The positioning of the 2nd-Up (and 3rd-Up when applicable) is foot to 
foot with the 1st-Up. 

 

Common Content for Each 
N-Up 

(N-Up Module only) 

True 

The PDF content for all N-Ups is common. 

False 

The PDF content for each N-Up is unique. When False is selected, 
the Content Select... window displays a Content property for each N-
Up. 

 

Spine Side Left / Right 

The orientation and order of the content relative to the spine. 

You can set the default in the General node of User Preferences. 

Cutting Complexity Choose the operating speed of the machine from the drop-down list. 
The speed is based on the complexity of the product, so more 
complex products will require decreased machine speed. Cutting 
Complexity is used to determine the cost of a layout.  

Customer The customer for this product (Company Name and Contact Name). 

Active True / False 

The status of all product components is active. Only active product 
components are included in the layout calculation. 

This property says (Different Values) when the product contains both 
Active and Inactive components. 

Required Quantity The quantity of product to be printed. Editing the product quantity may 
require another Auto Layout or may require that the number of sheets 
produced is changed accordingly using Layout > Set Required 
Sheets. 

 

Runs Alone True / False 

The item runs alone (True) or not (False). 

Display Color RGB display color for this product. 

Finished Width The final trimmed product width. 

Finished Height The final trimmed product height. 

Grain Either / Either-All Same / Vertical / Horizontal 

Grain direction of the finished, bound product. Editing the grain 
direction directly affects the layout so is often followed by an Auto 
Layout. 
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Stock The stock specified for this product. 

This property says (Different Values) when Cover and/or Text 
Component stocks vary. 

Bleed Top (From Page 1) The amount of bleed on the top edge of the product. 

All bound products with bleed have some empty bleed properties, as 
bleed amounts vary. 

Bleed Left (From Page 1) The amount of bleed on the left edge of the product. 

Bleed Bottom (From Page 
1) 

The amount of bleed on the bottom edge of the product. 

Bleed Right (From Page 1) The amount of bleed on the right edge of the product. 

Allow Nesting True / False 

Determines if a product may impinge on the area of another, 
irregularly shaped object. 

Folio Pattern 1, 2, 3... n / Page 1, Page 2... / A, B, C... / FC, InFC, 1, 2, 3... InBC, 
BC, etc. 

The folio numbering scheme to display on the layout. “FC” indicates 
front cover; “InFC” indicates inside front cover, etc. 

Page Numbers 1, 2, 3... n / C1, C2, T1, T2... 

The sequential page numbering scheme to display on the layout. C 
indicates cover page; T indicates text page. The numbering scheme 

selected also prints on the reports. 

Colors The inks common to all pages of the product. Use the Page list to edit 
page colors. 

This property says (Different Values) when Colors vary. 

Binding Machine The binding machine selected for this product. 

Jog Trim The jog trim margin required for all components of this product. 

Text Spine Trim The spine trim margin (grind off) required for the text components of 
this product. 

Non-Jog Trim The non-jog trim margin required for all components of this product. 

This property says (Different Values) when Non-Jog Trims vary. 

Front Face Trim The front face trim margin required for all components of this product. 

This property says (Different Values) when Front Face Trims vary. 

Back Face Trim The back face trim margin required for all components of this product. 

This property says (Different Values) when Back Face Trims vary. 

N-Up Offset 

N-Up Module only 

The margin between each N-Up. 

Calculate Cover Spine Auto / Manual 

Auto enables Metrix to calculate the width of the spine for perfect 
bound products based on the paper thickness. 

Cover Spine Width The cover spine width. 

You can only edit this property when Manual is selected. This only 
applies to perfect-bound products with a cover. 

Number of Pages The total number of pages (including the cover) for this product. 

Collation Marks Click  to access the following: 

Method: Binding Machine Defaults / Custom – The default settings 
for the selecting binding machine, or user defined settings. 

Mark Type: (None) /Spine / Jog – Placement of the collation marks. 
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Start Offset – The distance from the jog/spine intersection to place 
the first collation mark. 

Width – The collation mark width. 

Height – The collation mark height. 

Repeat Number – The number of collation marks to step before 
beginning at the Start Offset again. 

Over Page Content -True / False- Whether or not collation marks 
print over other text. 

Primary Mark Color – Type of color, color, and percentage of color 
for collation marks on non-nested components. Primary marks appear 
on the outermost component(s) of a perfect bound product. Saddle-
stitched components all have primary collation marks. 

Secondary Mark Color – Type of color, color, and percentage of 
color for collation marks on nested components. Secondary marks 
appear on nested components of a perfect bound product. 

Trailing Text – Default is <TextComponent.Number>, but many other 
pertinent variables are also available. 

Anchor Trailing Text To - Block of Marks / Individual Marks–You 
can position Trailing text relative to the whole set of collation marks, or 
relative to the individual marks. 

Distance From Anchor – The distance the trailing text will be from 
the individual collation marks or the block of marks. 

Trailing Text Point Size – The point size of the trailing text. 

Shingling (Creep) Auto 

Auto enables Metrix to calculate the shingling required based on the 
stock thickness of each 4-page set, the number of sets, and their 
position relative to the spine edge. 

Inner % (0–300) 

The percentage of the total shingling amount applied to the innermost 
4-page set. When a value of less than 100% is entered, the 
remainder, expressed as a negative shingling amount (moving away 
from the spine), is applied to the outermost 4-page set. 

Choose Settings > User Preferences > Shingling (Creep) Defaults 
to select your Automatic Shingling defaults. 

Manual 

Manual enables you to specify Inner and Outer values and then Metrix 
calculates the resulting shingling for each 4-page set. 

Inner Value 

The absolute shingling amount to apply to the innermost component. 
Enter a positive value to move pages towards the spine. 

Outer Value 

The absolute shingling amount to apply to the outermost component. 
Enter a negative value to move pages away from the spine. 

Binding Parameters Binding Machine Defaults 

Use the binding machine setup defaults as specified in the Metrix 
database. 

 

Custom 

 
Stack Item Count 

The number of finished products to stack once binding is complete, to 
bundle up for delivery. 
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Stack Layer Item Count 

The number of finished products to stack in each layer. Layers are 
usually rotated by 180° to compensate for variations in thickness from 
the spine to the face. 

Number of Stitches (Saddled) – 0 / 1 / 2 / 3 / 4 

The number of stitches for this saddle-stitched product. 

Staple Shape (Saddled) – Crown / Butted / Eyelet The staple shape 
for this saddle-stitched product. 

Side Scores from Spine (Side-By-Side, 0=None) 

For perfect bound (side-by-side) products requiring two extra scores 
on the cover sides, one on the front and one on the back, for a total of 
4 scores. The value indicates the distance from the spine scores. Valid 
range: up to 25.4mm or 1". A value of 0 (zero) indicates no extra side 
spine scores. 

MIS ID A MetrixXML product identifier for the originating MIS. 

  

*Note If you are not sure that your PDF contains a trimbox or if it matches the product size, you can use any of 
the PDF tools available, including Acrobat, to check it. 

Cover node properties 

 

 
Cover Node Properties 

Property Explanation 

Grain Either / Vertical / Horizontal 

Grain direction of the finished, folded cover. 

Tagged True / False 

The product is tagged (True), or not (False). You can use 
tagged items as a group in various functions. 

Runs Alone True / False 

The item runs alone (True) or not (False). 

Stock The stock for all cover components. 

Cover node 
selected 



42 ⚫ Productivity Suite | User Guide 

 

 

Bleed Top (From Page 1) The amount of bleed on the top edge of cover pages. 

All bound products with bleed have some empty bleed 
properties, as bleed amounts vary. 

Bleed Left (From Page 1) The amount of bleed on the left edge of cover pages. 

Bleed Bottom (From Page 1) The amount of bleed on the bottom edge of cover pages. 

Bleed Right (From Page 1) The amount of bleed on the right edge of cover pages. 

Production Date Date formatted field with pull-down calendar. You determine 
the purpose. 

Jog Trim The jog trim margin required for all components of this cover. 

Non-Jog Trim The non-jog trim margin required for all components of this 
cover. 

Front Face Trim The front face trim margin required for all components of this 
cover. 

Back Face Trim The back face trim margin required for all components of this 
cover. 

Calculate Cover Spine Auto / Manual 

Auto enables Metrix to calculate the width of the spine for 
perfect bound products based on the paper thickness. 

Cover Spine Width The cover spine width. 

This property is editable only when Manual is selected. 

Number of Pages  The total number of pages for the cover. 

 

Cover component properties 

 

 

Cover Component Properties 

Property Explanation 

Active True / False 

The status of this component is active. 
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Only active components are included in the layout calculation. 

Tagged True / False 

The product is tagged (True), or not (False). You can use tagged 
items as a group in various functions. 

Grain Either / Vertical / Horizontal 

Grain direction of the finished, folded cover component. 

Stock The stock for this cover components. 

Production Date Date formatted field with pull­down calendar. Purpose is 
determined by you. 

Bleed Top (From Page 1) The amount of bleed on the top edge of cover pages. 

All bound products with bleed have some empty bleed properties, 
as bleed amounts vary. 

Bleed Left (From Page 1) The amount of bleed on the left edge of cover pages. 

Bleed Bottom (From Page 1) The amount of bleed on the bottom edge of cover pages. 

Bleed Right (From Page 1) The amount of bleed on the right edge of cover pages. 

Finishing Group Group products together on a layout based on their finishing 
requirements. 

Priority 1–10 

Highest priority = 1. Establishes a placement hierarchy. Metrix 
places components with higher assigned priorities first, often 
nearer to the gripper edge, ensuring the highest print quality. 

Product Group None / Product Group [User­Defined Name] 

The product group to which this component belongs. Product 
groups can then be assigned to one of up to ten placement groups, 
selected upon initiating an auto layout. 

Requested Out Auto Calculate / User Define 

Only editable when the project’s Determine Number Out property 
has been set to User Define. 

Number Out The number out for this component, as calculated by Metrix or as 
user­defined. 

Total Quantity The total number of components, including extras, to be produced 
by this layout. 

Combine Pages True / False 

The content file for this cover component contains a single page or 
spread for each side. Leave this property set to False when the 
cover content file contains individual pages corresponding to the 
finished product size. Change this property to True when the cover 
content file contains a single page or spread for each side. 

Number of Pages The total number of pages for the cover component. 

Fold Name The folding pattern selected for this cover component. You can 
change the folding pattern by clicking  and selecting another from 
the Metrix database. 

Fold Description The description saved in the Metrix database for this folding 
pattern. 

Fold The JDF notation for this folding pattern. 

Arrows indicate fold direction, colors and fractions indicate sheet 
edge and fold distance on the open sheet. 

Examples: 
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1/2= up fold half the open sheet along the green edge. 1/4= 
down fold one quarter the open sheet along the red edge. 

Jog Trim The jog trim margin specified for this cover component. 

To edit this property, select the Cover node. 

Text Spine Trim The spine trim margin (grind off) specified for the text components 
of this product. 

Non­Jog Trim The non­jog trim margin specified for this cover component. 

Front Face Trim The front face trim margin specified for this cover component. 

Back Face Trim The back face trim margin specified for this cover component. 

Lap The difference between the Front Face Trim and Back Face Trim 
properties, as calculated by Metrix. 

N-Up Offset The margin between 2-Up and 3-Up products. 

Max Non-Jog Trim The maximum, or largest, Non-Jog Trim specified for the cover 
component. 

Max Front Face Trim The maximum, or largest, Front Face Trim specified for the cover 
component. 

Max Back Face Trim The maximum, or largest, Back Face Trim specified for the cover 
component. 

Flat Width The total component width, including pages and trim margins. 

Flat Height The total component height, including pages and trim margins. 

MIS ID A MetrixXML component identifier for the originating MIS. 

Text node properties 

Note The following properties appear when you select an individual text item and not its parent. 

 

Text Node Properties 

Property Explanation 

Grain Either / Vertical / Horizontal 

Grain direction of the finished, folded text. 

Tagged True / False 



Metrix Properties | User Guide ⚫ 45 

 

 

Runs Alone True / False 

Runs alone (True) or not (False) 

Stock The stock for all text components. 

This property says (Different Values) when text component stocks 
vary. 

Production Date Date formatted field with pull­down calendar. You can also type in 
the date manually. Purpose is determined by you. 

Bleed Top (From Page 1) The amount of bleed on the top edge of text pages. 

Bleed Left (From Page 1) The amount of bleed on the left edge of text pages. 

Bleed Bottom (From Page 1) The amount of bleed on the bottom edge of text pages. 

Bleed Right (From Page 1) The amount of bleed on the right edge of text pages. 

Jog Trim The jog trim margin common to all text components. 

Text Spine Trim The spine trim margin (grind-off) common to all text components. 

Non-Jog Trim  The non-jog trim margin common to all text components. 

Front Face Trim The front face trim margin common to all text components. 

Back Face Trim The back face trim margin common to all text components. 

Number of Pages The total number of text pages 

  

Text component properties 

 

 

Text Component Properties 

Property Explanation 

Active True / False 

The status of this component is active. 
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Only active components are included in the layout calculation. 

Tagged True / False 

The product is tagged (True), or not (False). You can use tagged 
items as a group in various functions. 

Runs Alone True / False 

The item runs alone (True) or not (False). 

Grain Either / Vertical / Horizontal 

Grain direction of the finished, folded cover component. 

Stock The stock for this text component. 

Production Date Date formatted field with pull­down calendar. You determine the 
purpose. 

Bleed Top (From Page 1) The amount of bleed on the top edge of cover pages. 

Bleed Left (From Page 1) The amount of bleed on the left edge of text pages in this 
component. 

Bleed Bottom (From Page 1) The amount of bleed on the bottom edge of text pages in this 
component. 

Bleed Right (From Page 1) The amount of bleed on the right edge of text pages in this 
component. 

Priority 1–10 

Highest priority = 1. Establishes a placement hierarchy. Metrix 
places components with higher assigned priorities first, often 
nearer to the gripper edge, ensuring the highest print quality. 

Product Group None / Product Group [User­Defined Name] 

The Product Group to which this component belongs. You can then 
assign Product Groups to one of up to ten Placement Groups, 
selected upon initiating an Auto Layout. 

Requested Out Auto Calculate / User Define 

Only editable when you set the project’s Determine Number Out 
property to User Define. 

Number Out The number out for this component, as calculated by Metrix or as 
user defined. 

Total Quantity The total number of components, including extras, that this layout 
will produce. 

Number of Pages The total number of pages for this text component. 

Fold Name The folding pattern selected for this text component. You can 
change the folding pattern by clicking  and selecting another from 
the Metrix database. 

Fold Description The description saved in the Metrix database for this folding 
pattern. 

Fold The JDF notation for this folding pattern. 

Arrows indicate fold direction; colors and fractions indicate sheet 
edge and fold distance on the open sheet. 

Examples: 

1/2 = up fold half the open sheet along the green edge. 1/4 = 
down fold one quarter the open sheet along the red edge. 

Jog Trim The jog trim margin specified for this text component. 

To edit this property, select theText node. 

Text Spine Trim The spine trim margin (grind off) specified for this text component. 
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To edit this property, select theText node. 

Non­Jog Trim The non­jog trim margin specified for this text component. 

Front Face Trim The front face trim margin specified for this text component. 

Back Face Trim The back face trim margin specified for this text component. 

Lap The difference between the Front Face Trim and Back Face Trim 
properties, as calculated by Metrix. 

N-Up Offset The margin between 2-Up and 3-Up products. 

Max Non-Jog Trim The maximum, or largest, Non-Jog Trim specified for this text 
component. 

Max Front Face Trim The maximum, or largest, Front Face Trim specified for this text 
component. 

Max Back Face Trim The maximum, or largest, Back Face Trim specified for this text 
component. 

Flat Width The total component width, including pages and trim margins. 

Flat Height The total component height, including pages and trim margins. 

MIS ID A MetrixXML component identifier for the originating MIS. 

 

Note If you have multiple text components selected (using SHIFT-click or CTRL/CMD-click), the properties 
list below will only display those properties shared by all of the text components. If the field says, 
“(Different Values),” you can edit the value, and it will become the same for all of the selected text 
components. 

 

Runs Alone component property 

The Runs Alone property allows you to specify that a component appear on its own layout rather than being 
ganged with any other components. 

To activate the feature 

1. Select a component and scroll down the Properties Editor. 

2. Set the Runs Alone property to True. 
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Bound page properties 

 

 

Bound Page Properties 

Property Explanation 

Number The sequential number of the selected page. 

Folio The folio assigned to the selected page for display and reporting 
purposes. 

Planned Colors The ink colors of a selected page. 

Rotation 0° / 90° / 180° / 270° 

The rotation of the selected page. 

Bleed Top The bleed amount on the top edge of the selected page. 

Bleed Left The bleed amount on the left edge of the selected page. 

Bleed Bottom The bleed amount on the bottom edge of the selected page. 

Bleed Right The bleed amount on the right edge of the selected page. 

Thumbnail Image The low-resolution JPG, PNG, or GIF preview image (RGB only) 
assigned to the selected page. 

This property is ordinarily used only when nesting irregularly 
shaped objects on a Metrix layout. 

Transparent Color The background color of the thumbnail image (most often white) 
to turn transparent. 

Selected 
Component 

 

Selected Page 

 

Runs Alone 

set to True 

 



Metrix Properties | User Guide ⚫ 49 

 

 

This property is ordinarily used only when nesting irregularly 
shaped objects on a Metrix layout. 

Transparency Tolerance The range of red, green, and blue (RGB) values, either side of the 
selected Transparent Color’s values, to be rendered transparent 
for the thumbnail image background may not be pure white. With 
a tolerance of + / - 20, all pixels within the following range are 
rendered transparent: R=215-255, G=25-255, B=215-255. 

This property is ordinarily used only when nesting irregularly 
shaped objects on a Metrix layout. 

Rampage Workflow Whether or not a Rampage workflow is applied to this page, and if 
so, the name of the workflow. 

Leaf Width The width of the selected page plus trim margins. 

Leaf Height The height of the selected page plus trim margins. 

Custom Shingling True / False 

Override product-level shingling and apply custom shingling to 
this page. 

Shingling Value When Custom Shingling is True, the custom shingling value to 
apply to the selected page. 

Editable only when Custom Shingling is set to True. 
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Flat/folded product properties 

 

 

Flat/Folded Product Properties 

Property Explanation 

ID The ID Metrix assigns to the product. You can only change this 
property by reordering the list of products. 

 

Type Bound / Flat / Folded / Diecut 

The product type. 

Name The product name. 

Description The product description. 

Notes Product notes. 

Due Date The product due date. It can be any string of text. 

Customer Req. Date Delivery date required by the customer. Date formatted field with pull-
down calendar. 
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Production Date Date formatted field with pull-down calendar. You determine the 
purpose. 

Content File The PDF file assigned to the product. 

Content Positioning Rule 

 

Match PDF Page Trimbox Size and Center 

The content file contains a trimbox for each page that matches 
precisely the Metrix page size. 

Center Each PDF Page Trimbox 

The content file contains a trimbox for each page that does not 
necessarily match precisely the Metrix page size. Metrix centers the 
PDF page trimbox on the Metrix page, and crops any PDF content 
falling outside the Metrix page size plus bleed. 

Center Each PDF Page 

The content file does not necessarily contain a trimbox for each page. 
Metrix centers the PDF page on the Metrix page, and crops any PDF 
content falling outside the Metrix page size plus bleed. 

Cutting Complexity Choose the operating speed of the machine from the drop-down list. 
The speed is based on the complexity of the product, so more 
complex products will require decreased machine speed. Cutting 
Complexity is used to determine the cost of a layout. 

Customer The customer for the product (Company Name and Contact Name). 

Active True / False 

The product is active. 

Only active products are included in the layout calculation. 

Tagged True / False 

The product is tagged (True), or not (False). You can use tagged 
items as a group in various functions. 

Required Quantity The quantity of product to be printed. 

Allowed Overs The number of acceptable overs for the product.  

Rectangular and irregular shape products must be planned using the 
Display Graphics algorithm. For die-cut products, set the Use Die-
cutting Tool Geometry field in the Layout properties to True. 

Runs Alone True / False 

The product runs on its own layout (True), or not (False). 

Display Color The RGB display color for this product. 

Finished Width The final trimmed product width, in reader orientation. 

Finished Height The final trimmed product height, in reader orientation. 

Grain Either / Either-All Same / Vertical / Horizontal 

The grain direction of the finished product. 

Stock The stock specified for this product. 

Bleed Top (From p. 1) The amount of bleed on the top edge of the product. 

All folded products with bleed have some empty bleed properties, as 
bleed amounts vary. 

Bleed Left (From p. 1) The amount of bleed on the left edge of the product. 

Bleed Bottom (From p. 1) The amount of bleed on the bottom edge of the product. 

Bleed Right (From p. 1) The amount of bleed on the right edge of the product. 
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Allow Nesting True / False 

Determines if a product may impinge on the area of another, 
irregularly shaped object. 

Folio Pattern 1, 2, 3... n / Page 1, Page 2... / A, B, C... / FC, InFC, 1, 2, 3... InBC, 
BC, etc. 

The folio numbering scheme to display on the layout. “FC” indicates 
front cover; “InFC” indicates inside front cover, etc. 

Finishing Group Group products together on a layout based on their finishing 
requirements. 

Priority 1–10 

Highest priority = 1. Establishes a placement hierarchy. Metrix places 
products with higher assigned priorities first, often nearer to the 
gripper edge, ensuring the highest print quality. 

Product Group None / Product Group [User Defined Name] 

The Product Group to which this product belongs. You can then 
assign product groups to one of up to ten placement groups, selected 
upon initiating an auto layout. 

Requested Out Auto Calculate / User Define 

Only editable when you set the Determine Number Out property in 
the Project node to User Define. 

Number Out The number out on the layout for this product, as calculated by Metrix 
or as user defined. 

Total Quantity The total number of products, including extras, to be produced by this 
product’s layout. 

Combine Pages (Folded 
only) 

True / False 

Set to True when the content file contains a single page or spread for 
each side. 

Number of Pages (Folded 
only) 

The total number of pages for the product. 

Fold Name (Folded only) The folding pattern selected for this product. You can change the 
folding pattern by clicking  and selecting another from the Metrix 
database. 

Fold Description (Folded 
only) 

The description saved in the Metrix database for this folding pattern. 

Fold (Folded only) The JDF notation for this folding pattern. 

Arrows indicate fold direction, colors and fractions indicate sheet 
edge and fold distance on the Open sheet. Examples: 1/2 = up fold 
half the open sheet along the green edge. 1/4= down fold one 
quarter the open sheet along the red edge. 

Offcut Top The amount of extra white space to reserve at the top edge of the 
product. Will not affect crop mark placement. 

Offcut Left The amount of white space to reserve at the left edge of the product. 
Will not affect crop mark placement. 

Offcut Bottom The amount of white space to reserve at the bottom edge of the 
product. Will not affect crop mark placement. 

Offcut Right The amount of white space to reserve at the right edge of the 
product. Will not affect crop mark placement. 

Flat Width The product page width plus any offcuts specified. 

Flat Height The product page height plus any offcuts specified. 

MIS ID A Metrix XML product identifier from the originating MIS. 
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Flat/folded page properties 

 

 

Flat/Folded Page Properties 

Property Explanation 

Number The sequential number of the selected page. 

Folio The folio number (or alpha-numeric designation) of the selected page. 

Planned Colors The inks for the selected page. 

Rotation (Flat) 0° / 90° / 180° / 270° 

The rotation of the selected page. 

This property is editable on side 2 only. Use this property to specify 
variations in page orientation from front to back. 

Rotation (Folded) 0° / 90° / 180° / 270° 

The rotation of the selected page. 

When folded pages are rotated, bleeds are affected. Edit the bleed 
properties as necessary. 

Bleed Top The bleed amount on the top edge of the selected page. 

Bleed Left The bleed amount on the left edge of the selected page. 

Bleed Bottom The bleed amount on the bottom edge of the selected page. 

Bleed Right The bleed amount on the right edge of the selected page. 

Thumbnail Image The low-resolution JPG, PNG, or GIF preview image (RGB only) assigned 
to the selected page. 

This property is ordinarily used when products are nested. 

Transparent Color The background color of the thumbnail image (most often white) to turn 
transparent. 

This property is ordinarily used when products are nested. 

Transparency 
Tolerance 

The range of red, green, and blue (RGB) values, either side of the selected 
transparent color’s values, to be rendered transparent for the Display 
Image. Pure white pixel values are: R=255, G=255, B=255, but the 

Page 

Selected 

Selected 
Product 

 

Page 
Properties 
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Thumbnail Image background may not be pure white. With a tolerance of +/- 
20, all pixels within the following range are rendered transparent: R=215–
255, G=215–255, B=215–255. 

This property is ordinarily used when products are nested. 

Rampage Workflow Whether or not a Rampage workflow is applied to this page, and if so, the 
name of the workflow. 

Width (Folded only) The width of the selected page. 

Use this property to specify a custom width for a folded panel. 

Height (Folded only) The height of the selected page. 

Use this property to specify a custom height for a folded panel. 

 

Die-Cut and Irregular Shape product properties 

 

 

Die-Cut and Irregular Shape Product Properties 

Property Explanation 

ID The ID Metrix assigns to the product. You can only change this property by 
reordering the list of products. 

 

Type Bound / Flat / Folded / Die-cut using Die-Cutting Tool / Irregular Shape 
Using Contour Line in Content File 
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The product type. 

Name The product name. 

Description The product description. 

Notes Product notes. 

Due Date The product due date. It can be any string of text. 

Customer Required 
Date 

Delivery date required by the customer. Date formatted field with pull-down 
calendar. 

Production Date Date formatted field with pull-down calendar. You determine the purpose. 

Content File The PDF file assigned to the product. 

Content Positioning 
Rule 

Match PDF Page Trimbox Size and Center 

The content file contains a trimbox for each page that matches precisely the 
Metrix page size. 

Center Each PDF Page Trimbox 

The content file contains a trimbox for each page that does not necessarily 
match precisely the Metrix page size. Metrix centers the PDF page trimbox 
on the Metrix page, and crops any PDF content falling outside the Metrix 
page size plus bleed. 

Center Each PDF Page 

The content file does not necessarily contain a trimbox for each page. 
Metrix centers the PDF page on the Metrix page, and crops any PDF 
content falling outside the Metrix page size plus bleed. 

Cutting Line Color The currently selected contour line used for the Cutting operation. 

Tool Selected die-cutting tool.   

Resolve Bleed 
Conflicts 

True / False 

Applies Allowed Bleed Intrusion settings configured for the die-cutting tool. 

Cutting Complexity Choose the operating speed of the machine from the drop-down list. The 
speed is based on the complexity of the product, so more complex products 
will require decreased machine speed. Cutting Complexity is used to 
determine the cost of a layout. 

Customer The customer for the product (Company Name and Contact Name). 

Active True / False 

The product is active. 

Only active products are included in the layout calculation. 

Required Quantity The quantity of product to be printed. 

Allowed Overs The number of acceptable overs for the product.  

Rectangular and irregular shape products must be planned using the 
Display Graphics algorithm. For die-cut products, set the Use Die-cutting 
Tool Geometry field in the Layout properties to True. 

Produce Exact 
Quantity 

True / False 

When set to True, there will be no overs because only the exact required 
quantity is produced. Die-cut products only. 

Runs Alone True / False 

The product runs on its own layout (True), or not (False). 

Display Color The RGB display color for this product. 
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Finished Width The final trimmed product width, in reader orientation. 

Finished Height The final trimmed product height, in reader orientation. 

Grain Either / Either-All Same / Vertical / Horizontal 

The grain direction of the finished product. 

When set to Either or Either-All Same, product may be at any angle 
relative to the sheet.  

Stock The stock specified for this product. 

Bleed All Edges The amount of bleed on each edge of the product. 

Allow Nesting True / False 

Determines if a product may impinge on the area of another, irregularly 
shaped object. 

Folio Pattern 1, 2, 3... n / Page 1, Page 2... / A, B, C... / FC, InFC, 1, 2, 3... InBC, BC, etc. 

The folio numbering scheme to display on the layout. “FC” indicates front 
cover; “InFC” indicates inside front cover, etc. 

Finishing Group Group products together on a layout based on their finishing requirements.  

Priority 1–10 

Highest priority = 1. Establishes a placement hierarchy. Metrix places 
products with higher assigned priorities first, often nearer to the gripper 
edge, ensuring the highest print quality. 

Product Group None / Product Group[User­Defined Name] 

The Product Group to which this product belongs. You can then assign 
product groups to one of up to ten placement groups, selected upon 
initiating an auto layout. 

Requested Out Auto Calculate / User Define 

Only editable when you set the Determine Number Out property in the 
Project node to User-Define. 

Number Out The number out on the layout for this product, as calculated by Metrix or as 
user defined. 

Total Quantity The total number of products, including extras, to be produced by this 
product’s layout. 

Flat Width The product page width plus any offcuts specified. 

Flat Height The product page height plus any offcuts specified. 

MIS ID A Metrix XML product identifier from the originating MIS. 
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Die-Cut and Irregular Shape page properties 

 

Die-Cut and Irregular Shape Page Properties 

Property Explanation 

Number The sequential number of the selected page. 

Folio The folio number (or alpha-numeric designation) of the selected page. 

Planned Colors The inks for the selected page. 

Rotation 0° / 90° / 180° / 270° 

The rotation of the selected page. 

Bleed Top The bleed amount on the top edge of the selected page. 

Thumbnail Image The low-resolution JPG, PNG, or GIF preview image (RGB only) assigned 
to the selected page. 

This property is ordinarily used when products are nested. 

Transparent Color The background color of the thumbnail image (most often white) to turn 
transparent. 

This property is ordinarily used when products are nested. 

Transparency 
Tolerance 

The range of red, green, and blue (RGB) values, either side of the selected 
transparent color’s values, to be rendered transparent for the Display 
Image. Pure white pixel values are: R=255, G=255, B=255, but the 
Thumbnail Image background may not be pure white. With a tolerance of +/- 
20, all pixels within the following range are rendered transparent: R=215–
255, G=215–255, B=215–255. 

This property is ordinarily used when products are nested. 
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Layouts properties (all layouts) 

 

Layouts Properties 

Property Explanation 

Total Count The total number of layouts in this project 

Side 1 Rampage 
Workflow 

Whether or not a Rampage workflow is applied to side 1, and if so, the 
name of the workflow. 

Side 2 Rampage 
Workflow 

Whether or not a Rampage workflow is applied to side 2, and if so, the 
name of the workflow. 

 

Layout properties (individual layout) 
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Layout Properties 

Property Explanation 

Printing Method One-Sided / Sheetwise / Work and Turn / Work and Tumble / 
Perfected 

The printing method for this layout. 

Perfected is only available when the selected press is capable of 
perfecting as defined in the Metrix database. 

Side 1 Press The press specified for side 1 of this layout. 

Side 2 Press The press specified for side 2 of this layout. 

When you select either One-Sided, Work and Turn, or Work and 
Tumble as the printing method, this property is non-editable. 

Stock The stock specified for this layout. 

To change the layout stock, click  and choose a different stock in the 
Stock Selector window. 

Sheet Dimensions The sheet size of the selected stock. 

Use Die-cutting Tool 
Geometry  

True/ False 

Select True to use the die-cutting tool geometry, or select False to use 
the nesting algorithm when creating an auto layout using a die-cut 
product.  

Auto Page to Bleed Gap True / False 

When set to True, automatically sets the Page to Bleed Gap for all 
products to the amount required for the largest bleed on any side of any 
product on the layout. 

Page to Bleed Gap The distance between the trim edge of one product instance to the 
bleed edge of an adjacent product instance. 

Required Sheets The number of sheets required to produce the required quantity of the 
product(s) on the layout, as calculated by Metrix using Auto Layout or 
using Layout > Set Required Sheets, or as input manually. 

Cutter The name of the cutting machine selected for the layout. 

Required Cuts The number of cuts required for this layout. 

Sheet Area Use The percentage of the sheet consumed by the product instances on the 
layout. 

Component Count The total number of products (and/or bound components) assigned to 
the selected layout. 

Instance Count The total number of product instances on the selected layout. 

Mark Count The total number of marks on the selected layout. 

Side 1 Rampage 
Workflow 

Whether or not a Rampage workflow is applied to side 1, and if so, the 
name of the workflow. 

Side 2 Rampage 
Workflow 

Whether or not a Rampage workflow is applied to side 2, and if so, the 
name of the workflow. 

MIS ID A MetrixXML layout identifier from the originating MIS. 

Press Inspection Zone An area reserved for printing control marks on certain digital presses. If 
this area is gray, then the selected press does not support inspection 
marks. 

Auto Cutoff Length True/ False 
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Select True to have Metrix automatically determine your cutoff length 
or select False to enter your own cutoff length within the parameters of 
the chosen sheet size.  

Auto Cutoff Length is only available if you set your production 
properties and parameters for Auto Plan to have a rollfed press with 
variable cutoff length. 

Cutoff Length Enter the cutoff length for your layout.  

Cutoff Length is only available if you select False for your Auto 
Cutoff Length.  

Is Display Graphics True/ False 

Show whether or not the layout was planned using the Display 
Graphics algorithm. 

 

Note If you have multiple, individual layouts selected (using SHIFT-click or CTRL/CMD-click), the properties 
list will be the same as for an individual layout, but properties that are different in different layouts will 
have the message “(Different Values)” in the property field. If the field is gray, the value is not editable. If 
the field is white, the value is editable, and will become the same for all the selected layouts. 

 

Changing presses from the Properties Editor 

You can change the Press first, and Metrix will warn you if the press, stock, and sheet size do not match. 

If you change the Press, and Metrix displays warnings, you can change the stock and sheet size directly from the 
Properties Editor. Change the stock by clicking  in the Stock option in the Properties Editor. Select a different 
sheet size from the menu that appears when you click the current sheet size. 

Below are examples where we have changed the press size and warnings appear. 
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Changing automatic gutters between component instances 

Gutters are determined by both the Page To Bleed Gap property and the product Bleeds property. 

Note For more information on bleeds, see Understanding positive and negative bleed. 

1. Select a layout in the Project Explorer. 

2. Edit the Page to Bleed Gap property in the Properties Editor. 

3. Click Auto Layout. 

Notes The default Page To Bleed Gap is set in the Conventions node of the Database window. 

 Use auto bleeds to eliminate bleeds between adjacent product instances, while maintaining the 
exterior bleeds. For more information, see Step and Repeat Using Drag and Drop.  

 

Product instance properties 

 

Product Instance Properties 

Property Explanation 

Layout Selected 

Instance Selected 

Instance 
Properties 
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ID The instance ID assigned by Metrix. 

Left The distance from the left trim edge of the instance to the left edge 
of the sheet. 

Right The distance from the right trim edge of the instance to the right 
edge of the sheet. 

Bottom  The distance from the bottom trim edge of the instance to the bottom 
edge of the sheet. 

Top The distance from the top trim edge of the instance to the top edge 
of the sheet. 

Orientation The orientation of the selected instance. 
Flat/Folded/Bound Products: 0° / 90° / 180° / 270° 
Irregular Shape Products: Enter the degree of rotation for the 
product instance. The number must be from 0° - 359°. 
 

Flipped True / False 
Swap the front and back sides of this instance. 
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Working with Projects 
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Creating, Opening, Searching, and Sorting Projects 

• Create a new project by clicking the New button or selecting File > New Project. 

• Open a project by clicking the Open button or selecting File > Open Project. In the Open Project 
window, you can sort any of the Project properties (Project ID, Name, Description, Notes, Type, etc.) in 
ascending or descending order by clicking the title at the top of the column. You can also sort the list by 
typing criteria in the Filter field, separated by spaces. 

• Filtering with Or selected, finds the projects that meet any of the criteria listed. This is a broader, less 
restrictive search. 

• Filtering with And selected, finds only the projects that meet all the listed criteria. This is a narrower, 
more restrictive search. 

• Removing all data from the Filter field or clicking the Clear All button makes all the listings appear 
again. 

• Open an advanced search window by clicking the Advanced button. Here you can search for projects 
by name, idea, description, as well as created and modified dates. Select Clear to reset the advanced 
search.   

• Filter projects by type using the Type drop down list, or by urgency using the Needs Attention drop 
down list.  

 

Deleting Projects 

1. To delete one or more projects, click Open and then select the projects you wish to delete. 

2. Click Delete, and then click Yes in the Delete Projects window. 

Note You may SHIFT-click to select a range of multiple projects, or CTRL-click (Windows) or CMD-
click(Mac) to select multiple, non-contiguous projects. 
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Working with Products 

Creating a new product 

Create a new product by clicking the Product button or selecting Project > Add New Product. In the New 
Product Wizard, fill in or select the appropriate information to define the product. When you reach the Default 
Page Properties window, you have the option to click Finish, which creates just the product, or to continue and 
define the layout as well. 

Making a one-sided product 

In the Run List, set the non-printing side to have Planned Colors “(None)” and Filename “(Blank).” Choose One-
sided as the Layout Printing Method. 

Note You can change the printing method after creating the layout. 

Deleting a product 

1. Select a product in the Project Explorer. 

2. Right-click the selected product. 

3. Select Delete from the contextual menu. 

Controlling product orientation on the sheet 

Orientation is controlled by the Metrix Auto Layout engine, which considers the grain for the product and the 
grain of the selected sheet. You can set the grain for the product in the New Product Wizard, or you can edit the 
product’s properties in the Project Explorer. The sheet’s grain direction is defined in the Database window. 

Note You can rotate product instances on a layout. For more information see Rotating product instances. 

Product Bundling 

Bundles are a means of keeping printed products with common criteria together to streamline post-printing 
processes such as finishing or distribution. The user defines the bundles with a unique name, which products are 
in each bundle, and the desired quantity of each product in each bundle.  

Possible use cases for this feature are: 



66 ⚫ Productivity Suite | User Guide 

 

 

• A “kit” of products needs to be sent to multiple destinations, so for ease of picking and packing, each kit 
should be bundled together on the same layout(s). This allows distribution to begin before the entire run 
is finished printing. 

• All products that need to be delivered on a specified date should be bundled together. For example, 10 
of each of 500 products must be delivered today with the remaining quantities to be delivered at other 
times. This also allows distribution to begin before the entire run is finished printing. 

• You want to keep all components for each product together on layouts rather than having them 
scattered throughout multiple layouts. 

Note For more information on product bundling, see ePS Metrix Tech Note-Bundling.  

To configure a bundle 

Product bundles are configured for a project, and cannot be set up for individual products. Product bundling only 
works with the Display Graphics module.   

1. Select the project in the Project Explorer.  

2. Click the Bundling field in the Project Properties.  

3. Click the […] button to open the Edit Bundle Definitions window.  

 

4. Choose the bundle type from the Bundling Type drop-down list: 
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a. No Bundling is the default mode that applies no bundles to the project.  

b. Manual allows you to edit the settings configured for other modes or customize an all-new 
bundle.  

Note  If the first mode you select is Manual, there will be no pre-defined bundles. Manual 
bundling provides the most flexibility for creating bundles with varying quantities. In 
addition to changing the number of bundles and the bundle names, you can specify the 
number of each product in each bundle. For more information on the Manual mode, 
see To configure a Manual bundle. 

c. Auto-All Products creates bundles with all the products of the project in each bundle.  

Note  The Required Quantity for each product is evenly divided among the specified 
number of bundles. The default Number of Bundles is 10. The maximum number of 
bundles is 1000. You can change this number by opening the Metrix 2022.1.properties 
file in a text editor when Metrix is not running and editing the value for 
“Bundle.MaxNum=XXXX”. 

d. Auto-Each Product creates a separate bundle for each product.  

Notes  Metrix divides the Required Quantity by the specified Product Instance per Bundle. 
For example, if there are 3 products with a Required Quantity of 30 each, then there 
will be 3 bundles with 10 instances for each product.  

 The maximum number of bundles is 1000. You can change this number by opening the 
Metrix 2022.1.properties file in a text editor when Metrix is not running and editing the 
value for “Bundle.MaxNum=XXXX”. 

e. Auto-By Note creates a separate bundle for each unique Note in the Product Properties.  

Notes The Note property is not case sensitive.  

 If the Note property is empty for a product, then it will not appear in the list of bundles.  

f. Auto-By Company creates a separate bundle for each Company that appears in the Product 
Properties.  

Note  If the Company property is empty for a product, then it will not appear in the list of 
bundles.  

g. Auto-Due Date creates a separate bundle for each Due Date that appears in the Product 
Properties.  

Notes The Due Date property is not case sensitive.  

 If the Due Date property is empty for a product, then it will not appear in the list of 
bundles.  
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h. Auto-By Customer Required Date creates a separate bundle for each Customer Required 
Date that appears in Product Properties.   

Note  If the Customer Required Date property is empty for a product, then it will not appear 
in the list of bundles.  

5. Complete the remaining fields: 

a. Bundles always start on new sheet is available for all Bundling Types. When this check 
box is selected, Metrix will not place bundles on a sheet that contains another bundle. Instead, 
each bundle starts on a new sheet. 

b. Separator Marks is only available if Bundles always start on new sheet is not selected. 
When this checkbox is selected, Metrix will place a Separator Mark between bundles that 
appear on the same sheet.  

Notes  You can change the thickness of the Separator Marks in the Bundle Separator Mark 
Size field in the Marks tab of the User Preferences.  

 You can edit an individual Separator Mark by selecting it on the layout and changing 
the thickness, color, and position in the Properties.  

c. Spacing is only available if Separator Marks is selected. This field allows you to specify how 
much space to leave between product bleeds and the Separator Mark.  

d. Bundle Count is available for all Bundle Types. The field is not editable; it is automatically 
populated with the total number of bundles in the project.  

e. Number of Bundles is only available for Auto-All Products bundling type. This field allows 
you to specify the number of bundles in the project.  

f. Product Instances per Bundle is only available for Auto-Each Products bundling type. This 
field allows you to specify the number of product instances in each bundle.  

g. Respect Quantity is available for the Auto-All Products and Auto-Each Products bundling 
types. When this checkbox is selected, bundles will contain only the Required Quantity for 
products. This may result in some bundles having more or fewer instances of products, but the 
total quantity will equal the product Required Quantity. If Respect Quantity is not selected, 
the quantities for all products will be equally distributed among all bundles. 

Note  When the total number of products configured for Bundling does not match the 
Required Quantity, the Quantities in Bundles do not match product Required 
Quantities message appears. If you click OK, then a Fix Product Quantities window 
opens: 

 

 

 Select Update Required Qty to automatically change the Required Quantities for the 
listed product(s) so they match the number specified for bundling. 
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 Select Ignore Warning so no charges will be made to the Required Quantity or 
bundles. There may be overs or unders.  

 Select Cancel to return to the Edit Bundle Definitions window so you can edit the 
product quantities in the bundles.  

  

6. Click OK.  

To configure a Manual bundle 

1. Choose Manual from the Bundling Type drop-down list.  

2. Click the + button to add a new bundle.  

Note You can add as many bundles as you want.  

 

3. Click in the Product column for the bundle you want to edit. You can change the name and add 
products to the bundle in the Edit Bundle window.  
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4. Enter a custom name in the Name field to change the name of the bundle.  

5. Click the + button to open the Select Product window, where you can choose the products to add to the 
selected bundle.  

Note You can add as many products to a bundle as you want.  

 

6. Click in the Count column for the Product you want to edit and enter the number of instances to include 
in the bundle for that product. 
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7. Click OK to save the configuration when all the bundles are complete.  

Note If you want to delete ALL configured bundles in Manual mode, click the Clear button.  

Bleeds 

Understanding positive and negative bleed 

Metrix approaches product bleed from the perspective of the layout – how much product fits on the layout when 
bleeds are considered? But Metrix goes one step further with the concept of negative bleed – how much extra 
product can be squeezed onto the layout when products contain white space in the margins and therefore non-
image areas of the press sheet can be utilized? 

Products with bleeds 

“Positive” bleed is the conventional way we think about bleed. For example, Metrix ensures that pages with bleed 
are kept away from the No Image area on the press sheet. 
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Note The gutter between bleeding and non-bleeding product instances is controlled by the Page To Bleed 
Gap property. For more information, see Changing Automatic Gutters. 

Products with no bleed 

Products with no bleed may be defined as having zero bleed, or they may be defined as having “negative” bleed. 
Negative bleed allows Metrix to use No Image areas of the sheet for product placement, which sometimes 
means that more product can be placed onto the sheet, improving the productivity of the press run. 

 

Metrix allows products with negative bleed to be placed into the No Image areas, up to the amount of negative 
bleed, or up to the No Page area, whichever comes first. 

Changing bleeds 

Changing all bleeds for all products 

1. Select Products in the Project Explorer. 

2. Edit Page Bleeds in the Properties Editor. 

Note Edits made to the Page Bleeds property of the Products node apply to all sides of all products. 
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Changing product bleeds on both sides 

To change the bleeds values on both sides of a single product 

1. Select the individual product (underneath the parent product) in the Project Explorer. 

2. Edit the Bleeds values (highlighted in the following illustration). 

Note Edits made to the bleed properties of the Product node apply to both sides of the product. 

1. Select the 
product 

2.   Edit Page Bleeds 
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Changing product bleeds on one side only 

1. Select the Component in the Project Explorer. 

2. Click the View Area tab ( ). 

3. Select the tab for the appropriate Side. 

4. Select the desired Page in the View Area. 

5. Edit the Bleed Properties (Top, Left, Bottom, and Right). 

Note Edits made to the Page node apply to the selected page only. 

 

 

1. Select the 
component 

2. Edit the Bleeds 
property values 
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Resolving overlapping bleeds 

When the project property Stop Bleeds Overlapping is set to True (the default), whether you are looking at the 
product or the layout, the overlapping bleeds are automatically resolved. 

Using Offcuts 

Sometimes finishing operations such as embossing or die-cutting require extra white space on the sheet. You 
can use offcuts in such situations. 

1. Select a product in the Project Explorer. 

2. Enter selected offcuts in the Values field of the Properties Editor. 

• Offcut Top 

• Offcut Left 

• Offcut Bottom 

• Offcut Right 

Note Offcut location may depend on the product’s orientation on the layout. For more 
information, see Controlling Product Orientation. 

In the following illustration, we have changed the Offcut Left and Offcut Right Values to .5”. 

 

Using Groups 

Assigning product groups 

To assign the product group and priority (1–10; 1 is highest priority), use the following steps. 

Notes Before you can assign product groups they must be defined in the Metrix database. See the Metrix Setup 
Guide for complete details. 
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 You can assign up to 10 product groups per layout. Higher priority products are placed first, often nearer 
the grip edge, ensuring the highest print quality. 

 Product groups are not supported with the Display Graphics algorithm.  

1. Select a product from the Project Explorer. 

2. Select a value or option from the product group and priority in the Properties Editor. 

Note You can set product display colors individually or by group. Choose Project > Set All Product 
Display Colors, and then select either Individually or By Product Group. 

Assigning placement groups 

If you need a gap between groups, set the Placement Group Gap property in the User Preferences window. For 
more information, see Auto Layout Preferences.  

You can edit the placement group after you: 

• Select a product. 

• Click the Product Group property in the Properties Editor. 

• Select a product group (if it is not already assigned). 

• Click Auto Layout. 

Enter a number (1–10) to indicate the placement order for each product group. 

 

Finishing Groups 

Finishing groups allow you to group together products that share the same finishing requirements onto the same 
layout. These products may require the same foil, coating, or have other unique requirements that are different 
from the rest of the products in the project.  

To add a finishing group to a product: 

1. Select a product from the Project Explorer. 

2. Click the Finishing Group field in the Product Properties.  

3. Select (Edit Finishing Groups) to open the Finishing Groups window.  
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4. Enter the custom name of the Finishing Group.   

  

5. Click  or press enter.   
 

Notes Finishing Group names are not case sensitive.  

 The Name field in the Finishing Group window automatically filters the list as you type.    

 You can add as many finishing groups as you want to the list.  

 

To delete a finishing group: 

1. Select a product from the Project Explorer. 

2. Click the Finishing Group field in the Product Properties.  

3. Select (Edit Finishing Groups) to open the Finishing Groups window.  

4. Choose the appropriate finishing group from the list and click . 

Notes When a finishing group is deleted, all the products in the current project assigned to that 
finishing group are changed to (None).  
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 Deleting a finishing group removes it from the master list that applies to all projects, but if you 
open a project that uses a deleted finishing group, then the finishing group will be re-added to 
the list.  

 

To assign a finishing group to a product: 

1. Select a product from the Project Explorer. 

2. Select a finishing group from the Finishing Group drop-down list in the Properties Editor, or select 
(Edit Finishing Groups) and choose the finishing group from the list in the Finishing Groups window.  

         

Note  The Finishing Group drop-down list in the Properties Editor shows only the finishing groups 
used in the current project. The Finishing Groups window shows all finishing groups. 

Changing Product Stock 

1. In the Project Explorer, select the product. 

2. From the Properties Editor, select Stock > . 

3. Select your new stock from the Stock Selector window. 

Note If the product stock and assigned Layout stock do not match a warning will display. 

Selecting and changing multiple items 

Metrix gives you the ability to select multiple components—products, layouts, or both—so you can change many 
properties of those items at one time. 

When you have only one product or layout selected in the Project Explorer, you see that item in the View Area. 
The Properties Editor displays the properties of the selected item. Those fields that are not gray in the Properties 
Editor are available to be changed manually. 

You can use SHIFT-click (Windows or Mac) to select a range of items, or you can use CTRL-click on Windows 
(CMD-click on Mac) to select non-contiguous items. 

If you select more than one item, the View Area cannot display both items at the same time, so it will display a 
message telling you how many items have been selected. Since the properties of the selected items can be 
different, the Properties Editor then displays the properties of the items differently, giving you the opportunity to 
change some of the properties to be the same for all the items. 

There are basically four kinds of property displays in the Properties Editor: 
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• Properties that have the same values, and are editable will display in regular black text in a field with a 
white background 

• Properties that are not editable and have a gray background 

• Properties that are different will have the words (Different Values) in the field. (Different Values) where 
change is not allowed will have gray italic text with a gray background 

• (Different Values) where change is allowed will be in gray italic text with a white background. When you 
click in the field, the gray italic text will change to regular black text. You can then edit the property so it 
will be the same for all of the selected items. 

Note Properties that are not relevant to one or more of the selected items will disappear from the 
Property Editor. 

If you select enough items, for example layouts and products, you may only be left with the few properties the 
items have in common. 

Note This can be helpful if you want to be sure all products and layouts are on the same stock. 

Tagging Components 

Metrix allows you to tag components. You can tag any component or leave it untagged. You may think of your 
own uses for this function, such as tagging those products that have been approved, or tagging products having 
a particular ink coverage, or products on a particular stock. This simple function can give you greater control over 
selecting, sorting, and filtering items. 

When you tag a component, it is marked with a small tag icon on the lower, right-hand corner of the component 
as seen below. 

 

To tag a component, simply right-click it inside the Project Explorer, and select Tagged from the contextual 
menu. 

 

One of the ways you can use tagging is in sorting or filtering. 

Tagged Component 
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You can also choose to run Auto Plan only on the tagged components in your project. Once you start tagging 
components, you will probably find many uses for this feature. 

Flipping Items and Instances 

Flipping items on a sheet 

In some cases, you may want to print the front of your product on the back side of the sheet and vice versa. The 
following sections in this chapter will explain how to do this. 

Flipping components when perfecting 

Metrix 22.1 allows you to flip print output so that the front side of the products is printed on the back side of the 
layout, arriving face up in the delivery area of the press, when using the Perfected printing method. 

To turn on the Flip Components When Perfecting option 

1. In the Database window, select Presses, and then select the appropriate press. 

2. Click Edit, and then find the Flip Components When Perfecting property in the Edit Press window. 

3. Set the option to True, and then click OK. 
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Notes Metrix will then “flip” all projects planned for that press using the perfected printing method so 
that the fronts of the components appear on the back of the press sheet, and vice versa. 

 This setting applies only to components, not to marks. 

 For more information about how to set up Presses in the Database window, see the Setup 
Guide. 

Flipping component instances individually 

You can flip individual components regardless of the selected printing method. 

Note Flipping is when the front side of products is printed on the back side of the layout so the printed sheet 
arrives face up in the delivery area of the press. 

1. Select the layout and the View tab. 

2. Click the component instance. 

3. In the Properties Editor, select Flipped >True. 

 

Note For more information on Product properties, see Product properties. 
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Rotating Pages 

Rotating a single flat product side 

Note When Bleed properties are unequal, page rotation may require changes to the bleeds. 

1. Click the product in the Project Explorer area. 

2. Click Side 2 underneath the Component Picker tab. 

3. Select the page from the View Area below by clicking on it. 

4. Change the Rotation value in the Properties Editor on left side of the screen. 

Rotating a single folded page 

Note The Rotation property acts on the selected page side only – the reverse side of the page is not rotated. 

1. Select the product in the Project Explorer area. 

2. Select the page from the View Area. 

3. Change the Rotation value in the Properties Editor on left side of the screen. 

Rotating product instances 

To rotate a product instance, use the following steps. 

1. Select the product instance by clicking on it, and then right-click (CTRL-click on Mac). 

2. Select Rotate > 90° CCW,180°, or 90° CW. 

Assigning a Product to a Layout 

Your layout must have one or more products assigned to it before you can generate an Auto layout or use the 
Auto Production function. Use one of the following methods. 

Methods 1-3 

• Drag the product onto the layout in the Project Explorer. 

Note To assign multiple products to a layout, press and hold the Shift or Command key (Mac) or 
Ctr keyl (Win) and click on the products in the Project Explorer. While holding down the 
modifier key, drag the components to a layout. 

• Use the New Product Wizard to assign the product to a layout during product creation. 

• Run Auto Plan to assign all the products to layouts automatically. 

Method 4 

1. Select a product in the Project Explorer. 

2. Choose Assign Component(s) to Layout… from the Project menu. 
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3. Select the layout to which you wish to add the product. 

4. Click OK. 

 

Manually adding a Product to a Layout 

1. Select the layout from the Project Explorer. 

2. Right-click and choose Add Component Instance from the contextual menu. 

Note Add Component Instance places a single instance on the lower-left sheet corner. You must 
already have at least one component assigned to a layout for this option to become available in 
the contextual menu. 

Swapping Component Instances on a Layout 

1. Select the two component instances you want to swap on the layout in the Layout View.  

2. Right-click and choose Swap Positions from the contextual menu.  

Note Swap Positions does not delete the existing dimensions of the products on the layout.  
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Copying Component Instances from One Layout to Another 

1. Open the User Preferences window and select the Auto Layout tab.  

2. Set the Allow a Component to be on multiple Layouts to True.  

3. Hold the Alt key on Windows or the Option key on Mac. 

4. Click and drag a component from one layout to another in the Project Explorer. This adds a copy of the 
component to the new layout. 

 

Note You can move a component from layout to another by clicking and dragging the component without 
holding the Alt or Option key.  

Show/Hide Layout Tooltips 

To show or hide Layout Tooltips: 

1. Right-click on a component instance in the Layout View area. 
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2. Select or de-select Show Layout Tooltips on the contextual menu. 

Using the Metrix Auto Layout Engine 

The Auto Layout feature calculates the best way to lay a project out on a sheet. It works based on the constraints 
and specifications that you provide, calculating the best possible layout for a given scenario. 

Auto Layout does not consider the best, most cost-effective layout overall. It only works within the constraints 
that you specify. For example, it does not consider other possibilities with different parameters (sheet size, 
quantities, printing methods, presses, etc.) from what you specify. 

Note The Auto Layout feature cannot improve on Auto Plan results when the Media Optimization or 
Display Graphics algorithms are used, because these algorithms already find the most optimal layout.  

To run Auto Layout 

3. Select a layout that has one or more products assigned to it.  

4. Select Auto Layout. Auto Layout will present one or several options in the Layout Selector window. 

5. Choose the preferred layout and click OK. 

 

Note Metrix without the Capacity Plus module restricts the Auto Layout and Auto Production engines 
to 16 different products per sheet. Metrix with Capacity Plus allows up to 200 different products 
per sheet. For more information, see Using the Metrix Auto Layout Engine and Using Metrix 
Auto Production. 

Using Metrix Auto Production 

You can use the Metrix Auto Production engine to find the most cost-effective press, printing method, sheet size, 
and product geometry for the currently selected layout. 

It allows you to consider multiple layouts in one action. For example, if you wanted to try an auto layout on a 
layout of various sized stocks, you could run an auto layout on each stock type individually. Or, you could simply 
run the Auto Production feature, and then specify which options (press, sheet size, etc.) you want auto 
production to consider in its calculations. Auto production would then choose the best options and present you 
with the results. 

Note The Auto Production engine cannot improve on Auto Plan results when the Media Optimization 
algorithm is used, because this algorithm already finds the most optimal layouts.  

 Auto Production does work with layouts that were planned using the Display Graphics algorithm; the 
selected press must be digital. 

 If all products have the Filename set to “Blank” for one side, you can only use the One-Sided Printing 
Method; if you want to use a two-sided Printing Method for Auto Production, set the Filename to 
“Unassigned” instead.  

To run Auto Production 

1. Select a layout that has one or more products assigned to it. 
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2. Select Auto Production from the tool bar above the Layout View. 

3. Step through the wizard, selecting Printing Method, Presses, and Sheet Dimensions options for Metrix 
to consider and process. 

4. Click Finish in the Sheet Dimensions window. 

5. Choose your preferred option in the Layout Selector window, and then click OK. 

Note Metrix without the Capacity Plus module restrict the Auto Layout and Auto Production engines 
to 16 different products per sheet. Metrix with Capacity Plus allows up to 200 different products 
per sheet. For more information, see Using the Metrix Auto Layout Engine and Using Metrix 
Auto Production. 

Step and Repeat Using Drag and Drop 

You must add one or more product instances before you can use step and repeat. 

Note For more information about product instances, see Manually Adding a Product to a Layout. 

Step and repeat options 

Action Windows Mac 

Step and repeat selected product ALT-Drag OPTION-Drag 

Step and repeat selected product with Auto 
Bleeds (trim to trim) 

CTRL-ALT-Drag CMD-OPTION-Drag 

Step and repeat using the wizard 

You can use the Step And Repeat Wizard to step and repeat selected product instance(s), considering bleeds 
and page to bleed gap, or with auto bleeds (trim to trim). 

1. Select 1 or more instances. 

2. Select Layout> Step And Repeat from the menu. 

3. Step through the wizard. 
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Working with Product Instances 

Selecting multiple product instances 

SHIFT-click for Windows or Command-click for Mac and select multiple items on a layout or drag-select. Start 
the drag off any product instance. 

 

Drag and drop product instances 

Action Windows Mac 

Drag and snap to another product 
instance, considering Bleeds, Page to 
Bleed Gap, and Offcuts 

Drag and drop Drag and drop 

Drag and snap to the lower left-hand 
sheet corner, considering Bleeds, 
Offcuts, and No Image areas. 

Drag and drop Drag and drop 

Drag and snap to another product 
instance trim to trim 

CTRL-Drag and 
drop 

CMD-Drag and drop 

 

Note To adjust drag and snap sensitivity, go to Settings > User Preferences > Layout View and use the 
Drag and Snap Sensitivity slide bar to set greater or lesser sensitivity. 

Nudging product instances 

To nudge one or more instances left, right, up, or down: 

• On Windows: use CTRL  

• On Mac: use CMD  

Note Nudge increments are 1 mm or 1/16”. 

Moving product instances 

This type of move is relative to the current position. 

1. Select the instances you want to move. 

2. Select Layout > Move… from the menu. 
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3. Enter Horizontal and Vertical values in the Move window. 

Note Positive values move Right and Up, negative values move Left and Down. 

Changing product instance x-y coordinates 

1. Select the instances. 

2. Edit Left, Right, Bottom, and/or Top properties in the Properties Editor. 

Note You can use fractions and mathematical expressions, which Metrix will resolve. 

 

Aligning product instances 

To align the Product Instances: 

1. Select the instance(s) to move. 

2. Select the instance to align with, and then right-click. 

3. Choose Align, and then select a direction. 
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Centering product instances on the sheet 

1. Select the instance(s), and then right-click. 

2. Choose Center Horizontally, Center Vertically, or Center Both. 

Measuring distances between instances 

Note The measuring tools only display the values. If you want to insert a distance notation, use dimensions. 
For more information, see Adding Dimensions to the Layout.  

1. Select two instances in the View Area. 

2. Review the measurements in the top right corner. 

Icon Displays this measurement Icon Displays this measurement 

 
The horizontal gutter amount 

 

The distance from bottom trim 
edge to bottom trim edge 

 

The vertical gutter amount, from 
trim edge to trim edge.  

The distance from right trim 
edge to right trim edge. 

 

The distance from left trim edge 
to left trim edge  

The distance from top trim edge 
to top trim edge. 

Removing instances from layouts 

1. Select an individual or multiple instance in the Project Explorer or View Area.  

2. Right-click and choose Remove from Layout to remove the instance from the layout without deleting it 
from the project.   
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Layout Tooltips 

Layout tooltips allow you to view the component instance number, product size, and planned color.  

To enable and use Layout Tooltips: 

1. Right-click on any component instance on the layout.  

Note Layout Tooltips will be applied globally to all layouts in your system.  

2. Choose Show Layout Tooltip.  

3. Hover on the component instance to see the layout tooltip.  



Working with Projects | User Guide ⚫ 91 

 

 

 

 

Manually Setting the Run Length 

The Required Sheets property is the layout run length calculated by Metrix during an auto layout, auto production, or 
auto plan. When products are placed manually, you need to recalculate the run length. 

1. Select a layout from the Project Explorer. 

2. Select Layout > Recalculate Required Sheets from the menu. 

Note You can also edit the Required Sheets property manually. 

 

Content Previews  

Content Previews allows Metrix to instantly show a live preview of the assigned PDF content files. Metrix uses 
industry-standard Adobe preview technology to generate the content previews, and stores these page previews 
locally for instant retrieval. Content Previews works on Mac or Windows, and you can toggle Previews on and off with 
easy keyboard commands.  

Note  You must have PDF content applied to a product to use the Content Previews. 

In the Project Explorer, with a product selected, you can see in the Content File property that PDF content has 
already been assigned to this product. 
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Displaying assigned content 

When you select a product, component, or layout and then click above the Layout window, the product 
will display the assigned PDF content. 

 

 

 

Selected 

Product 

PDF Content 

is assigned 



Bound Work | User Guide ⚫ 93 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bound Work 
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Bound Component Symbols 

 First Fold Page 

 Jog Edge 

 Spine Edge 

 Lay Side (the first side/edge to enter the folding machine) 

Non-Lay Side 

 

Handling Spreads (Cover Only) 

Turning a cover page into a spread 

1. Select a cover component. 

2. In the Properties Editor, select Combine Pages > True. 

Notes When the “Combine Pages” property is set to False (the default), the cover pages will be 
treated as separate pages. 

 If the “Combine Pages” property is set to True, the cover pages will be treated as spreads. 

 How “Combine Pages” is set determines how Metrix imposes PDF graphics. 

 For example, in the example following, since “Combine Pages” is set to True, Metrix expects 
the graphic to consist of two pages, one for each spread. If “Combine Pages” were set to False, 
Metrix would expect the graphic to have four pages, one for each separate page of the cover. 

Jog Edge 

Jog Edge 

First Fold 
Page 

Lay Side 

Non Lay  

Side 

Spine 

Spine 
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Handling Folding 

Fold choice in the New Product Wizard 

The Metrix New Product Wizard chooses the fold that’s been promoted to the top of the list in the database, for 
the number of pages selected as the Largest Text Component. 

To change the fold or page count 

1. In the Project Explorer, select the product. 

2. In the Assembly View, select the component. 

3. Right-click, and then choose Edit Component Fold. 
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4. In the Fold Selector window, select the Page Count in the Filter by Fold Pages option. 

5. Select the fold pattern. 

Working with Components 

Reordering components 

1. Select the product in the Project Explorer. 

2. Drag and drop component. 

 

3. Drag and drop to Pre-collate. 

 

Deleting a component 

1. Select a product in the Project Explorer, and then select the component from the View Area. 

2. Right-click on the component, and then choose Delete. 

Removing a component from a layout 

You can remove a component from a layout without deleting it from the project.  
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1. Select a component on a layout in the Project Explorer or the View Area. 

2. Right-click on the component and select Remove from Layout. 

Note Remove from Layout in the Project Explorer removes all component instances from the layout. 
Remove from Layout in the Layout View removes only the selected component instance(s) from 
the layout.  

 

Changing the component stock 

Note Component stock must match the layout stock it is assigned to. For more information, see Changing the 
Layout Stock.  

1. Select a component in the Project Explorer. 

2. Select Stock > . 

3. Choose New Stock in the Stock Selector window. 

Shingling 

Using Automatic Shingling 

When the Automatic Shingling option is disabled by default, you can still enable shingling for individual products. 
Alternatively, you can enable automatic shingling by default. For more information, see Shingling Preferences. 

1. Select a product in the Project Explorer. 

2. Select Shingling > . 

3. Choose Shingling Parameters from the window of the same name. 

 

Shingling Properties 

Property Explanation 

Type (None) / Auto / Manual The type of shingling to use. 

Method Move / Scale Whether the page image will be moved or scaled. 

Inner % 0 – 300 The percentage of the total calculated shingling amount to be 
applied to the center (inner) 4-page set of product pages. 

Only editable when auto selected. 

Inner Value The amount of shingling to apply to the innermost 4-page set. 

Outer Value The amount of shingling to apply to the outermost 4-page set. 

Only editable when Manual is selected. 

Shingle Trim Marks True / False Add or not add shingle trim marks to page on export. 
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Shingling calculations – Inner % 

A few examples will illustrate how the Inner % value of Metrix shingling works. 

Example 1: 100% inner 

We have inserted 100% of the total shingling amount calculated for this product (.061") on the innermost pages, 
feathering out to 0" for the outermost pages. 

 

Example 2: 80% inner 

We have inserted +80% of the total shingling amount calculated for this product (.0488”) on the innermost pages, 
feathering out to –20% (–.0122) for the outermost pages. 

 

Custom Shingling 

1. Select a component in the Project Explorer. 

2. Select a page from the Properties Editor. 
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3. Select Custom Shingling > True in the Properties Editor. 

4. Enter a value. 

 

 

Pulling Back Images in the Spine 

This is sometimes necessary to accommodate gluing. Entering a negative value in the Bleed Left property of the 
Text node will apply a negative bleed in the spine of all text components. 

1. Select the Text node. 

2. Enter a negative value in the Bleed Left property value. 
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Changing the Binding Parameters 

1. Select a product in the Project Explorer. 

2. Select Building Parameters >  . 

3. Choose parameter in the Binding Parameters window. 

Binding Parameters Properties 

Property Explanation 

Method Binding Machine Defaults / Custom The binding machine setup to use. 

Stack Item Count The number of finished products to stack once binding is complete, to 
bundle up for delivery. 

 

Stack Layer Item 
Count 

The number of finished products to stack in each layer. Layers are usually 
rotated by 180° to compensate for variations in thickness from the spine to 
the face. 

Number of Stitches 
(Saddled) 

0 / 1 / 2 / 3 / 4 

The number of stitches for this saddle-stitched product. 

Staple Shape 
(Saddled) 

Crown / Butted / Eyelet 

The staple shape for this saddle-stitched product. 
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Side Scores from 
Spine (Side-By-Side, 
0=None) 

For perfect bound (side-by-side) products requiring two extra scores on the 
cover sides, one on the front and one on the back, for a total of 4 scores. 
The value indicates the distance from the spine scores. Valid range: up to 
25.4mm or 1". A value of 0 (zero) indicates no extra side spine scores. 

 
 

Changing the Cover Spine Width 

1. Select a product in the Project Explorer. 

2. Select Calculate Cover Spine > Manual in the Properties Editor. 

3. Enter a value for the Cover Spine Width of the Properties Editor. 

Creating a Book with No Cover 

Metrix always creates a cover component. However, you can still create a book with no cover by deactivating the 
cover component. If a layout has already been created for this component, delete the layout. Use the following 
steps. 

1. Select a cover component in the Project Explorer. 

2. Right-click, then select Active. 

Changing the Layout Stock 

1. Select a layout. 

2. Select Stock > . 

3. Choose New Stock, and then click OK. 

Note Layout and Component stock must match. For more information, see Changing the Component 
Stock. 

Auto Expand Trims to Fill Sheet 

Metrix 22.1 includes the Auto Expand Trims feature, which allows Metrix to automatically expand the Non-Jog 
Trim, Face Trim, and Back Face Trim to fill the sheet, while maintaining the lip as a default. Previously in 
Metrix, you had to manually adjust the trims on a layout and then save it as a standard. Now you can set a User 
Preference and trims will be expanded automatically. 

When the Auto Expand feature is enabled, Metrix does the following: 

• Subtracts the Flat Width and Flat Height from the sheet size assigned to the selected component. 

• Applies the extra space (Sheet Height – Flat Height = y) to the Non-Jog trims. 

• Change the Non-Jog Trim to [current value]+y/2. 

• If there are two Front Face Trim margins and two Back Face Trim margins on this component, the 
extra space on the component sides (Sheet Width – Flat Width = x) is applied to the Face Trims. To 
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maintain the current lap, the Front Face Trim and Back Face Trim margins are set to [current 
value]+x/4 

• Respects the Binding Machine settings, so trims will not expand more than the maximum allowed by 
the binding machine nor contract more than the minimum. 

Auto Expand Limitations 

• Can be applied only to one or two identical components that are oriented head-to-foot or head-to-head 
on a sheet. There can be no mixed types of components, and no more than two per sheet. 

• Applies to only bound products with 4-, 8-, or 16-page folds. 

• Finished size must be the same for all components. 

• Auto Expand Trims is not applied in all workflow use cases where there are multiple scenarios for 
solutions. 

To use Auto Expand Trims: 

1. Select User Preferences > Auto Layout. 

2. From the Auto expand/contract face and non-jog trim to fit sheet menu, select True. 

Creating Calendar Style Products 

Calendar style – Spine edge 

 

Note Checking the Rotate Pages for Calendar Style checkbox rotates the pages so the spine is on top, and 
orients them head-to-foot. 

Calendar style – Page size 

The text on this window can help you in determining how to enter the finished size for a calendar style product. 

The width is the distance from the spine to the face edge, the height is the distance from the jog to non-jog edge. 



Bound Work | User Guide ⚫ 103 

 

 

 

 

 

  



104 ⚫ Productivity Suite | User Guide 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Flat/Folded Work 
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Handling Folded Product Spreads 

When the Combine Pages property is set to False (the default), the product pages will be treated as separate 
pages. 

If the Combine Pages property is set to True, the product pages will be grouped together as one object, also 
known as a spread. 

How Combine Pages is set determines how Metrix imposes PDF graphics. 

For example, in the example below, since Combine Pages is set to True, Metrix expects the graphic to consist 
of two pages, one for each spread. If Combine Pages were set to False, Metrix would expect the graphic to 
have six pages, one for each separate page of the product. 

 

Note You should always enter the folded product size as the finished size (folded and trimmed size), 
regardless of the Combine Pages property setting. 

Understanding Metrix Folding 

The numbering of all folded product pages is controlled by the Metrix Folding Wizard, based on the fold up/fold 
down sequences selected. Metrix determines the numbering based solely on the operations performed by the 
folding machine on the physical sheet of paper to arrive at the final folded stack of pages, independently of the 
content. 

Drilling down to ascertain page sequence 

Metrix considers the folding operations on the paper independently of the content. Therefore, the best way to 
ascertain the actual content sequence and orientation – as required by the physical folding operations – is to 
visualize “drilling down” on the folded and rotated sheet. Drilling down on a 6-page accordion fold, with the jog 
edge at the head and the spine at the left, can be visualized as follows: 
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In this example, the drill first touches page 1 and then it’s back, page 2. The next page touched is page 3, 
followed by 4. Each successive page touched by the “drill” is the next sequential number. Using this method, you 
can ensure that the content received matches the actual page sequencing required by the folding pattern. 

Changing the folding pattern 

1. Select a Product in the Project Explorer in the top left of the screen. 

2. From the Properties Editor, select Fold Name >  . 

3. Select a new fold from the Fold Selector window. 

 

Reading the fold diagrams 

Corner symbol 

The L-shaped, solid blue angle (  ) is the reference edge lay mark on the lower, left-hand corner of the lay side 

of the sheet. The dotted angle (  ) is the same reference edge lay mark as viewed from the non-lay side. 

Blue triangles 

The small blue triangles on the fold diagram represent the jog edge after folding. This is the same as in the 
layout view in Metrix. 

Green and red lines 

Green line - the side of the sheet indicating the fold direction for green fractions. 

Red line - the side of the sheet indicating the fold direction for red fractions. 

You could think of it this way: green always folds onto green, and red always folds onto red. 

Folds on the green line are always left to right. 

Folds on the red line are always bottom to top. 

Up and down arrows 

The up and down arrows () indicate the direction of the fold relative to the lay side of the sheet. 

“Fold up” () means toward the lay side (toward you) and on top of other pages. 

“Fold down” () means toward the non-lay side (away from you) and under other pages. 

Fractions 

The fraction is always part of the whole, unfolded sheet. It is not the part of the remaining “visual” pages after 
other folds have been made. 
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For example, on a fold diagram with a green line of 8 pages, and a red line of 2 pages, 1/2 means 4 pages on 
the green line, but 1/2 means 1 page on the red line. 

 

For a 20-page fold, with 10 pages wide (green line), and 1 page long (red line), the lay side might look like this: 

 

Given this configuration, 1/10 = 1 page, 1/5 = 2 pages, 2/5 = 4 pages, 1/2 = 5 pages. 

So, if you fold 1/2, you will fold the 5 left pages over the 5 right pages, because 1/2 of 10 is 5. If you were doing 
this with real paper, you would then see 5 pages from the non-lay side of the sheet, like this: 

 

If you then fold down 1/5, you do not fold one page down (page 4), but two pages (pages 4 and 1), because 
1/5 here means 1/5 of 10, which is 2 pages, and not 1/5 of the 5 pages you see (which would be 1 page). The 
result is: 

 

Thus, the fractions are based on the overall, unfolded sheet, and not on what remains after folds have been 
made. 

Database Conventions and Folded Page Size 

The Metrix Database contains two conventions that can affect the page size of folded products, depending on 
the folding pattern selected: 

• Roll Fold Clearance 

• Flush Fold Excess Maximum 

Note You can only edit the conventions if you have a User role with permission to Edit or Delete 
Database items. See the ePS Metrix Setup Guide and Worksheets for more information on 
creating Users and User Roles. 

Changing a Folded Panel (Page) Size 

1. Select a product in the Project Explorer. 

2. Select a page in the Properties Editor. 

3. Edit the Width in the Properties Editor. 
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Component Picker 
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What is the Component Picker? 

If a project has only a few products, and a few layouts, it is simple to find the individual components to modify 
them. 

However, if a project has hundreds of products, and dozens of layouts, finding and changing components could 
then become a daunting task. 

The Component Picker makes the job of finding and changing multiple components as easy as sorting and 
filtering items in a list. 

The basic elements of the Component Picker include: 

• A table in the view area where each row represents a component in the current Metrix Project, and each 
column represents a component property 

• A window to select different component properties to display in the table. This gives you the ability to 
filter by only those properties pertaining to the current project 

• Simple­to­use but comprehensive filtering functions that you can tailor to your specific needs 

• Boolean AND, OR, and NOT searches at the click of a mouse, or with a menu selection 

• The ability to sort a column ascending or descending by clicking the header, much like other tables in 
Metrix where you can rearrange the column order 

• The ability to modify or tag multiple filtered items in the Project Explorer. 

• You can save multiple filtering parameters as a set and then re­load them for use with the same or other 
projects 

Using the Component Picker 

Opening the Component Picker table 

You access the Component Picker by clicking Component Picker above the View Area. 

 

The Component Picker table will then open in the View Area. 

Notes The default filter selection is “Assigned to a Layout is Either.” That way all components in the current 
project will be displayed in the table, whether those components are assigned to a Layout or not. 

 You can change the Either selection to True or False. A selection of True will display only those 
components that are assigned to a Layout. A selection of False will display only those components that 
are not assigned to a Layout. 

 This default filter cannot be removed, because all components must fall into one of these three 
categories. That is why X (delete) on the right side is gray. 
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Click the small, gear-shaped icon just below the View Area on the right side. This will open the “Column 
Selection” window, where you can determine which columns will appear in the Component Picker table. 

Setting up the Component Picker property columns 

After you click the gear icon, the Column Selection window opens. Check the box of each component property 
you wish to appear as a column in the Component Picker table. Pick the properties that will be most useful to you 
in the filtering process. When you have made your selections, click OK to close the window and return to the 
Component Picker table. 

The Component Picker control icons 

The filtering process in the Component Picker is governed by the icons located above the table. Those icons 
include: 

• Expand/Collapse Filter View ( ) - Clicking this icon either hides or shows the filters. 

• Number of Active Filters ( ) ­ Shows the number of filters, even if the filters are hidden. 

• Save Filters ( ) ­ Saves the current filters as a set. 

• Load Filters ( ) ­ Opens a window of the currently saved filter sets so you can load one. 

• Add A Filter ( ) ­ Opens a new filter. 

• Add A Group ( ) - Opens a filter group. Groups are used for more complex filtering. 

• Delete A Filter ( ) ­ Clicking the red X deletes that filter from the list of filters. 

 

 

 

 

 

 

Click Gear  
Icon 

Component Picker 
Table 
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Using the Component Picker filters 

Below is an illustration of the Component Picker where we have added one filter by clicking . Then we 
selected “Type” on the first component menu, and “Flat” on the second. Consequently, only the components with 
the Type marked as Flat are selected. Those components with “Bound” or “Folded” as the Type property have 
been excluded from the list. 

The first menu is always the list of component columns that are selected in the Component Picker- Column 
Selection window. 

The second, or subsequent menus, will be options for the first component property. 

On some filters, a text field will open where you can type in numbers, such as a width, a height, or an integer for 
establishing a number or range of numbers. 

 

Editing components and Component properties 

Editing the Component properties 

Once you have filtered the components, you can change the properties of those components in basically four 
ways: 

• Single Components – You can select just one component by clicking it in the Component Picker, and 
then change its properties in the Properties Editor. 

• Multiple, non-contiguous components – You can select non-contiguous components in the Component 
Picker, and then change the properties of just those components in the Properties Editor. 

Filtered / Total 

Components 

Number of  

active filters 

 

Expand / Collapse  

filter view 

 
Save filters 

Add a filter Load filters 

Add a group 

Delete  
a filter 
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• Contiguous series of components – You can select a contiguous series of components in the 
Component Picker, and then change the properties of just those components in the Properties Editor. 

• All filtered components – You can select all the filtered components in the Component Picker, and then 
change the properties of all the components in the Properties Editor. 

Not all the properties of the selected components will be available for editing, but if the background field is white, 
or white with gray text, then you can change the property. 

If the background field is gray, then you cannot change the property. 

Important Be careful when changing fields marked as “(Different Values)” because entering a new value will 
change all selected components to that value. You may want to check the selected components 
first to see if you want all the components to have the same value for that property. 

If the fields are visible in the Component Picker table, you will see the property changes reflected immediately in 
the table. 

Editing the properties of a single component 

To edit a single component, click that component in the Component Picker table, and then change the properties 
in the Properties Editor. 

Note The Properties Editor lists the name of the single component being changed. 

 

Editing the properties of non-contiguous components 

To edit non-contiguous components, CTRL-click (CMD-click on Mac) the components in the Component Picker 
table, and then change the properties in the Properties Editor. 

Note The Properties Editor lists the number of selected components being changed. 

Editing a contiguous series of components 

To edit a series of components: 

1. Click the first component in the Project Explorer, and then SHIFT-click through to the last component in 
the series. 

2. Then change the properties in the Properties Editor. 

Note The Properties Editor lists the number of selected components being changed. 

Editing all the filtered components 

You can select all the components in the Component Picker table in two ways: 

Name of selected 
component 

The component 
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• If you can see both the first and last components in the list, you can click the first component, and then 
SHIFT­click the last. 

• If the list of components is so long that you cannot see the last component, click the first component in 
the table, and then use CTRL­A (CMD-A on Mac) to select all components. 

Then change the properties in the Properties Editor. 

Note The Properties Editor lists the number of selected components being changed. 

The Component Picker property options 

Here is a table of the property options (the first menu on a filter) for the Component Picker, and the additional 
options for that property. The additional options may be pull­down menus, text fields, or both. 

Property (First 
Menu) 

Options (Second, Third, or Fourth Menu) 

Component ID Any / Matches / Contains / Begins With / Ends With 

Selections other than Any open a text box to enter all or a portion of the 
Component ID for filtering. 

Type (is)Any / Flat / Folded / Bound / Diecut 

A table displays either all types of products, or only the type designated in 
the second menu selection. 

Name Any / Matches / Contains / Begins With / Ends With 

Selections other than Any open a text box to enter all or a portion of the 
name for filtering. 

Description Any / Matches / Contains / Begins With / Ends With 

Selections other than Any open a text box to enter all or a portion of the 
description for filtering. 

Notes Any / Matches / Contains / Begins With / Ends With 

Selections other than Any open a text box to enter all or a portion of the 
notes for filtering. 

Due Date Any / Matches / Contains / Begins With / Ends With 

Selections other than Any open a text box to enter all or a portion of the due 
date for filtering. 

Customer Req. Date Any / Within Last / Within Next / Exactly / Before / After / Today / 
Tomorrow / Yesterday / This Week / 

This Month / This Year 

Any selects components with any date, including components with nothing 
in the date field. 

Within Last opens a field to enter an integer, and a drop­down menu with 
days, weeks, months, and years. 

Within Next opens a field to enter an integer, and a drop­down menu with 
days, weeks, months, and years. 

Exactly opens a third menu with the current date selected. Clicking the 
drop-down triangle opens a calendar where you can scroll to and select an 
exact date. 

Before opens a field to enter an integer, and a drop­down menu with days, 
weeks, months, and years. 

Today opens a third menu with the current date selected. 

Tomorrow opens a third menu with tomorrow’s date selected. 

Yesterday opens a third menu with the yesterday’s date selected. 

This Week (Month, Year) select components with a date within those date 
ranges. 

Production Date Any / Within Last / Within Next / Exactly / Before / After / Today / 
Tomorrow / Yesterday / This Week / 
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This Month / This Year 

Any selects components with any date, including components with nothing 
in the Date field. 

Within Last opens a field to enter an integer, and a drop­down menu with 
days, weeks, months, and years. 

Within Next opens a field to enter an integer, and a drop­down menu with 
Days, Weeks, Months, and Years. 

Exactly opens a third menu with the current date selected. Clicking the 
drop-down triangle opens a calendar where you can scroll to and select an 
exact date. 

Before opens a field to enter an integer, and a drop­down menu with Days, 
Weeks, Months, and Years. 

Today opens a third menu with the current date selected. 

Tomorrow opens a third menu with tomorrow’s date selected. 

Yesterday opens a third menu with the yesterday’s date selected. This 
Week (Month, Year) select components with a date within those date 
ranges. 

Customer Any / Matches / Contains / Begins With / Ends With 

Selections other than Any open a text box to enter all or a portion of the 
Customer Name field for filtering. 

Active Either / True / False 

Either displays all components, whether the Active property is set to True or 
False. 

True displays only those components with an Active property of True. 

False displays only those components with an Active property of False. 

Req. Quantity Any / Equals / Less Than / More Than 

Selections other than Any open a field to enter an exact number, or a 
range, for the required quantity. 

Finished Width Any / Equals / Less Than / More Than 

Selections other than Any open a field to enter a measurement establishing 
a range for the finished width. 

Finished Height Any / Equals / Less Than / More Than 

Selections other than Any open a field to enter a measurement establishing 
a range for the finished height. 

Grain (is) Any / Horizontal / Vertical / Either / Either-All Same / (Different 
Values) 

Any selects all grain directions. Horizontal, Vertical, Either, and Either-All 
Same select only the components with that specified grain direction. 
(Different Values) is disabled because it is not possible for a component to 
have more than one grain direction. 

Stock (is) Selecting the Stock property opens a second menu listing all of the 
stocks assigned to components in the project. 

Priority Any / Equals / Less Than / More Than 

Selections other than Any open a field to enter an integer. For Equals, the 
components must have the exact priority listed in the field to be selected. 
For Less Than, the assigned priority must be less than the integer selected. 
For More Than, the assigned priority must be more than the integer to be 
selected. 

Product Group (is) Selecting Product Group opens a second menu listing all of the names 
of the product groups. 

Combined Pages (is)Either / True / False 

Either selects all components, whether the Combined Pages is set to True 
or False. True, and False select only the components with that particular 
Combined Pages setting. 
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Page Count Any / Equals / Less Than / More Than 

Selections other than Any open a field to enter a number for the exact Page 
Count, or to establish a range for the Page Count. 

Fold Name (is) Selecting Fold Name opens a second menu listing all of the names of 
the folds used in any of the components, or (N/A) for those components that 
are not folded. 

Color(s) Selecting Colors opens three additional menus: 

Menu 1 options: 

Both Sides, meaning that both sides of the component contain the color 
designated in Menu 3. 

Either Side, meaning that either side of the component contains the color 
designated in Menu 3. 

Side 1, meaning that only side 1 of the component contains the color 
designated in Menu 3. 

Side 2, meaning that only side 2 of the component contains the color 
designated in Menu 3. 

Menu 2 options: 

Is, meaning the color designated on Menu 3 is the only color on the 
designated side(s). 

Is Not, meaning the color designated on Menu 3 is not the only color on the 
designated side(s). 

Contains, meaning the color designated on Menu 3 is only one of the colors 
on the designated side(s). 

Does Not Contain meaning the designated color is not one of the colors on 
the designated side(s). 

Menu 3 options: A pull-down menu listing all the colors used in the 
components. 

Using Group Filters in the Component Picker 

Group filters work basically the same as the regular filters in the Component Picker. The difference is that group 
filters allow for more complex filtering logic, with extra visual help to set up the filtering. 

The regular filters are basically a way of selecting components that meet multiple property criteria in one 
component—the component must have this property, AND this property, AND this property to be selected. This 
is usually referred to as a Boolean AND search. For example, the component must be flat, AND not wider than 
3.5” AND have CMYK colors on both sides. This will result in a narrower set of components that meet all the 
criteria. 

You can search for a set of components where there are various properties, and the component meets the 
criteria if it has any one of the properties. This is commonly referred to as a Boolean OR search. For example, 
the component must be Flat, OR not wider than 3.5” OR have CMYK colors on both sides. But the component 
only needs to meet any one of the criteria. This will result in a broader set of components that meet the criteria. 

You can also search for components that have one property, but do not have another (Flat, but not CMYK). This 
is known as a Boolean NOT search. This is most obvious in those menus that have Either, True, and False 
options. If you select Either, then you are doing a Boolean OR search. Components with either True OR False 
in the property field will be selected. But if you select True, then all components with False in the field will be 
excluded, Thus, you are saying “this,” but NOT “that,” and you are performing a Boolean NOT search. 

Group filters look a little different from the regular filters, but they add and remove filters in the same way. The 
biggest difference is probably with the first line of a group filter. It is in the first line that you establish what kind of 
filtering you want to perform. 

The first line has a menu with Any or (All) as options. This gives you two options: 

• Any of the following are true. 

• All of the following are true. 
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Since the “Any of the following are true” option produces an extended Boolean OR filter (this, or this, or this, or 
this, etc.), it can be easier to arrange than trying to use the standard filters to do the same. 

Here is an example of a group filter that selects components with a Flat Type, or Folded Type, or components 
with a Finished Width of 3.5”, or components with a Finished Width of 22.75”. 

 

To create a group filter 

1. Click , and then select Any or All from the drop-down menu. 

2. Click , and then select what your criteria you want to use from your filter. 

3. Create additional layers, if needed. 

Notes Group filters can be nested under other filters, including other group filters, for even greater 
refinement of the selection parameters. 

 Each of the filters in a group filter are counted separately. 

 Deleting a group filter deletes the group, and all of the regular filters associated with it. 

Saving and Loading Filter Sets 

Saving a filter set 

When you are working in the Component Picker and have established a set of filter parameters you wish to use 
more than once, you can save the filters as a set to be re-loaded later. 

1. Click  to open the Save Filter Set window. 

There are two fields in the window, one for the name of the filter, and one for a description of the filter 
set. Only the Name field is required. 

2. Click OK to save the filter set. 
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Loading a filter set 

If you open the Component Picker and wish to apply a saved filter set to the components in the current project, 
click the Load Filters icon above the View Window. 

 

A window will open showing all saved filter sets in the Database. 

To load a filter set, first click its name in the list to select it, and then click ADD. If no filter set is open, Metrix will 
open the selected set. If a filter set is open, Metrix will add the selected set to the current set. 

If you have a filter set open, but wish to replace it with a different set, select the filter set, and then click Replace. 

If you need to find a certain filter set among numerous sets, you can use the filter field to type in text from the 
name of the set. 

Managing Filter sets in the Database 

The Metrix Database keeps track of the saved filter sets for the Component Picker. If you need to edit, delete, or 
clone a set, you can do so by opening the Database window with no project open. Follow these steps to perform 
one of the previously mentioned actions. 

1. Select Database from the Settings menu to open the Database window. 

2. Select the filter set you wish to edit. 

3. Select one of the buttons on the right side to choose one of the actions listed below. 

 

There are three actions available for filter sets in the Database: 

• Variation – You can make a variation, or clone, of a filter set by selecting its name in the list, 
clicking Variation, and then editing the set in the Variation window that opens. You can only 
change the Name and Description entries. 

• Edit – You can edit a filter set’s Name and Description data by selecting the set in the list and 
clicking Edit. In the Edit Filter Set window that opens you can change the Name and Description 
fields. 

• Delete – If you wish to delete a filter set from the Database, you select the set in the list, and then 
click Delete. 

When you return to the Component Picker, the changes you made in the Database will be reflected in the Load 
Filters window.
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The Run List 
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What is the Run List? 

The Run List is a mechanism allowing multiple source files to be associated with a single component via a kind 
of file browser that allows you to view the parameters of various source files and then associate some or all 
those files to various pages of components in a project. 

The Run List allows you to split source files, rearrange page, allow for missing pages, and use a single source 
file in multiple products. 

Advantages of the Run List 

Past versions of Metrix allowed only a single source PDF file to be associated with a component (Flat, Folded, 
Bound Text, or Bound Cover). There are many scenarios where this is not sufficient. Source files may be 
supplied in pieces or incorrect order, and pages within source files may change at the last minute. Some 
example cases that the Run List can address are: 

• Split source files: Contiguous (for example, a 200-page bound product that comprises 10 sequenced 
20-page PDFs). Non-contiguous (for example, a 56-page bound project that comprises a 56-page PDF 
plus a 4-page PDF that replaces 4 of the pages in the 56-page PDF) 

• Page reassignment: After the initial page assignment is complete, you can move or reassign pages to 
place them in a different order from the original source file. One example is a folded product in which 
the individual pages were designed in an order that did not anticipate the Metrix “drill down” method of 
page ordering 

• Missing pages: Often, particularly with respect to bound projects, a customer will submit PDF source 
files in sections, requiring Metrix to allow an incomplete Run List. The Run List permits exporting some 
of the layouts of the project (to imposed PDF) if all the pages on those layouts are present while others, 
on other layouts, are missing 

• Multiple Products in a single file: The Run List allows splitting out individual products from a single 
multi-page content file. A specific example is 100 double-sided card products with the content supplied 
as a single 200-page PDF file 

How to open the Run List 

When a project opens, the View Area tab is selected, normally with a layout displayed in the View Area. If there 
is nothing to display, the View Area tab appears as a gray rectangle and the View Area is empty. 

To the right of the View Area tab is the Component Picker tab, and to the right of that is the Run List tab. 

Click the Run List tab (next to the Component Picker tab) to display the Run list for the selected project. 

 

The Run List Window 

The two major parts of the Run List window are the File List and the Run List. 

The File List displays all content files added to the project, whether or not they are assigned to product. The File 
List contains two sections. The File List is on the left while the Page list is on the right. 

The Run List displays either some or all products in the project and the properties of the content associated with 
those products. 

Previously, you could only add files by associating them with a component. The File List provides a separate 
mechanism by allowing you to import any number of content files independently of components, and manipulate 
their page position associations with a much greater degree of control. 

The Status column below the Run List is also useful for checking the status of the items in the Run List, 
especially when there are problems. 
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The File List window 

The files in this list appear in alphanumerical order. Green checkmarks appearing in page icons indicate how 
many pages the content is assigned to. 

At the top of the File List window are three buttons and a menu. They are: 

• Add Files ( ): Clicking Add Files opens a standard browsing window where you can navigate 
the file subsystem to choose PDF content files. You can select multiple files and add them 
simultaneously to the File List. Files appear and are added in alphanumeric order. You can add them 
prior to creating products. 

• Remove ( ): This removes the selected file(s) from the File List. Any pages from among the 
files selected that assigned to the Pages List will also be removed. 

• Relink ( ): This allows you to link to a new file if the original file is missing or needs to be 
replaced for any reason. 

The Relink window 

Clicking Relink ( ) opens the Relink File(s) window. When the Relink window opens, the name of the file 
selected in the File window appears in the Relink File(s) window. You can use this window to browse and select 
the file to replace the missing content. 

 

File List 

Run List 
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When you select the “Search for Missing Links in this Folder,” all unlinked files (files that have been moved or 
renamed) will be listed in the Relink File(s) window. If they are found in the same folder, they will be 
automatically linked when you click OK. 

Note The Remove and Relink buttons are only available when you select a file in the File List window. 

The Show Files menu 

The Show Files menu appears in the top section of the File List. It has options for displaying content files for the 
entire project, or just the content files for the selected product(s). Show All Content Files is the default setting. 

To the right of the Show Files menu is the Show Blank Page check box. Clicking this check box adds a Blank 
Page option to the pages in the File List window. From there you can drag the Blank Page into the Run List 
window to add or insert blank pages into the Run List. 

Displaying the Content of the File Pages 

Right-clicking on a page in the File List brings up an image of that page. 

Page size and page colors are displayed in the Preview window. 

There are also page selection arrows at the bottom of the image allowing you to move back and forth, page by 
page, through the images in the file. 

 

Adding Content to the File List 

You can add content files in the following ways. 

• The Add Files button: As described in the File List window section, clicking the Add Files button opens 
a browse window. You can then locate the content file you want and import it into the File List. 

Drag and drop 

• From the Finder/Explorer into the File List: Pages are added to the File List in alphanumeric order 

• From the Finder/Explorer directly into the Run List: Files are automatically added to both the Run List 
and the File List 

Note Since the files are added to both lists, this is a dual copy function. Thus, if you want to undo this 
action, you need to use Undo twice—once to remove the file from the Run List, and again to 
remove the file from the File List. 

File List operations 

• Files appear in the File List in alphanumeric order. 

• A green checkmark appears in the page icon in the File List when a content page is assigned to a 
product. When two green checkmarks appear, two or more products are assigned to that content page. 

File colors and 
page size 

Arrows that allow 
you to see all file 
images 
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• A horizontal scrollbar appears when there are more pages to display horizontally than you can view in 
the currently sized pane. A vertical scrollbar appears when there are more files to display than you can 
view. 

• You can select one or more pages, or the whole file, but not both at the same time. 

• You can select multiple complete files, as well as multiple individual pages from multiple files. 

• Files are added to the Run List in file/page order. 

• When you click an individual file icon, you select all the pages in that file. 

• Files and pages appear highlighted in blue when selected. 

• Pressing the CRTL (Windows) or CMD (Mac) key, and then clicking additional pages selects non-
contiguous pages. 

• Clicking one page, holding down the SHIFT key, and then clicking the last page in the range selects a 
contiguous range of pages. Clicking one page, holding down the CTRL/CMD key, and then clicking 
additional pages selects non-contiguous pages. 

Run List window operations 

Selecting only one product means that is all that will appear in the Run List. If you multi-select two or more 
products, all selected products appear in the Run List. 

A menu above the Run List includes the following options to filter the Run List display. 

• Show All 

• Show Fronts (Odds) 

• Show Backs (Evens) 

• Show Covers (Bound) 

• Show Text (Bound) 

When files are added from the File list to the Run List, they are applied only to currently displayed products. 

Note Products in the Run List appear in the same order in which they appear in the Project Editor. To reorder 
products in the Run List, you must reorder them in them in the Project Editor. 
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Columns in the Run List window 

Run List Columns 

Column Title Explanation 

Product Displays the name of the product. 

This column will always be visible when scrolling horizontally in the Run List. 

Position Shows the page position in the product. 

Bound Products: This is the numerical value. 

Flat Products: This is described as “Front” or “Back”. 

Combined pages: Components with Combined Pages will also show as 
“Front” or “Back.” 

This column will always be visible when scrolling horizontally in the Run List. 

Cover/Text Shows whether the page is a cover component or a text component with a 
“C” or “T” and the page number. For Flat and Folded products, this column 
will be empty. 

The column is always visible when scrolling horizontally in the Run List. 

File Name Displays the name of the PDF if a page has been assigned from the Files 
List. 

Unassigned displays red and indicates that the page is awaiting content. 

(Blank) indicates that the page is intentionally left blank. For example, when 
all new chapters should begin on an odd-numbered page, but in the content 
file the previous chapter ends on an odd- numbered page. 

Clicking a file name opens a menu where you can reset the selected file 
name to “Blank,” or “Unassigned.” 

Clicking the gear icon in the File Name column header opens a menu where 
you can reset all file names to “Blank,” or “Unassigned,” or you can remove 
extra rows from the Run List. 

A tool tip on this field shows the full path of this file. A file path also appears 
when hovering over a file in the File List. 

File Pg. No Displays the page number from the file that was assigned to that product 
page number slot. If the page is “Blank” or “Unassigned,” then the File Pg. 
No. column will be empty. 

Component Shows the name of the product component. 

Status Shows the status of the content file. If there is a problem with the content 
file, a warning icon and description of the problem will appear in this column. 

Size: Indicates there is a problem with the trimbox. 

Colors: Indicates the colors in the content file do not match the colors in the 
Planned Colors list. 

Missing: Indicates the content file cannot be found. 

(Multiple): Indicates there is more than one problem. 

Hover text can provide more detailed information about the error. 

Folio Shows the Folio (e.g., FC, InFC, 1,2,3, 4, InBC, BC) 

Colors Shows the colors that are planned to be on that page. 

Shingling Value Shows the amount of shingling applied to that product page number slot. 

Content Positioning 
Rule 

Will display one of three options for the position of the content: 

Center Each PDF Page 

Center Each PDF Page Trimbox 

Match PDF Page Trimbox Size And Center 

Clicking in the field brings up a menu where you can select one of the three 
options 

Selecting the gear icon in the column header brings up an “apply to all” 
menu where you can apply the positioning rule to selected pages. 
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Trimbox Size Shows what the size is for the Content Page Trimbox. 

Note It is possible to rearrange the order of the columns. You can rearrange the first three columns only 
between themselves. It is also possible to resize them. 

N-Up Binding in the Run List 

When a product is set for N-Up Binding greater than one, a Number Up selector (N-Up 1,2,3) appears at the top 
of the Run List so you can select which N-Up the Run List represents. This menu appears to the right of the 
Display Options menu. 

N-Up Binding in the Run List follows the rules below. 

• When changing a product from 1-up to 2- or 3-up, common content can be assigned, or the multi-up 
products can have different content 

• N-up has no impact on content assignment or on the Run List 

• Dragging one component on top of another is supported to create N-Up components when common 
content is enabled 

Working with the Run List 

From the Project Explorer 

As described previously, you can assign entire PDF content files, individually or as a group, to product pages in 
the Run List by dragging and dropping from the Finder/Explorer or the File List to the Run List. 

Editable fields 

Some properties are non-editable in the Run List because they are tied to the product page slot (or row), while 
others can be edited in the Run List because they are tied to the content files. Keep in mind the following: 

• Non-editable properties appear as black text on a gray background 

• Editable products appear as black text on a white background 

• You can only select editable properties 

• You can only select the File name, Colors, and Content Positioning Rules 

Drag and drop from the File List to the Run List 

You can also assign content pages, individually or as a group, from the File List to the Run List by drag and drop. 

• Drag and drop operations to the Run List may use a sequential or random selection of pages from any 
or all File List files. Click on the first page, then SHIFT-click on the last page for contiguous selection. 
CTRL-click (CMD-click on Mac) on different pages for non-contiguous selection. Clicking on the page 
icon to the left of the file name selects every page in the file. 

• When you drag multiple, non-contiguous content pages to the Run List, they are added in File List 
order; pages are added in alphanumeric order. 

To select pages 

• Click on the first page, then SHIFT-click on the last page for contiguous selection. 

• CTRL-click (CMD-click on a Mac) on different pages for non-contiguous selection. 

Notes Clicking the page icon to the left of the file name selects every page in the file. 

 When you drag multiple, non-contiguous content pages to the Run List, they are added in the 
File List order; pages are added in alphanumeric order. 
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Adding or inserting content pages 

There are two ways to drag content pages or files from the File List onto the Run List. You can either: 

• Add content 

• Insert content 

Adding content 

Adding content to the Run List occurs when you select pages or files in the File List and drag them to a page slot 
in the Run List. When the cursor is over a page slot, the entire row is highlighted. When you release the mouse 
button, a warning may appear stating that there is already content on some of these pages. 

The following is an example of what the Run List might look like before content is added. 

 

When you click OK in the warning window, the pages from the File List are added to the Run List, replacing the 
number of pages from there down that you were adding. In other words, if you had five pages selected in the File 
List, five pages will be replaced in the Run List. 

Important When you add pages, the number of pages being copied are replaced from the selection point 
down. The rest of the pages, however, remain exactly as they were. 

  For example, if you were dragging five pages onto the third product page slot, the content of the 
rows from 3-7 would be changed, and the next page would be 8. 

The following is an example of what the Run List might look like after adding a two-page file. 
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Inserting content 

Note Inserting pages is possible only when selecting a single bound product. 

Inserting pages has a different result from adding pages. When you select pages or files in the File List, and then 
drag the cursor between two pages in the Run List, a horizontal black line indicates where the pages will be 
inserted. 

 

When you release the mouse button, the pages from the File List are added to the Run List between the two 
pages where you placed the black line. 

Important When you insert pages (as opposed to adding), the number of pages being inserted will “push” the 
pages from the selection point down by the same number you inserted.  

 For example, if you inserted five pages between page 2 and 3 in the File Pg. No. column, the 
content of rows 3-7 would change and the next page (previously File Pg. No. 8) would be 3, 
because all pages are moved down by five. There would then be five extra rows at the end of the 
list of that product’s pages in the Run List; only the File name and File Pg. No. columns would 
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contain any information, as seen below. 

 

Any content pages pushed past the last page in the product are ignored, since they are no longer associated 
with product pages. 

To remove the extra rows at the end of the Run List, click the gear icon in the File name column header, and 
select Remove Extra Rows from the menu. 

Note Since you can only add pages to bound products, if the number of content pages exceeds the number 
of product pages, extra pages will only be added to the bound products in the Run List. Folded and flat 
products respond normally in the first two pages to adding or inserting, but no extra pages are added. 

Blank or unassigned pages 

A page that is awaiting content displays a red (Unassigned) message. To change this, you can add content to 
that page. 

A (Blank) page indicates a page that is intentionally left blank so a blank page will print. For example, if all new 
chapters of a book should begin on an odd-numbered page, but in the content file, a chapter ends on odd-
numbered page, then you should use a blank page in the Run List. 

Clicking in the File name column of the Run List opens a menu where you can set the selected file name to 
(Blank) or (Unassigned). When there are unassigned pages in the Run List, the File name column header will 
turn red as a warning that there are unassigned pages in the Run List. 

When there are unassigned pages in the Run List, the File name column header will turn red as a warning that 
there are unassigned pages in the Run List. 

Inserting blank pages 

You can insert blank pages directly by using the Blank Page icon. 

After you click the Show Blank Page check box in the File List window, a file icon with the designation {Blank 
Page} appears at the top of the file list. You can insert these blank pages into the Run List or use it to replace a 
page in the Run List. 

When you drag the {Blank Page} icon to the place in the Run list where you wish to insert the blank page, a dark 
line appears between the two pages in the list. 

Note When you select the {Blank Page} icon, the Remove and Relink buttons are disabled. 

When you release the mouse button, a blank page is inserted between the two pages where the dark line had 
previously indicated. 
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All content pages below the blank page are now moved down by one. 

Note After you insert blank pages in the Run List, there may be extra rows at the end of the list that have no 
page designation in the product. You will see those extra pages if you scroll to the bottom of the list.  

Important information about blank pages 

There are two important things to remember about inserting blank pages. 

First, if you need blank pages between some pages in a bound product, you should insert the pages rather than 
adding them. That way you preserve the order of the remaining pages. 

When you insert a page, all other content pages are pushed down, but none of them are replaced. If you add 
pages, some of the page content is replaced by other content. 

When you drag the blank page from the File List to the Run List, be sure it is inserted between two pages 
(indicated by a heavy black line), and does not replace any pages (indicated by the Run List row being 
highlighted in blue). 

Second, if you created the product with the same number of pages as the content file, inserting pages means the 
product will need more pages, so you will need to add enough signatures to the product to include those pages. 

You can do this either before or after you insert the blank pages. If you know the number of blank pages you will 
need, you can add them to the product before you insert the blank pages. If you do not know how many you will 
need, you can count the extra rows at the end of the product in Run List to see how many blank pages were 
inserted. 

Note After you insert a blank page in a product, you should not remove the extra rows from the end of the 
Run List, because those rows contain the content for the pages you are going to add to the product. 

To add pages to the product, go to the Assembly View of the product. You can do this by selecting the product in 
the Project Explorer pane, and then clicking the View tab (located to the left of the Component Picker tab). In the 
Assembly View, clone enough signatures to accommodate the number of blank pages you will be inserting, or 
have already inserted. Then check the Run List to be sure the number of blank and content pages in the Run List 
matches the number of pages in the product. 

Please refer to the following steps to add pages to a bound product using the Assembly View. 

1. Select the Bound product in the Project Explorer. 

2. Click the Layout View tab. 

3. Right-click a signature to open a menu and clone the component. 

 

4. Clone enough components to cover the number of blank pages. 

Adding one content file page to multiple product page number slots 

It is possible to assign the same content page to multiple product page slots in the Run List. 

For example, follow these steps if you want to assign an 11-page PDF content file to 10 flat products, with pages 
1-10 applying to each of the fronts and Page 11 applying to all backs. 

1. Select the 10 products in the Project Explorer. 

Right-click on 
a signature 
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2. Limit the displayed Run List to Show Backs (Evens) by selecting this option from the pull-down Show 
menu at the top of the Run List. 

3. Select Page 11 from the File List. On Windows, press and hold the CTRL key (CMD key on Mac), and 
drag Page 11 to any of the displayed Run List page slots. 

Note You must have only one page selected in the File menu. If multiple pages are selected in the 
File List, and you then press the CTRL (or CMD) key, a beep sounds, a notification appears, 
and (on Windows) the drag icon changes to a circle with a slash. No pages are assigned to 
products. 

4. When the mouse button is released, Page 11 will be applied to all visible page slots. 

Planned Colors 

Handling planned colors on a single selected row 

When you select a single row in the Run List in the Planned Colors column, a menu appears allowing you to 
select different colors, including None (no planned colors) and Custom (colors set by you). 

Color warnings 

Planned Colors Status warning 

When JDF Color Mapping is enabled, and the Planned Colors and the colors of the content page do not match, 
the planned colors and Status column headers turn red, and a Colors warning appears in the Status column. For 
more information, see JDF Color Mapping. 

Colors Status warning 

Clicking the warning in the Status column opens the Page Color Error window, where you can correct the 
planned colors for that page. 

Here you will find information about extra colors, missing colors, the file colors, and a menu for selecting and 
changing the Planned Colors. 

There is also a button indicating whether the Color Mapping is for the front or back of the layout on which the 
page is placed. 

 

The color options on the Planned Colors menu are the same as those in the Planned Colors column. If you 
select the Custom… option, a window opens where you can select a set of custom colors for the page. 
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Note For additional information on resolving Colors errors, see the JDF Color Mapping. 

Planned Colors on multiple selected rows 

You can change the Planned Colors for all rows in the Run List when either no rows are selected, or only one 
row is selected. To do this, click the gear icon in the Planned Colors header. When you do, a window opens 
allowing you to change all rows in the list. 

Note The word “(All)” appears in the window title. 

If multiple rows are selected, either contiguous or non-contiguous, clicking the gear icon in the Planned Colors 
header opens a similar window. The difference here is the only the selected rows will change. 

Note  The word “(Selected)” appears in the window title. 

Important If only one row, or all the rows, are selected, then the choice will apply to all the rows—the same as 
if the “(All)” window were used. 

Size Errors in the Run List 

Conditions producing Size errors in the Run List Status column 

Assigning content pages to product pages in the Run List will produce a Size error in the Status column when: 

• The content and product pages are different sizes 

• The content and product pages have a different rotation 

• One or more of the product pages has a different leaf size than the others 

• One or more of the content pages has no trimbox 

• The product pages are combined, thus making the product and content pages different sizes 

• The content and product pages are the same size but have different orientations 
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Size error when flat and folded products and content are different sizes 

Dragging content pages onto flat or folded product pages of a completely different size produces a size error. In 
this case 3.5” x 2” pages are added to product pages set for 8.5” x 11”. 

Clicking the size error in the Status column opens the Set Product Size window. 

 

Clicking OK changes the product page size to 6” x 9” automatically. 

If changing the product page size does not resolve the error, you may need to change: 

• The Content Positioning Rule 

• The Content File 

Size errors for bound products 

With bound products, a size error may occur because the content file is a different size from the product pages or 
because one or more leaf sizes are narrower than the other leaves. 

Clicking OK changes the product size. If that does not resolve the error, then you need to change one of the 
following: 

• Content Positioning Rule 

• Content File 

• Leaf Size 

Note When a leaf is wider than the rest of the product pages, no size error is reported because Metrix 
creates the extra width by adding Front Face Trim rather than changing the page size. 

Size error for rotated pages 

If the product was created to be calendar style, or if it contains rotated pages, a size error occurs. Clicking in the 
Status column opens the Page Rotation Error window. 

If the content file and product pages are different sizes, the error may be resolved by changing the size of the 
product pages. 

When the content file and product pages are the same size, but the product pages have been rotated, you must 
change the rotation for either the content file or the product pages. 

Alternatively, you can change the Content Positioning Rule in the User Preferences window to Center Each PDF 
Page or Center Each PDF Page Trimbox. 

Note For more information about the Content Positioning Rule, see Content Positioning Rules, Content 
Handling Preferences, and the Bound product properties. 

Size error for content pages with no trimbox 

Dragging content pages onto product pages when one or more of the content pages has no trimbox produces a 
size error in the Status column in the Run List. 

Clicking the size error in the Status column opens the Set Product Size window. 

Clicking OK will change the Content Positioning Rule for that product page to center the content on the product 
page. 
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If all the content pages have no trimbox, and need to be centered on the product pages, click the gear icon in the 
Content Positioning Rule column and then select Center Each PDF Page (All). 

Size error for product with combined pages 

Dragging 8.5” x 11” content onto 8.5” x11” pages when Combined Pages is set to True (for a combined size of 
17” x 11”) cause a size error in the Status column. 

Clicking the size error in the Status column opens the Set Product Size window shown below. 

Clicking OK dismisses the window. You must then change the Content File, Product size, or the Content 
Positioning rule to correct the error. 

Size error—same size product and content, but different orientation 

Dragging 8.5” x 11” content onto product pages that are set for 11” x 8.5” orientation also produces a size error. 

Clicking the size error in the Status column opens the Page Rotation Error window. Clicking OK dismisses the 
window. You can then: 

• Change the product size to 8.5” x 11” 

• Change the Content Positioning Rule 

• Use a different content file 

• Change the page rotation 

Note For some bound products, this error window may also suggest changing the leaf size. 

Product size does not match PDF trimbox 

• If the Content Positioning Rule is set to Match PDF Trimbox Size And Center, and the product and 
content files do not match, “Size” appears with a red X in the Status column of the Run List 

• Clicking in the Status cell in the Run List opens a window that asks, “Set Product Size to (WxH)” and 
then gives new dimensions 

• You can either select Cancel to cancel the window, or click OK to apply the new size to the product 

• If the Content File does not have a trimbox, when you click in the Status cell, a window opens allowing 
you to change the Content Positioning Rule to “Center Each PDF Page” or “Center Each PDF Page 
Trimbox and Center” 

Miscellaneous Run List Rules 

Upgrading from previous Metrix versions 

When upgrading from versions of Metrix prior to the introduction of the Run List (2015.4 and earlier): 

• Content file references are maintained 

• Products that without assigned content are considered (Unassigned) 

Run List Previews in the View Area 

These rules apply to the preview of pages in the View Area (not the File List): 

• Previews of products that have content assigned display the content 

• Previews of pages that are Unassigned appear as a red and white checkerboard pattern 

• Previews of “(Blank)” pages appear as blank white pages 
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Adding too many pages to a flat or folded product 

If the page count of the content file is less than the number of product pages in the Run List, (Unassigned) 
Product and Position rows are left at the end of the Run List. 

When only one flat or folded Product is selected, if the page count of the content file is greater than the product 
page count, or greater than the number of pages after the one on which the content file is dropped, content is 
added only to the pages in the selected product. No extra content pages are added at the end of the list. 

A beep will sound and a notification appears when this happens. 

 

Content Positioning Rules 

• If different Content Positioning Rules are applied to pages in the same product, when that product is 
selected, the Content Position Rule in the Project Explorer product property shows “(Different Values)”. 

• The Content Positioning Rule remains tied to the Page Position slot, and will be applied to any content 
page that is assigned to that slot. 

• If multiple product page slots are selected, and you select a Content Positioning Rule for any of the 
selected Product page slots, the rule is applied to all selected pages. 

Content Positioning Rule preference 

There is a user preference that globally applies content positioning rules to all new products on import. You can 
override this rule at the Run List level. Content positioning rules applied to a product page slot remain tied to that 
slot. 
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Note For more information on the Content Positioning Rule, see the Bound product properties.  

Missing Content files 

• If Metrix cannot find a content file, the file name appears in red text in the File List and “Missing” 
appears in red text in the Status column of the Run List 

• You can update the link to the “Missing” content file by using the Relink button in the File List or by 
clicking on the “Missing” error in the Run List, which opens the Relink File(s) window. 

Resolving Text Mark variables 

• When the text mark variable <Product.ContentFile> is placed on a layout adjacent to a component, the 
mark resolves to the name of the content file. If that component has more than one content file 
assigned, the mark resolves to “(Multiple Files).” 
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Mark Arrangement 

When you add any layout file mark (Marks > Add File), Metrix places the default file mark, using the Default 
Mark Anchor, Default Layout Anchor, and the Default Layout Anchor Object (Press Sheet) options. The Default 
Offsets (0,0) properties are also applied, placing the lower left corner of the mark in the lower left corner of the 
press sheet. 

Note The default file mark is determined by the order of the file marks in the Metrix Database window – the 
one at the top of the list is the default. This is user definable. 

 

Once you have selected the anchors and anchor object, you can position the mark using the offsets or by 
dragging and dropping. 

Notes Positive offsets move up and right; negative offsets move left and down. 

  Drag-and-Drop/Nudge: Moves are in increments of 1mm or 1/16". To nudge, hold down CTRL 
(Windows) or CMD (Mac) and use the arrow keys. 

  The Sizing property refers to the mark size, and the options are: File Size; Fixed Size; Fixed Height, 
Variable Width; and Fixed Width, Variable Height. 

File Mark Setup 

In Metrix 22.1, the PDF file marks are stored in the Metrix Database rather than in the Marks folder. This ensures 
that other user sharing the same database have access to the same File Marks. 

Note If you are upgrading from a previous version of Metrix and the Marks folder resides in the Metrix folder, 
copy that Marks folder and paste it into the Metrix 22.1 folder. 

As long as Metrix has access to the Marks folder, whether you placed a copy in the Metrix 22.1 folder or 
it resides in the same location defined for the previous installation of Metrix, Metrix will import the file 
marks from that location when you first open the Metrix Database and start Metrix. 

If the Marks folder has been moved so that Metrix cannot automatically import file marks, you can edit 
the individual marks in the Database window and browse to and select the corresponding PDF files. 
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If a file mark is missing from the database after an upgrade, then it will appear in red in the File Marks 
panel of the Database window.  

File marks previews are now created internally using the PDF Renderer, so it is no longer necessary to have 
corresponding .png files for marks. 

To set up marks 

1. Select Settings > Database. 

2. Select File Marks, under Resources, on left side of the Database window. 

3. Click New on the right side of the Database window. 

4. Enter the relevant information in the Filename, Width, and Height fields in the New File Mark window. 

Prioritizing file marks 

When you add a file mark to your layout, Metrix automatically places the default mark (the one at the top of the 
list). You can change the order of the marks in the database, which will change the default mark. 

Note You must be logged into Metrix with a user role giving you permission to re-order the file marks list. That 
is, you must set “Edit or Delete Database Items” to True in the Database window. 

1. Select Settings > Database. 

2. Select File Marks on the left side of the Database window. 

3. Select the intended mark to reorder. 

4. Use Up and Down to prioritize entries. 

Note You can use this same process to prioritize mark sets. Select mark sets instead of file marks 
and use the Up and Down buttons to prioritize the list of mark sets. 

Adding a fixed size file mark 

1. Select Marks > Add File in the Project Explorer. 

2. Select the desired file mark using the File property in the Properties Editor. 

3. Choose Anchors, Anchor Object, and Offsets values in the Properties Editor. 

4. Choose other properties in the Properties Editor. 

Adding a duplicating file mark 

1. Select Marks > Add File. 

2. Select desired File Mark, Sizing, and Center Image properties in the Properties Editor. 

3. Choose Anchors, Anchor Object, and Offsets properties. 

4. Choose other properties in the Properties Editor. 

Barcode Marks 

Barcode marks provides the barcode identification of products, book components, layouts, etc. They are also 
used for automated finishing systems, and to speed fulfillment and invoicing. 
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Adding a barcode mark to a layout 

To add a barcode to a mark, select Marks > Add Barcode. The properties that appear in the Properties Editor 
are those pertaining to the barcode. 

 

Embedding the font for barcode human readable text 

If your workflow requires you to have fonts embedded in the output stream, copy a TrueType font (for example 
arial.ttf) to the Font folder inside the Metrix installation folder. Metrix will use this font for text marks displayed in 
the Layout View and will embed this font in the Imposed PDF or the PDF Marks Flat in a JDF workflow. 

Barcode Mark Properties 

Property Explanation 

Type Code 128 / Interleaved 2 of 5 

Barcode type to use. Determined by the barcode reader. 

Barcode Text Barcode text, static and/or variable. 

Barcode Text Resolved The static and/or variable resolved barcode text. 

Human Readable Text The human readable text to insert underneath the barcode. 
Use <!> to insert line breaks. 

Human Readable Text Resolved The static and/or variable resolved human readable text. 

Include Checksum True / False 
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For Interleaved 2 of 5 only. Determined by the barcode 
reader. 

Measurement Unit Points / Inches or Points / Millimeters 

The measurement unit to use for the barcode and the human 
readable text. 

Text Point Size Human readable text point size. 

Bar Height Barcode height. 

Minimum Bar Width Minimum width for the barcode. 

Side Quiet Zone Blank space to leave at the sides of the barcode. 

Top Quiet Zone Blank space to leave at the top of the barcode. 

Width The calculated width of the barcode mark. 

Height The calculated height of the barcode mark. 

Rotation 0° / 90° / 180° / 270° 

The rotation of the barcode mark. 

Mark Anchor Point The point on the mark to use as an anchor. 

Layout Anchor Object Press Plate / Press Sheet / Product Trim 

The object to anchor the mark to. 

Layout Anchor Point The point on the Layout Anchor Object to use as an anchor. 

Horizontal Offset The horizontal distance to move the mark away from the 
anchor point. Positive values move up and right, negative 
values move left and down. 

Vertical Offset The vertical distance to move the mark away from the anchor 
point. Positive values move up and right, negative values 
move left and down. 

Placement Front Only / Back Only / Both Front and Back 

The sheet sides for placement of the barcode mark. 

Mirror Backup True / False 

When True, the position of the barcode mark on the Back 
mirrors the Front. 

Over Page Content True / False 

When True, the barcode mark will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for the barcode mark. 

Output Print Report Only / Exported Output Only / Both Export 
and Report 

Where the barcode mark should appear. 

Barcode mark variables 

Use the abbreviated variables when necessary – Metrix barcode mark input is limited to 100 characters. Metrix 
barcode mark variables are not case-sensitive. 

Variable Inserts Related to 

<!> Carriage return and line feed Any text 
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<Date> Current date Computer 

<Time> Current time Computer 

<Project.ID> Project ID Project 

<Project.Name> Project name Project 

<Project.Description> Project description Project 

<Project.Notes> Project notes Project 

<Project.Customer> or 
<Project.Customers> 

A comma-separated list of all 
customers for all products in 
the project 

Project 

<Color> Color of each separation Layout 

<Layout.Side> or <Side> Layout side number (1, 2) Layout 

<Layout.Side.Alpha> or <Side.Alpha> Layout side letter (A, B) Layout 

<Layout.Number> or <Number> Layout number Layout 

<Layout.PrintingMethod> or 
<PrintingMethod> or <PM> 

Layout printing method Layout 

<Layout.SheetHeight> or <SheetHeight> 
or <SH> 

Layout sheet height Layout 

<Layout.SheetWidth> or <SheetWidth> or 
<SW> 

Layout sheet width Layout 

<Layout.RequiredSheets> Layout required sheets Layout 

<Product.ID> Product ID Component 

<Product.Name> Product name Component 

<Product.Description> Product description Component 

<Product.Notes> Product notes Component 

<Product.Customer> Product customer Component 

<Product.DueDate> Product due date Component 

<Product.ContentFile> Product content filename Component 

<Product.RequiredQuantity> Product required quantity Component 

<Product.ProductGroup> Product group Component 

<Product.Width> or <Product.Width.Unit> Product width and unit of 
measure 

Component 

<Product.Width.NoUnit> Product width without unit of 
measure 

Component 

<Product.Height> or <Product.Height.Unit> Product height with unit of 
measure 

Component 

<Product.Height.NoUnit> Product height without unit of 
measure 

Component 

<Instance.ID> Instance ID (e.g., A-1 or A1-1) Component 

<Instance.Number> Instance number (e.g., the “1” 
in A-1 or A1-1) 

Component 

<Instance.Count> Number of instances on the 
layout 

Component 

<Instance.RequiredQuantity> Instance quantity (how many 
components are produced from 
the instance) 

Component 

<Component.Number> Component number Component 
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<TextComponent.Number> Text component number (not 
counting cover component) 

Component 

<Component.Count> Total number of components in 
the product 

Component 

<TextComponent.Count> Total number of 
textcomponents in the product 
(not including cover 
component) 

Component 

<Component.PageCount> Page count for this component 
(front & back) 

Component 

<Product.MIS_ID>* Product MIS_ID Component 

<Component.MIS_ID>* Component MIS_ID Component 

<Layout.MIS_ID>* Layout MIS_ID Component 

<BarcodeText> (for Human Readable 
property) 

Text present in Barcode Text 
property 

Barcode Mark 

<BarcodeText.Resolved> (for Human 
Readable property) 

Resolved text present in 
Barcode Text Resolved 
property 

Barcode Mark 

*Note MIS_ID cannot be inserted from within the Metrix interface – product, component, and/or layout MIS ID 
information can only be generated from an MIS and thus its presence is only possible when the project 
originates from MIS. 

Muller Martini barcode marks 

The Barcodes module includes special barcode marks for Muller Martini finishing equipment. These special 
barcode marks enable the Muller Martini binder to read a job identification number, the signature number, and 
the total signatures in the job. 

Metrix provides all three pieces of information by calculating a special value that is inserted into the barcode 
automatically. You are only required to insert one variable and Metrix does the rest. 

• Use any one of the project or product properties listed below to insert a numeric job identifier. 

• If you are using Code 128, Metrix truncates to the last 4 digits to identify the job. If you are using 
Interleaved 2 of 5, Metrix truncates to the last 3 digits to identify the job. 

• Any incorrect entry, that is, any other characters besides digits, will produce an incorrect value that is 
not usable by the Muller Martini equipment. 

• The barcode mark must be placed onto a component and be resolved, that is, the “hot spot” must be 
green. 

• Consult with Muller Martini for details on the placement, sizing, number of marks, spacing, etc. 

Variable Inserts 

<MMBarcode.Project.Name> Job Identifier (Code 128, insert 4 numbers; Interleaved 2 of 
5, insert 3 numbers), Component (Signature) Number, 
Component Count 

<MMBarcode.Project.Description> Job Identifier (Code 128, insert 4 numbers; Interleaved 2 of 
5, insert 3 numbers), Component (Signature) Number, 
Component Count 

<MMBarcode.Project.Notes> Job Identifier (Code 128, insert 4 numbers; Interleaved 2 of 
5, insert 3 numbers), Component (Signature) Number, 
Component Count 

<MMBarcode.Product.Name> Job Identifier (Code 128, insert 4 numbers; Interleaved 2 of 
5, insert 3 numbers), Component (Signature) Number, 
Component Count 
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<MMBarcode.Product.Description> Job Identifier (Code 128, insert 4 numbers; Interleaved 2 of 
5, insert 3 numbers), Component (Signature) Number, 
Component Count 

<MMBarcode.Product.Notes> Job Identifier (Code 128, insert 4 numbers; Interleaved 2 of 
5, insert 3 numbers), Component (Signature) Number, 
Component Count 

Resolving Muller Martini barcode mark variables 

In the illustration below, the job number “1234” has been placed into the Product Notes property. A Muller Martini 
barcode mark (Code 128) has been inserted with the variable <MMBarcode.Product.Notes>. 

Metrix has calculated a value that informs the Muller Martini binder that the job number for this component is 
1234 and that this is Signature 3 of 4. 

Note The calculated value is only understandable by the Muller Martini barcodereader. You will not see, for 
example, “1234” or “sig 3 of 4”. Once the value is read by the Muller Martini system, however, it will be 
perfectly understood. 

 

 

Understanding Rectangle Marks 

You can use rectangle marks for take-off bars and other kinds of marks requiring a filled rectangular shape. 

There are three different types of rectangle marks: 

• Fixed Size: Specified by the Width and Height properties. 

 

• Fixed Height, Variable Width: Width is sheet width; height specified by Height property. 

Fixed size 
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• Fixed Width, Variable Height: Height is sheet height; width specified by the Width property. 

 

Adding a Rectangle Mark to a Layout 

1. Select Marks > Add Rectangle. 

2. Specify sizing in the Properties Editor. 

3. Choose Anchors, Anchor Object, and Offsets properties. 

4. Choose other properties in the Properties Editor. 

Line Marks 

Understanding line marks 

Metrix draws line marks within the specified area. The Width, Height, and Slope properties determine the line 
mark area and direction (and the Thickness property determines the line mark weight). 

Variable 
height 

Variable width 
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For horizontal and vertical line marks, the slope is irrelevant. 

 

Example 1 – Fixed size, slope up 

 

Example 2 – Fixed size, slope down 
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Example 3 – Fixed height, variable width, slope up 

 

Example 4 – fixed size, horizontal line 

 

Adding a line mark to a layout 

1. Select Marks > Add Line. 

2. Choose the Sizing property in the Properties Editor. 

3. Choose Anchors, Anchor Object, and Offsets in the Properties Editor. 

4. Choose other properties in the Properties Editor. 

Selecting Line Marks on a Layout 

Metrix has two ways to assist you in selecting line marks from a layout. 

• You can select a higher magnification for the View Area, enlarging the layout. 

• You can use the Object List to select any of the objects on the layout. 
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Note For more information on where to find the Object List, see Interaction and display of the four UI 
areas. 

Copying All Marks from One Layout to Another 

You can select, copy, and paste all the marks on a layout using the Marks menu. 

• If you need to select all the marks on a layout, go to the Marks menu and choose Select 
All(ALT+SHIFT+A on Windows, or CTRL+A on Mac). 

• Once you have selected all the marks on a layout, you can copy them as a group using the Marks 
menu. Choose Copy Selected (ALT+SHIFT+C on Windows, or CTRL+C on Mac). 

• Once you copy the marks on a layout, you can paste them as a group into one or more layouts. Click a 
layout to select it, or SHIFT-click multiple layouts to select more than one. Then choose Paste on the 
Selected Layout(s) from the Marks menu (ALT+SHIFT+V on Windows, or CTRL+V on Mac). 

• When you paste a group of marks onto a layout, the properties assigned to the marks (such as height, 
width, or location) will apply to the new layout(s) regardless of the layout’s size. Thus, if the width of a 
mark is variable, it will be 24” wide on a 24” layout, but 36” wide on a 36” layout. 

Cutter Alignment Marks 

Cutter Alignment Marks are used by digital cutting machines to maintain registration across the sheet 
while performing operations such as cutting and creasing. This is especially important for very large sheets 
or flexible substrates. 

Adding and Editing a Cutter Alignment Mark  

Note Cutter Alignment Marks can be placed onto a layout individually or as groups. To add a Cutter 
Alignment Mark Group, open the database and select the Cutter Alignment Mark Groups option 
in the Resources section. For more information, please see ePS Metrix 22.1 Setup Guide and 
Worksheets.  

  

 

1. Select Marks > Add Cutter Alignment Mark.  

2. Complete the fields in the Mark Properties Editor.  

Note All fields available for editing must be completed so the Metrix algorithm can automatically place 
marks around each instance.  
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a. Alignment Mark Types: Choose the appropriate mark type from the drop-down list.  

i. Black Circle on White Square 

ii. Black Circle on White Circle 

iii. White Circle on Black Circle 

iv. White Circle on Black Square 

v. Crosshair 

b. Mark Anchor Point: The point on the mark to use as an anchor.  

c. Layout Anchor Object: Choose the appropriate anchor object from the drop-down list.  

i. Press Sheet 

ii. Press Plate 

iii. Product Trim 

d. Layout Anchor Point: The point on the layout to use as an anchor.  

e. Horizontal Offset: The horizontal distance to move the mark away from the anchor point. 
Positive values move up and right, negative values move left and down.  
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f. Vertical Offset: The vertical distance to move the mark away from the anchor point. Positive 
values move up and right, negative values move left and down.  

g. Spot Black:  

i. True: The black part of the mark prints in a pre-defined spot black ink.  

ii. False: 100% process black is used.  

h. Spot White:  

i. True: The white part of the mark prints in a pre-defined spot white ink.  

ii. False: 0% CMYK is used (no ink, so it will be the color of the substrate).  

i. UV Ink: 

i. True: The cutter alignment mark uses UV ink.  

ii. False: The cutter alignment mark does not use UV ink. 

j. Inner Size: Diameter of the inner mark (black circle or white circle).  

k. Outer Size: Size of the outer mark (black or white square or circle).  

l. Placement: The side of the sheet to place the mark.  

i. Front Only  

ii. Back Only  

iii. Both Front and Back 

m. Mirror Backup:  

i. True: The position of the mark on the Back mirrors the Front.  

ii. False 

n. Over Page Content:  

i. True: The mark will overprint page content.  

ii. False 

o. Output: Where the mark should appear.  

i. Print Report Only 

ii. Exported Output Only 

iii. Both Export and Report 

p. Ignore Overlapping Content:  

i. True: Content or mark, which is on top, overprints.   

ii. False: Content or mark knocks out.  

 

Text Marks 

Adding a Text Mark to a Layout 

Note Text marks may contain static and/or variable text. For more information, see Text mark variables.  

1. Select Marks > Add Text. 

2. Enter Static and Variable Text, Font Size, and Rotation properties. 

3. Choose Anchors, Anchor Object, and Offsets properties. 

4. Choose other properties. 
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Embedding the font for text marks 

If your workflow requires fonts be embedded in the output stream, copy a TrueType font (for example arial.ttf) to 
a Font folder inside the Metrix installation folder. Metrix will use this font for Text Marks displayed in the Layout 
View and will embed this font in the Imposed PDF or the PDF Marks Flat in a JDF workflow. 

Resolving component-related text mark variables 

• Red indicates Unresolved status 

• Green indicates Resolved (variable text is replaced with actual data) status 

To resolve it, move the text mark onto the component. 

 

Note Text mark variables are computer-related, project-related, layout-related, and component-
related. For more information, see Text mark variables.  

Unresolved 

Resolved 
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Text mark variables 

Use the abbreviated variables when necessary – Metrix text mark input is limited to 100 characters. Except for 
<Date> and <Time> Metrix text mark variables are not case-sensitive. 

Variable Inserts Related to: 

<Date> Current date Computer 

<Time> Current time Computer 

<Project.ID> Project ID Project 

<Project.Name> Project name Project 

<Project.Description> Project description Project 

<Project.Notes> Project notes Project 

<Project.Customer> or 
<Project.Customers> 

A comma-separated list of 
all customers for all 
products in the project 

Project 

<Color> Color of each separation Layout 

<Layout.Side> or <Side> Layout side number (1, 2) Layout 

<Layout.Side.Alpha> or <Side.Alpha> Layout side letter (A, B) Layout 

<Layout.Number> or <Number> Layout number Layout 

<Layout.PrintingMethod> or 
<PrintingMethod> or <PM> 

Layout printing method Layout 

<Layout.SheetHeight> or <SheetHeight> or 
<SH> 

Layout sheet height Layout 

<Layout.SheetWidth> or <SheetWidth> or 
<SW> 

Layout sheet width Layout 

<Layout.RequiredSheets> Layout required sheets Layout 

<Layout.Stock> or <Stock> Layout stock Layout 

<Layout.Press.Name> or <Press.Name> Layout press name Layout 

<Layout.Bundles> List of all the bundles on 
the sheet.  

Layout 

<Layout.RampageSheetSideWorkflow 
Name> 

Rampage Workflow 
Name for that side of 
sheet 

Layout 

<Product.ID> Product ID Component 

<Product.Name> Product name Component 

<Product.Description> Product description Component 

<Product.Notes> Product notes Component 

<Product.Customer> Product customer Component 

<Product.DueDate> Product due date Component 

<Product.ContentFile> Product content filename Component 

<Product.RequiredQuantity> Product required quantity Component 

<Product.TotalQuantity> Product total quantity Component 

<Product.TotalQuantityPlus> Product total quantity 
minus the product 
required quantity, e.g., 
5,000 (250 extra) 

Component 

<Product.ProductGroup> Product group Component 
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<Product.Width> or <Product.Width.Unit> Product width and unit of 
measure 

Component 

<Product.Width.NoUnit> Product width without unit 
of measure 

Component 

<Product.Height> or <Product.Height.Unit> Product height with unit of 
measure 

Component 

<Product.Height.NoUnit> Product height without 
unit of measure 

Component 

<Product.BindingMachine.Name> Product binding machine Component 

<Instance.ID> Instance ID (e.g., A-1 or 
A1-1) 

Component 

<Instance.Number> Instance number (e.g., 
the “1” in A-1 or A1-1) 

Component 

<Instance.Count> Number of instances on 
the layout 

Component 

<Instance.RequiredQuantity> Instance quantity (how 
many components are 
produced from the 
instance) 

Component 

<Component.Number> Component number Component 

<TextComponent.Number> Text component number 
(not counting Cover 
component) 

Component 

<Component.Count> Total number of 
components in the 
product 

Component 

<TextComponent.Count> Total number of Text 
components in the 
product (not including 
Cover component) 

Component 

<Component.PageCount> Page count for this 
component (front & back) 

Component 

<Product.MIS_ID>* Product MIS_ID Component 

<Component.MIS_ID>* Component MIS_ID Component 

<Layout.MIS_ID>* Layout MIS_ID Component 

<Component.Fold.Name> Component fold name Component 

* MIS_ID cannot be inserted from within the Metrix interface – Product, Component, and/or Layout MIS_ID 
information can only be generated from an MIS and thus its presence is only possible when the project originates 
from MIS. 

Selecting text marks on a layout 

There are two ways to selecting individual line marks from a layout. 

• You can select a higher magnification for the View Area, enlarging the layout. 

• You can use the Object List to select any of the objects on the layout. 

Note For more information on where to find the Object List, see Interaction and display of the four UI 
areas. 

Creating Step and Repeat Marks 

1. Select a Mark. 
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2. Hold down the ALT key on Windows (OPTION on Mac) and drag. The new mark appears at the end of 
the original mark. 

3. Select the New Mark and edit properties. 

Note Continuous dragging produces more marks. Diagonal dragging produces marks horizontally 
and vertically. 

About Mark Sets 

Sample presses and mark sets 

The Metrix Database no longer comes pre-populated with sample presses and mark sets. If you want this data 
as part of your setup, you must import it from the EFI/Metrix/Imports folder. 

Note When importing multiple mark sets, a Mark Set Presses window opens for each mark set. If the mark 
sets you are importing are not intended for use with the same set of presses, we recommend that you 
import one mark set at a time so you can differentiate between them. 

Saving a mark set 

Mark sets can save you a lot of time. If you have positioned your marks using the appropriate anchors and 
offsets, you can apply them to dissimilar layouts. 

1. Select a layout in the Project Explorer. 

2. Select Marks > Save Marks As Mark Set. 

3. Enter the mark set name, and then click OK. 

Note You can access and modify Mark Set properties 1) when you are saving a mark set, or 2) 
through the Mark Sets node in the Database window with no project open, or 3) when you are 
making a variation of a mark set in the Database. You can only delete mark sets from the 
Database window when no project is open. 

Editing mark sets 

You can modify mark sets to help Metrix determine which mark set should be used with a particular layout. 

Editing Mark Set properties is especially helpful for those running Automation Lite, as it gives the operator 
precise control over which mark sets will be automatically applied to layouts during the automation process. Mark 
Set properties apply whether the mark set is added manually by an operator or automatically by Automation Lite. 

How to edit a mark set 

1. With no project open select Mark Sets in the Database window. Then select the mark set you wish to 
edit and click Edit to open the Edit Mark Set window. 

2. You can edit the following Mark Set properties in the Edit Mark Set window. 
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Mark Set Properties 

Property Explanation 

Name The name of the mark set 

Mark Count The number of marks in the set. 

Sheetwise True / False 

Whether or not the mark set is eligible to be applied to sheetwise 
layouts. 

Perfected True / False 

Whether or not the mark set is eligible to be applied to perfected layouts. 

Work and Turn True / False 

Whether or not the mark set is eligible to be applied to work and turn 
layouts. 

Work and Tumble True / False 

Whether or not the mark set is eligible to be applied to work and tumble 
layouts. 

One-Sided True / False 

Whether or not the mark set is eligible to be applied to one-sided 
layouts. 

Set Mark Placement to ‘Front 
Only’ for Single-Sided Printing 
Methods 

True / False 

For single-sided layouts (work and turn, work and tumble, or one-sided), 
this property will set the mark placement value to ‘Front Only’ for all 
marks on the layout. This helps eliminate the need for multiple mark sets 
for different working styles. 

Presses The list of presses for which this mark set is eligible. 

Process Cyan True / False / Either 

True insures that this mark set will only be eligible for layouts that 
contain this ink. 
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False insures that this mark set will not be eligible for layouts that 
contain this ink. 

Either allows this mark set to be eligible whether or not the layout 
contains this ink. 

Process Yellow Same description as for Process Cyan. 

Process Magenta Same description as for Process Cyan. 

Process Black Same description as for Process Cyan. 

Spot Colors 1-16 Same description as for Process Cyan. 

Note You can edit mark set properties and modify them through 1) the Database Mark Sets node, or 2) when 
you are saving a mark set, or 3) when you are making a variation of a mark set. You can only delete 
mark sets from the Database when no project is open. 

Adding mark sets to layouts 

You can add whole Mark Sets to one or more layouts at a time by following these steps. 

1. Select the layout or layouts in the Project Explorer. 

2. Next, go to the Marks menu, and select Add Mark Set. 

3. Select the mark set you wish to add from the Add Mark Set window, then click OK. 

Note You can filter the list of mark sets by typing criteria in the Filter field, separated by spaces. 

 — Filtering with Or selected finds those mark sets that meet any of the criteria listed. This is a 
broader, less restrictive search. 

 — Filtering with And selected finds only those mark sets that meet all listed criteria. This is a 
narrower, more restrictive search. 

 — Removing all data from the Filter field makes all the mark sets appear again. 

 — After you add the mark set to the layout, all marks are fully editable. You can create a new 
mark set from an existing one by making the necessary changes and saving it as another mark 
set. 

Deleting a mark set 

To delete a mark set, with no project open, use the following steps. 

1. Select Settings > Database. 

2. Under Resources, click Mark Sets. 

3. Select the Mark Set you want to delete and click Delete. 

Deleting all marks on a layout 

1. Select the layout. 

2. Select Marks > Delete All Marks. 

Changing the Spot Color for Marks 

You cannot change the spot color embedded in a file mark, but you can change the spot color for: 

• Rectangle marks 

• Line marks 

• Text marks 

Use the following steps to change the Spot Color for Marks. 
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1. Select layout. 

2. Select Marks > Set All Mark Spot Colors… 

3. Choose a new spot color in the Spot Color Marks window, and then click OK. 

Note The new spot color must already exist in the Metrix database. 

Collation Marks Overview 

There are two major kinds of collation marks – automatic and custom. These options provide great flexibility for 
those wishing to add collation marks to a product. 

You can add automatic collation marks by adjusting the collation marks settings for each binding machine in the 
Database window. These settings then apply to any new product that uses that binding machine. Thus, all future 
products can have “set-and-forget” collation marks applied automatically. 

Metrix comes with the Stitcher Trimmer set with collation marks on the jog edge. The Perfect Binder has collation 
marks set on the spine. Thus, by selecting the binding machine when making a new product, you also set the 
position of the collation marks. 

You can add custom collation marks to a product by adjusting the Collation Marks settings in the Properties 
Editor. You can change these settings individually to override the settings of the binding machine. 

Primary and secondary collation marks 

Collation marks appearing on the outermost, or non-nested components of a perfect bound product are referred 
to as primary collation marks. Collation marks on nested components are referred to as secondary collation 
marks. 

Although a few perfect bound products may contain nested components, most will have only outermost 
components, and thus display only primary collation marks. Those marks will appear sequentially along the spine 
edge of the components. 

 

 

In a saddle-stitched product, all components will have primary collation marks along the jog edge. 

Outermost 
Components Primary 
Collation Marks 

Outermost 

Components Primary 
Collation Marks 

Outermost 
Components Primary 
Collation Marks 

Nested Component 

Secondary Collation 
Mark 
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Note Collation marks do not appear on the cover of the product. 

Collation mark positions 

You can position collation marks text using the Anchor Trailing Text To option so text immediately follows the 
individual marks, as on the left, or follows the whole block of marks, as on the right. These examples are from a 
bound product with the collation marks on the spine edge and no secondary (nested) components. 

 

 

 

 

 

Collation marks are positioned sequentially along the jog edge of saddle-stitched products. You can anchor text 
variables to the individual marks, or to the entire block of marks, as for spine collation marks. 

 

 

 

Changing collation marks settings 

1. In the Properties Editor go to Collation Marks and click inside the Value column next to Binding Machine 
Defaults. This will make  appear. 

2. Click  to open the Collation Marks window. 

3. In the Collation Marks window, select Custom from the Method menu. 

Primary 
Collation 

Marks 
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The Collation Marks properties will now become available. 

 

4. Set the Collation Marks properties using the following descriptions as a guide. 

Collation Marks Properties 

Property Explanation 

Method Binding Machine Defaults / Custom 

Collation Marks properties should follow those of the selected 
binding machine or be custom settings. 

Mark Type (None) / Spine / Jog 

Placement of the collation mark. 

Start Offset The distance from the jog/spine intersection to place the first 
collation mark. 

Width The collation mark width. 

Height The collation mark height. 

Repeat Number The number of collation marks to step before beginning at the start 
offset again. 

Over Page Content True / False 

Whether or not collation marks print over other text. 

Primary Mark Color Type of color, color, and percentage of color for collation marks on 
non-nested components. 

Primary marks appear on the outermost component(s) of a perfect 
bound product. 

Saddle-stitched components all have primary collation marks. 

Secondary Mark Color Type of color, color, and percentage of color for collation marks on 
nested components. 

Secondary marks appear on nested components of a perfect bound 
product. 

Trailing Text Default is <TextComponent.Number>, but many other pertinent 
variables are also available. (For more information, see the table of 
Collation Mark Text Variables in the Changing collation marks 
settings section.) 

Anchor Trailing Text To Block of Marks / Individual Marks 
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You can position trailing text relative to the whole set of collation 
marks, or relative to the individual marks. 

Distance From Anchor The distance the trailing text will be from the individual collation 
marks or the block of marks. 

Trailing Text Point Size The point size of the trailing text. 

In the Collation Marks window, you can click  next to Primary Mark Color and Secondary Mark Color to make 
your selections for the mark colors and saturation. 

 

Notes The trailing text is always drawn in solid inks, not screens. So, all inks used for the relevant Mark Color 
(either the Primary Mark Color or Secondary Mark Color) are converted to 100% for the text. 

Here is an example of different positions of collation marks relative to the spine. Notice that since collation mark 
three is on a nested component of a perfect bound product, it is in the same position as collation mark two, and 
is in the Secondary Mark Color, which is 40% black. 
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Note Collation marks for saddle-stitched products work similarly. The major difference is that the collation 
marks will always be primary collation marks, and they will be along the jog edge of the product. 

The default setting for the Trailing Text is <TextComponent.Number>, but there are many other useful variables 
that you can use with collation marks. 

Collation Mark Text Variables 

Variable Inserts Related to 

<TextComponent.Number> Text component number (not 
counting the cover component) 

Component 

<Component.Number> Component number Component 

<Component.Fold.Name> Name of the component fold Component 

<TextComponent.Count> Total number of text 
components in the product (not 
including the cover component) 

Component 

<Component.Count> Total number of components in 
the product 

Component 

<Component.PageCount> Page count for this component 
(front & back) 

Component 

<Product.ID> Product ID Component 

<Product.Name> Product name Component 

<Product.ContentFile> Product content filename Component 

<Product.RequiredQuantity> Product required quantity Component 

<Product.TotalQuantity> Product total quantity Component 

<Product.Width> or <Product.Width.Unit> Product width and unit of 
measure 

Component 

<Product.Width.NoUnit> Product width without unit of 
measure 

Component 

<Product.Height> or <Product.Height.Unit> Product height with unit of 
measure 

Component 

<Product.Height.NoUnit> Product height without unit of 
measure 

Component 

<Product.BindingMachine.Name> Name of the binding machine Component 

<Instance.ID> Instance ID (e.g., A-1 or A1-1) Component 

<Instance.Number> Instance number (e.g., the “1” in 
A-1 or A1-1) 

Component 

<Instance.Count> Number of instances on the 
layout 

Component 

<Instance.RequiredQuantity> Instance quantity (how many 
components are produced from 
the instance) 

Component 

<Project.ID> Project ID Project 

<Date> Current date Computer 

<Time> Current time Computer 

<Layout.Side> or <Side> Layout side number (1, 2) Layout 

<Layout.Side.Alpha> or <Side.Alpha> Layout side letter (A, B) Layout 

<Layout.Number> or <Number> Layout number Layout 

<Layout.PrintingMethod> or 
<PrintingMethod> or <PM> 

Layout printing method Layout 
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<Layout.SheetHeight> or <SheetHeight> or 
<SH> 

Layout sheet height Layout 

<Layout.SheetWidth> or <SheetWidth> or 
<SW> 

Layout sheet width Layout 

<Layout.RequiredSheets> Layout required sheets Layout 

<Layout.Press.Name> or <Press.Name> Layout press name  Layout 

<Layout.Stock> or <Stock> Layout stock Layout 

Applying Default Collation Mark settings to an existing product 

Projects created before automatic collation marks were set up for the binding machine may have the Collation 
Marks property set to None. You can set custom collation marks, as previously described, or you can apply the 
binding machine defaults to the product as a whole. To change the custom settings, use the following steps. 

1. Select the product from the Project Explorer. 

2. Choose the appropriate binding machine from the Binding Machine property. 

3. Open the Collation Marks window by clicking  next to the Collation Marks field value. 

4. Select Binding Machine Defaults from the Method property of the Collation Marks window. In this case 
you will not be able to adjust the settings manually, since they have already been established for 
binding machine in the Database window. 

5. Click OK to change the Collation Marks from Custom to Binding Machine Defaults. 

Making a variation binding machine with Alternate Collation Mark settings 

Note You must have the appropriate permissions to change the Database. 

1. With no project open, select Settings >Database. 

2. Select Binding Machines under Equipment. 

3. Click Variation on the right side of the Database window to make a duplicate of the binding machine. 
You may want to add a descriptive word to the name of the binding machine to indicate that it includes 
alternate collation marks. 

4. Scroll to the end of the list in the New Variation Binding Machine window where you will find the 
Collation Mark options. When you select Spine or Jog from Marks Type, the options become available. 

5. When you are finished, click OK. 

Note These settings will now apply to any new product using this binding machine. Thus, all future 
products can have “set-and-forget” collation marks applied automatically. 

Inserting Marks 

Inserting automatic trim marks 

Metrix can add trim marks automatically using the Export window. 

Note Enter a trim mark length of 0 (zero) to turn them off. 

1. Select File > Export or click  . 

2. Select an export type. 

3. Choose Trim Marks properties from the Export window by clicking the arrow next to it to open the 
possible options. 
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4. Click OK. 

Inserting automatic proofing lines 

Metrix can add proofing trim and bleed lines automatically using the Export window. 

Note Enter a trim line and bleed line color of (None) to turn them off. 

1. Select File > Export or click . 

2. Select export type on the left side of the Export window. 

3. Choose Proofing Lines properties. 

 

Inserting automatic fold marks 

Metrix can add fold marks automatically using the Export window. 

Note Enter a fold mark length of 0 (zero) to turn them off. 

1. Select File > Export or click . 

2. Select the export type. 

3. Choose Folding Marks Properties from the Export window, and then click OK. 
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Adding Dimensions to the Layout 

Dimensions – Overview 

• To enter or exit Dimensions mode, click Dimensions. 

• If you are using dimensions as notations on the report, keep in mind that they are erased during an auto 
layout so they should be put on the layout last. 

• You can adjust the width of the anchor in the Dimensioning Preferences window. 

• To add default sheet dimensions, right-click or CTRL-click and select Create Default Sheet 
Dimensions. 

• To remove all dimensions from a layout, right-click or CTRL-click anywhere on the layout and select 
Delete All. 

• If two or more dimensions are in the same position, Metrix will delete the duplicates when you leave the 
dimensioning mode. 

• When you save a layout as a standard, the dimension data will be saved with that standard. 

• To delete a dimension, right-click or CTRL-click then select Delete. 

 

Clicking to Add Dimensions 

When you click in an area, Metrix looks for the nearest boundaries, and adds that dimension. 

• Click to add horizontal dimensions 

• SHIFT-click to add vertical dimensions 

• In the Dimensioning Preferences box, select the option “Position new dimensions outside the sheet.” 
This tells Metrix that you want all the dimensions outside the sheet area, and that you want Metrix to 
position the dimensions for you. 

• When “Make click dimensions only consider pages and sheet” is selected, Metrix will not measure 
between all boundaries, but only those related to the pages and sheet. 

Note You can delete a dimension by right-clicking and choosing Delete. 
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Manual Dimensions 

• You can also create dimensions manually, by dragging, rather than by clicking. 

• As you move your mouse over the layout, the cursor will change to a “crosshairs” shape when it is 
positioned over an eligible item. Drag it to another item to add the dimension. 

 

• You can move any dimension (including a sheet dimension) by selecting and dragging it to a new 
location. 
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Standards 
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Saving, Applying, and Updating Metrix Standards 

The purpose of standards is to ensure layout standardization and to eliminate repetitive work. While you can 
save standards and apply them for any type of work, they are particularly useful for bound layouts. 

Standards should not be confused with templates. Metrix has one, and only one, standard for a specific set of 
properties. You can apply a saved standard layout to a new layout when the following properties match: 

• Product Width and Product Height (multiple product sizes are supported, though this would not be 
common) 

• Product Type – Flat, Folded, Bound Cover, or Bound Text (multiple product types are supported, though 
this would not be common) 

• Fold 

• Binding Machine 

• Jog Trim and Spine Trim (bound work) 

• Press 

• Printing Method 

• Sheet Size 

After Metrix determines that all above properties match, Metrix also applies the following from the saved 
standard:  

• Product Instance positions on the Layout 

• Marks 

• Dimensions 

• Non-Jog Trims, Front Face Trims, and Back Face Trims (bound work) 

Saving a Layout as a Standard 

Note Only users with the appropriate permissions may save standards. 

1. Select the layout. 

2. Then choose Layout > Save Layout as Standard. 

When other layouts in the project meet the matching requirements, Metrix will ask whether you want to apply the 
standard to those other layouts. 

Note When Metrix applies a standard, the Layout icon changes to this: . 

 After applying a standard, the layout remains fully editable. The Layout icon will immediately change to 

this: , indicating that the layout is no longer a standard. 

Applying Standards Automatically 

A setting in the User Preferences window controls the automatic application of standards: 

1. Select Settings > User Preferences. 

2. Select Import Project. 

3. Set Substitute Metrix Standard to True. 

Note When Substitute Metrix Standard is set to True, Metrix automatically applies existing standards 
to matching layouts – whether imported or added in the Metrix user interface. 
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Applying standards manually 

To apply a standard manually 

1. Select a layout or product. 

2. Click  on the Metrix toolbar. 

3. If a matching standard exists, Metrix will apply it to the layout. 

Updating a standard 

A standard might require updating from time to time. 

When you select Layout > Save Layout As Standard, Metrix searches for an existing standard. If one is found, 
you will be prompted to overwrite or replace the existing one or leave it as is. 

Note Only users with the appropriate permissions may save or replace standards. 

Deleting a standard 

To delete a standard, select a layout to which the standard has been applied, then choose Layout > Delete 
Standard. Alternatively, you can delete a standard in the Standards Manager. 

Note Only users with the appropriate permissions may delete standards. 

Using the Standards Manager 

About the Standards Manager 

You can filter the standards in a project by the properties of those standards, find only the standard or standards 
you want to change, and then save the changes to the standard. 

You can filter the standards using the Standard Manager with various parameters under these general 
categories: 

• Press 

• Die-Cutting Tool 

• Binding Machine 

• Type 

• Printing Method 

• Fold Name 

• Finished Dimension 

• Finished Dimensions 

• Sheet Width 

• Sheet Height 

• Sheet Grain 

• Lap 

• Spine Trim 

• Jog Trim 

• Creator 

• Creation Date 
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We will explain the above categories in detail in a table at the end of this chapter. 

The Standards Manager functions much like the Component Picker, so if you have used that Metrix feature, you 
will find the Standards Manager operates in a similar fashion. 

Opening the Standards Manager 

You can only open the Standards Manager when no Metrix project is open. Either close the current project, or 
start the Standards Manager just after you start Metrix, but before you open a project. 

You can open the Standards Manager by clicking  in the upper left corner. 

The Standards Manager window 

After you open the Standards Manager, you will see a list of the standards Metrix has stored in the database. 

The Standards Manager opens with the standards collapsed to display more standards in the window. Click the 
triangle to the left of a standard to expand the standard and view the components. 

Note Some property fields may be empty, depending on whether the property applies to the whole standard 
or only to a component. The description “(Different Values)” indicates that the components in the 
standard have different values for that particular property. 

This window also has the buttons you will use to filter and edit your standards. They are as follows. 

• Expand/Collapse Filter View ( ) 

• Delete Standard ( ) 

• Edit Standard ( ) 

• Exit the Standards Manager ( ) 

• Number of Active Filters ( ) 

• Add Filter ( ) 

Filtering standards with the Standards Manager 

When you click , an Options menu will open that lets you select which property you would like to 

use for the filter. To delete a filter, click .  
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After you make a selection on the Filter Options menu, additional menus or text fields will open so you can 
refine which properties should be used to filter the standards. 

Click Add Filter each time you want to add an additional filter option. 

 

A complete table listing and explaining all the properties on this menu, as well as the additional menu items or 
text fields that can be added to filter the standards, is included in The Standards Manager Filter options.  

Editing, saving, or deleting a standard 

1. Find the standard you wish to modify. 

2. Select it from the Standards list. 

3. Click Edit to open the Standard Explorer window where you can edit the standard and then save the 
changes. 
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In the Standard Explorer window, you can edit the properties of the standard, run an auto layout if necessary, 
and save your changes by clicking Save. 

You can also modify various components of the layout if necessary. 

Note When editing a standard, the following properties changes to products are not saved: Content Position 
Rule, Tagged, Required Qty., Display Color, Grain, Bleeds, Allow Nesting, Priority, and Product Group. 
For layouts, Cutting Machine is not saved. 

If you need to add marks to the standard, the Marks menu is available while editing in the Standard Explorer. 

The elements in the layout will be more generic than the regular layout since many of the elements (e.g., head 
and jog or component dimensions) are not specific to the standard being displayed. 

When you want to return to the Standards Manager window, click Standards Manger. Or click Exit Standards 
Manager to exit the Standards Manager altogether. 

Editing a standard 

Note You must enter the Standards Manager before executing the following steps. 

1. Edit the properties you wish to change in the Properties Editor. 

2. Run an auto layout, if necessary. 

3. Click Save on the top left to save changes. 

4. Click Standards Manager to return to the Standards Manager window. 

Editing covers and text in a bound product 

In bound products, text components can appear by themselves, but a cover will always have a text component 
associated with it. Thus, in the Standards Manager, standards applied to the cover of a bound product will 
appear with a text component, but the text component will be unavailable for editing. The icon for the component 
will be gray indicating that it cannot be edited. 
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Also, if a standard contains a cover component and text component on the same layout, the text component may 
be listed in the Standards Explorer as a different product. You do not need to be concerned about this since it 
doesn’t affect how Metrix applies the standard. 

Deleting a standard from the File menu 

If you need to delete a standard, you can click Delete Standard, or you can do that from the File menu. Just 
select the standard, and then select File > Delete Standard. 

Exiting the Standards Manager from the File menu 

You can exit the Standards Manager by clicking Exit Standards Manager, or you can exit the Standards 
Manager by selecting that option from the File menu. You can also exit the Standards Manager using CTRL-W 
on Windows (CMD-W on Mac). 

The Standards Manager Filter options 

Use the table below of the Filter options (the first menu on a filter) for the Standards Manager, and the additional 
options for that property. The additional options can be pull­down menus or text fields. 

Standards Manager Filter Options 

Filter Option Second, Third, or Fourth Option (Menu or Text Field) 

Press (is) Opens a second menu with the names of all the presses used by any 
standards in the Database window. 

Die-Cutting Tool (is) Opens a second menu with the names of all the die-cutting tools used by 
any standards in the Database window. 

Binding Machine (is) Opens a second menu with the option None and a list of the binding 
machines used by any standards in the Database. 

Type Is / Contains 

Is restricts the filtering to those standards that have only the product type 
designated on the second menu. 

Contains finds those standards that contain the designated product type, but 
may also have other product types in the standard. 

Flat / Folded / Bound – Select the product type for filtering. 

Standard applied 
to cover selected 

and available for 
editing 

 

Text Component 
gray and 
unavailable for 

editing 
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Printing Method (is) Opens a second menu with a list of the printing methods used by any 
standards in the Database. 

Fold Name Is / Contains 

Is restricts the filtering to those standards that have only the fold name 
designated on the second menu. 

Contains finds those standards that contain the designated fold name, but 
may also have other fold names in the standard. 

Fold Name Menu – Shows the fold names used in the standards. 

Finished Dimension Equals / Less Than / More Than / Text Field 

Displays standards where at least one of the finished dimensions (width OR 
height) is equal to, less than, or greater than the number entered in the text 
field. 

Finished 
Dimensions 

Equals / Less Than / More Than / Two Text Fields 

Displays standards where at least one set of finished dimensions (width AND 
height) is equal to, less than, or greater than the numbers entered in the text 
fields. 

Sheet Width Equals / Less Than / More Than – and a text field to enter a number for the 
sheet width. 

Sheet Height Equals / Less Than / More Than – and a text field to enter a number for the 
sheet height. 

Sheet Grain (is) Opens a second menu where choose Vertical / Horizontal.  

Lap Equals / Less Than / More Than – and a text field to enter a number for the 
lap size. 

Spine Trim Equals / Less Than / More Than – and a text field to enter a number for the 
spine trim size. 

Jog Trim Equals / Less Than / More Than – and a text field to enter a number for the 
jog trim size. 

Creator (is) Opens a second menu with the names of the creators of any standards in 
the Database. 

Creation Date Any allows you to enter any creation date. 

Within Last opens a text field for a number, and a menu with Days / Weeks / 
Months / Years. 

Within Next opens a text field for a number, and a menu with Days / Weeks / 
Months / Years. 

Exactly opens a text field with a pull-down menu. You can enter an exact 
date in the field, or you can click the menu, and an interactive calendar will 
appear where you can find and enter a date by clicking. 

Before opens a text field with a pull-down menu. You can enter an exact 
date in the field, or you can click the menu, and an interactive calendar will 
appear where you can find and enter a date by clicking. 

After opens a text field with a pull-down menu. You can enter an exact date 
in the field, or you can click the menu, and an interactive calendar will appear 
where you can find and enter a date by clicking. 

Today enters today’s date in the field and is not editable. 

Yesterday enters yesterday’s date in the field and is not editable. 

This Week selects only those standards created this week.  

This Month selects only those standards created this month. 

This Year selects only those standards created this year. 
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Importing in Metrix 

JDF/Metrix XML import project prerequisites 

To successfully import JDF or Metrix XML projects, the database of the Metrix installation must have identical 
resources to those specified in the incoming file. These include (but are not limited to): 

• The Press ID specified in the JDF or Metrix XML. 

• The Binding Machine ID specified in the JDF or Metrix XML. 

When errors do occur, Metrix will detail the source of the problem as seen in the following. 

 

Database resources added by JDF/ Metrix XML import 

When JDF or Metrix XML projects are successfully imported, some resources are automatically added to the 
Metrix Database on the fly. These may include: 

• Customer and Customer Contact 

• Ink 

• Stock and Stock Sheet 

• Product Group 

Importing JDF and Metrix XML projects 

There are two ways to import JDF or Metrix XML Projects into Metrix: 

• Use Import Project on the toolbar 

• Drop the project into the hot folder 

Whichever method you use, the imported Metrix project is fully editable. 

Using the hot folder 

When a JDF or Metrix XML project is dropped into the hot folder, it automatically opens for editing as soon as the 
Metrix interface is available. You can drop more than one project into the hot folder – each project opens 
automatically in turn as the Metrix interface becomes available. 

When a project is open, the hot folder is stopped. 

Metrix XML projects 

Metrix XML projects contain all project and product data, but not all layout data; when importing Metrix XML 
projects, some layouts may require an auto layout. Layouts that match previously saved standards do not require 
an auto layout. 

Importing a JDF, Metrix XML, or CSV project 

Metrix can import three types of project data: Metrix XML, JDF, and CSV. 

Follow these steps to import a sample Metrix XML project. 
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1. Click Import Project on the toolbar. 

2. Choose the file appropriate for your Metrix installation. All of the sample files are located inside the 
Metrix installation Imports folder. 

For metric: 

• Windows: Choose C:\Program Files\EFI\Imports > Metric > 05_SELF-COVER_44PP.mxml 

• Mac: Choose MacintoshHD/Applications/EFI/Metrix/Imports 

For inches: 

• Windows: Choose C:\Program Files\EFI\Metrix\Imports > Inches > 05_SELF-
COVER_44PP_INCHES. Mxml 

• Mac: Choose Macintosh HD/Applications/EFI/Metrix/Imports 

3. Click Import. The Import window will open. 

Note The layouts require an auto layout. This is because a Metrix XML project contains project, 
product, and layout information, but not layout product positioning information. 

If you saved a standard for a particular type of layout, and Metrix discovers that the new project contains layouts 
that match the trims, marks, dimensions, and positioning information, the standard will automatically be applied 
to the new layout. 

You can set Metrix preferences so that standards are applied automatically or manually. 

Select Settings > User Preferences... > Import Project to change the settings. 

Importing products 

Metrix can import three types of product data: Metrix XML, JDF, and CSV (comma-separated or semicolon-
separated). Metrix can now also import flat, folded, or bound products. 

To import a CVS product: 

1. Click Import Product on the toolbar. 

2. Browse and select a .CSV file. Metrix ships with sample files located in the Metrix Imports folder. 

• For inches you can navigate to: 

• C:\Program Files\EFI\Metrix\Inches on Windows  

• Macintosh HD/Applications/EFI/Metrix/Inches on a Mac 

• For metric you can navigate to: 

• C:\Program Files\EFI\Metrix\Metric on Windows  

• Macintosh HD/Application/EFI/Metrix/Metric on a Mac 

3. Select the stock for the products. Choose House Stock - 80# Text 115 gsm. 

Note If a CSV file contains stock information, you will not be prompted to select a stock.  

4. Click OK. The new products B, C, D, E, F, and G are added to the project. They now appear in the 
Project Explorer. 

5. Drag each new product onto a layout, or you can assign a product to a layout by first selecting the 
product, and then choosing Assign Component(s) to Layout from the Project menu. 

Note On Windows, the cursor changes shape ( ) to indicate a valid drop location. 

6. Select a layout and click Auto Layout so Metrix can generate the layout with the new products added. 

Notes If the imported CSV products were assigned a group, they will be automatically segregated from 
the other products on the sheet. 

 If Metrix asks you to enter a number for a placement group as seen below, enter the number 
and then click OK. 
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Metrix can automatically insert space between the placement groups. Select Settings > User 
Preferences... > Auto Layout > Gap Between Placement Groups to enter your preferred amount of 
space. 

Exporting in Metrix 

The Export window 

You can output one or many kinds of data using the Export window. 

• Click Export to open the Export window 

• Clicking an option displays the window for that option on the right 

• Clicking the option checkbox activates its Export 

 

Exporting an imposed PDF 

To export an imposed PDF: 

1. Click Export on the toolbar. 

2. Select (highlight) and enable (check) imposed PDF. 

Note Clicking the checkbox enables/disables the export. Clicking the export Type (e.g., Imposed 
PDF) displays its settings. 
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3. Make note of the destination folder or select a new destination folder using Browse. Select the 
properties for the Imposed PDF export, then click OK. 

4. Review the Imposed PDF. In this example, you see both sides of the layout. 

Notes You can open the imposed PDF with any PDF reader and if desired, output to any networked 
printer, either scaled or full-size. 

 Metrix automatically names the imposed PDF using the Project ID. This project is 
IMPOSED_PRODUCT_WITH_PDF_INCHES, so the PDF file is also named 
IMPOSED_PRODUCT_WITH_PDF_INCHES. 

 

 

Imposed PDF Settings 

Setting Explanation 

Filename Format Enter the name of the export file. The automatic naming algorithm 
is ProjectID.PDF. 

Destination Folder Save the PDF to this location. The automatic naming algorithm is 
ProjectID.PDF. 

Layout Sides The layout sides to export. SHIFT-click to select a range of 
layout sides. CTRL-click (Windows) or CMD-click (Mac) to 
select multiple layout sides. 

Export As One File / Separate File for Each Layout / Separate File for 
Each Layout Side / Separate File for Each Bundle 

The PDF file(s) to create. 

Impose To Press Sheet / Plate 

The area to impose to. 

PDF Sheet Bleed Value that specifies the PDF Sheet Bleed margin (default is 0”) 

You can specify a PDF Sheet Bleed margin when exporting 
Imposed PDF, Barcoded Imposed PDF, and JDF. This bleed 
margin setting is in the Export window; it adds the specified 
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margin to the mediabox all around the sheet and sets the trimbox 
to the exact sheet size. This ensures that marks can bleed off the 
edge of the sheet. 

Trim Marks 

Length The trim mark length. 0 (zero) length turns off trim marks. 

Distance from Page Trim The distance from the page trim to the beginning of the trim mark. 

Thickness The trim mark thickness or weight. 

Over Page Content True / False 

When True, trim marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

External Fold Marks (outside the page trim bounding rectangle) 

Length The fold mark length. 0 (zero) length turns off external fold marks. 

Distance from Page Trim The distance from the page trim to the beginning of the fold mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted 

The fold mark line type. 

Internal Fold Marks (inside the page trim bounding rectangle) 

Maximum Length The maximum length for the fold mark. 0 (zero) length turns off 
internal fold marks. 

Crop Distance from Page Trim The distance from the page trim to the beginning of the fold mark. 

Minimum Length The minimum length for the fold mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted 

Proofing Lines 

Thickness The thickness of all proofing lines. 

Trim Line Color (None) / Select an Ink (from the Metrix database) 

Insert a trim line of the selected color around the bleed of each 
page. 

Trim Line Type Solid / Long Dashed / Short Dashed 

Insert a trim line of the selected type around the trim of each 
page. 

Bleed Line Color (None) / Select an Ink (from the Metrix database) 
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Insert a bleed line of the selected color around the bleed of each 
page. 

Bleed Line Type Solid / Long Dashed / Short Dashed 

Insert a bleed line of the selected type around the bleed of each 
page. 

Export Negative Bleeds True / False 

When True, any Negative Bleed area specified in Metrix will be 
cropped. 

Exporting a Digital Cutting File 

You can export a cutting file for a digital cutting machine in ZCC, ICut, ICut JDF, or DXF format. Select the 
format you prefer from the Cutting File Type menu as seen in the following: 

 

Exporting barcoded imposed PDF 

You can use barcoded (code 128) imposed PDF to speed sorting and shipping. The barcoded imposed PDF is 
output full size, put on top of the stack, then cut with the printed sheets. Each job stack then has barcoded 
information on top. 

Note Metrix uses the following syntax: Project ID_Barcoded.PDF. 
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Barcoded Imposed PDF Settings 

Setting Explanation 

Filename Format Enter the name of the export file. The automatic naming algorithm 
is ProjectID.PDF. 

Destination Folder Save the PDF to this location.  

Layout Sides The layout sides to export. SHIFT-click to select a range of 
layout sides. CTRL-click (Windows) or CMD-click (Mac) to 
select multiple layout sides. 

Export As One File / Separate File for Each Layout / Separate File for 
Each Layout Side / Separate File for Each Bundle 

The PDF file(s) to create. 

Impose To Press Sheet / Plate 

The area to impose to. 

PDF Sheet Bleed Value that specifies the PDF Sheet Bleed margin (default is 0”) 

You can specify a PDF Sheet Bleed margin when exporting 
Imposed PDF, Barcoded Imposed PDF, and JDF. This bleed 
margin setting is in the Export window; it adds the specified 
margin to the mediabox all around the sheet and sets the trimbox 
to the exact sheet size. This ensures that marks can bleed off the 
edge of the sheet. 

Trim Marks 

Length The trim mark length. 0 (zero) length turns off trim marks. 

Distance from Page Trim The distance from the page trim to the beginning of the trim mark. 

Thickness The trim mark thickness or weight. 

Over Page Content True / False 

When True, trim marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

External Fold Marks (outside the page trim bounding rectangle) 

Length The fold mark length. 0 (zero) length turns off external fold marks. 
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Distance from Page Trim The distance from the page trim to the beginning of the fold mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted The fold mark line type 

The fold mark line type. 

Internal Fold Marks 

Maximum Length The maximum length for the fold mark. 0 (zero) length turns off 
internal fold marks. 

Crop Distance from Page Trim The distance from the page trim to the beginning of the fold mark 

Minimum Length The minimum length for the fold mark 

Thickness The fold mark thickness or weight 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks 

Line Type Solid / Dashed / Dotted 

Thickness The thickness of all proofing lines 

Trim Line Color (None) / Select an Ink (from the Metrix database). 

Insert a trim line of the selected color around the bleed of each 
page 

Trim Line Type Solid / Long Dashed / Short Dashed 

Insert a trim line of the selected type around the trim of each 
page. 

Bleed Line Color (None) / Select an Ink (from the Metrix database) 

Insert a bleed line of the selected color around the bleed of each 
page. 

Bleed Line Type Solid / Long Dashed / Short Dashed 

Insert a bleed line of the selected type around the bleed of each 
page. 

Export Negative Bleeds True / False 

When True, any Negative Bleed area specified in Metrix will be 
cropped. 

Include Content True / False 

When False, only the barcodes and any human readable text will 
image. 

Barcode Properties 

Barcode Text The text to be transformed into barcodes. This can be static text, 
Metrix barcoded imposed PDF variables, or both. For more 
information, see Variables for Barcoded Imposed PDF.  
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Human Readable Text The readable text to insert below the barcode. This can be static 
text, Metrix barcoded imposed PDF variables, or both. 

For more information, see Variables for Barcoded Imposed PDF. 

Text Point Size The human readable text point size 

Bar Height The bar code height 

Minimum Bar Width The minimum bar width 

Side Quiet Zone The amount of white space to insert on the sides of the barcode 

Top Quiet Zone The amount of white space to insert on the top and bottom of the 
barcode 

Color All Separations / Select an Ink (from the Metrix database) 

The color for the barcodes 

Variables for Barcoded Imposed PDF 

Metrix Variables for Barcoded Imposed PDF 

Variable Inserts 

<!> Carriage return, line feed 

<Product.ID> The product ID (A, B, C, etc.) 

<Product.Name> The product name 

<Product.Customer> The product customer 

<Product.RequiredQuantity> The required quantity for the product 

<Product.Notes> Any notes entered into the Product Notes property 

<Product.DueDate> The product due date 

<Product.ProductGroup> The product group 

<Product.Width> The product width and the unit of measure (e.g., 210mm, 

8.5") 

<Product.Width.Unit> The product width and the unit of measure (e.g., 210mm, 
8.5") 

<Product.Width.NoUnit> The product width without the unit of measure (e.g., 210, 
8.5). 

<Product.Height> The product height and the unit of measure (e.g., 297mm, 
11") 

<Product.Height.Unit> The product height and the unit of measure (e.g., 297mm, 
11") 

<Product.Height.NoUnit> The product height without the unit of measure (e.g., 297, 
11) 

<Product.Description> The product description 

<Product.ContentFile> The content filename for this product 
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<Product.BindingMachine.Name> The product binding machine 

<Instance.Number> The instance number (for example, the “1” in “A-1”) 

<Instance.Count> The number of instances on the layout. You can use this in 
combination with <Instance.Number> to label each instance 
with the total, e.g., “1 of 10” (“<Instance.Number> of 
<Instance. Count>”). 

<Instance.RequiredQuantity> The required quantity for each product instance. Functional 
when Layout View preferences have been set to 
GangingStyle for flat and folded products 

<Instance.ID> The ID for each product instance (e.g., A-1, A-2, etc.) 

 

Note For those users whose languages include characters from the upper ASCII range in a font (German, 
French, Spanish, Swedish, etc.), those characters will be converted on export to their lower ASCII 
(basic English range) equivalents. Thus, accented characters will lose their accents (á becomes a, ç 
becomes c, ä becomes a, ß becomes s, etc.), and alternate punctuation marks will also be converted (¡ 
becomes ! , ¿ becomes ? ). Those characters without a lower-ASCII equivalent will be converted to a 
hyphen ( - ). 

Exporting Metrix XML 

You can export products (and entire projects) to Metrix XML, which can then be reimported into Metrix. 

You can export Metrix XML (MXML) in version 1.0, 1.5, or 1.6. Select the appropriate version from the MXML 
Version drop-down list. 

Set the Include Plant Equipment field to True if you want to include the equipment definition in the exported 
MXML so systems that consume MXML can determine the equipment used in the project.  

 

Note Metrix automatically names exported Metrix XML files with the Project ID and a MXML extension. 

Exporting complete JDF 

Complete JDF means that Metrix will append the JDF imposition data to the original JDF imported into Metrix. 
This node is gray when the open project did not originate as JDF. 

Note Guidelines are the same as for JDF Imposition. 
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Exporting JDF imposition 

Notes Metrix uses the following syntax: Project ID.JDF. 

 To export JDF for Fujifilm XMF or Screen Trueflow, see the relevant appendices. 

JDF Imposition Settings 

Setting Explanation 

Filename Format Enter the name of the export file. The automatic naming algorithm 
is ProjectID.PDF. 

JDF Destination Folder The destination for the JDF file exported by Metrix. This is a 
location accessible to the JDF consumer (the prepress system). 

Content Destination Folder Often a sub-folder of the JDF Destination folder, this is the 
destination for the PDF Marks Flat. This is also the destination for 
PDF content files when Copy Content Files=True and when the 
content has been assigned within Metrix (populated JDF). 

Content Source Folder As the window states, this folder is “relative to the JDF 
Destination folder” – most often the same name as the Content 
Destination folder above. 

The syntax of this folder name is different than the Content 
Destination folder, however. Be sure to enter the folder name 
using the proper syntax, as in the example illustrated. 

Impose To Press Sheet / Plate 

The area to impose to. 

Copy Content Files True / False 

When True, Metrix will copy any assigned content files to the 
Content Destination folder. When False, no assigned Content will 
be copied. 

Handle File Marks Embed in PDF Marks Flat / Reference in JDF File 

The generally accepted JDF procedure is to Embed in PDF 
Marks Flat. This means that any file marks used in the job are 
part of the data stream processed by the JDF Consumer. When 
Reference in JDF file is selected, File marks must be copied to 
the Content Destination folder so the JDF Consumer has access 
to them for processing. 

Trim Marks 

Length The trim mark length. 0 (zero) length turns off trim marks. 

Distance from Page Trim The distance from the page trim to the beginning of the trim mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink(from the Metrix database) 

The color for trim marks. 

External Fold Marks (outside the page trim bounding rectangle) 

Length The fold mark length. 0 (zero) length turns off external fold marks. 

Distance from Page Trim The distance from the page trim to the beginning of the fold mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted 
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The fold mark line type. 

Proofing Lines 

Thickness The thickness of all proofing lines. 

Trim Line Color (None) / Select an Ink (from the Metrix database) 

Insert a trim line of the selected color around the bleed of each 
page. 

Trim Line Type Solid / Long Dashed / Short Dashed 

Insert a trim line of the selected type around the trim of each 
page. 

Bleed Line Color (None) / Select an Ink (from the Metrix database) 

Insert a bleed line of the selected color around the bleed of each 
page. 

Bleed Line Type Solid / Long Dashed / Short Dashed 

Insert a bleed line of the selected type around the bleed of each 
page 

Export Negative Bleeds True / False 

When True, any Negative Bleed area specified in Metrix is 
cropped. 

Exporting JDF cutting data 

Check with your vendor to determine which type of finishing data your equipment can handle. When you click 
Export, and then select JDF Cutting, in the JDF Cutting section you can set the Destination folder for the cutting 
data, and select whether you want the data to be one file, or a separate file for each layout. 

 

To export JDF cutting data 

1. Select the bound product then choose a path. 

2. Select the data you want to include in the report file created from JDF cutting data, and then click OK. 

Note The report mentioned above is the file created when you export JDF cutting data. 

Exporting data as a ZIP file 

When you are ready to export your data as a ZIP file, click Export. Click in the box to select the ZIP File option. 
On the right, you have the list of data options you can select for inclusion in the ZIP file. You can leave the 
Destination folder set as it is, or you can use Browse to change the destination folder for the ZIP file. 
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As you select the data options on the right, those options become inaccessible in the list of export options on the 
left. 

 

If you attempt to select an export method for data that is already assigned to the ZIP file, a note on the right will 
inform you that the data you are trying to select is already selected for export in the ZIP file. 

Data types that are not assigned to the ZIP file are still available for export separately. 

Once you select the various formats for data export, clicking OK will send the ZIP file to the destination folder. 

Exporting with errors 

If you try to export a project with errors, Metrix will warn you that your project needs correction. If there are 
errors, you see a warning like this: 

 

If you still wish to export the project, you may do this, as long as the user roles are set in the Database window to 
allow exporting with errors. Use the following steps. 

1. With no project open, select Settings > Database, then select the User Roles option. 

2. Next, select your user name, then click Edit. 

3. Check whether the “Allow Export with Errors” is set to True. If it is not, then set the option for True, and 
click OK to accept the change. 

4. Close the Database window. 

As long as the “Allow export with errors” option is set for True, you will be able to export projects even through 
Metrix gave you a warning. 

Export profiles 

Metrix now can save multiple export settings as an Export Profile. This allows you to quickly and consistently 
select between multiple export file types. 

Options become 
inaccessible here 

 

Select options here 
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For example, you might have one Export Profile that exports a PDF to a hot folder on a RIP without exporting 
JDF cutter data, another Profile to write populated JDF to one workflow hot folder with cutting data, and yet 
another profile to export unpopulated JDF to a different workflow hot folder with JDF cutting and binding machine 
data. 

Export profiles make complex exports simple and consistent across multiple users. 

To export a profile 

1. Click Export. 

2. Adjust the export settings to your preferred specifications. 

3. Click Save Settings as Profile… to save the settings as a set. 

The profile will then be available for selection on the Export Profile menu. 

Previewing and Printing the Metrix Report 

Metrix produces a comprehensive report of your project that you can print on any network printer. 

Follow these steps to preview and print the Metrix report. 

Note On Windows, you must have at least one printer installed to select Preview or Print. 

1. To preview the report before printing, click Report on the toolbar. 

2. Select the Page Setup settings, then click OK. 

3. Select the Report Data settings, then click OK. 

a. For large products, you can create a report that does not include identical product information 
for side 2 of 2-sided pieces by de-selecting the Side 2 Product Data option.  

 

b. You can print a report in black and white by selecting Layout Diagrams – No Color, and then 
de-selecting Layout Diagrams – Color Component Backgrounds, Layout Diagrams – 
Shade Page Bleeds, and Layout Diagrams – Show Previews. 

4. Review the report. An example is seen following this step. 
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5. Print the report on any network printer by clicking Print in the toolbar of the Preview Project Report 
window. When you have finished printing, close the Preview Project Report window to return to the 
Layout View. 

Note You can print the report to PDF on Windows using a PDF printer, or on the Mac by using Save 
to PDF. 

Exporting a report directly to printer, PDF, or CSV 

If you prefer to skip the process of viewing a report before you print it, or to save the report directly to PDF or 
CSV, you can do any of these using Export. 

• When you are ready to export the report, click Export, and then select Report to Printer, Report to PDF, 
or Report to CSV.  

• If you are exporting the report to a printer, select the target printer from the Printer menu, select the 
options you want from the Include in Report list, and then click OK. 

• If you are exporting the report to PDF or CSV, browse to the desired destination for the exported file in 
the Destination folder: field, select the options you want from the Include in Report list, and then click 
OK. 
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The JDF Color Mapping Option 
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JDF Color Mapping 

JDF Color Mapping allows the mapping of spot colors to other spot colors, mapping of spot colors to individual 
process colors, conversion of spot colors to process builds, and disabling of individual colors on a layout-by-
layout basis in order to control the color information exported from Metrix. It also facilitates the renaming of spot 
colors to other standard color names to support automation. 

Color remapping happens on a project-by-project basis, so the color remapping configured in one project is not 
transferrable to another project. 

At this time, Color Mapping works only with JDF. 

Note For more information on how to turn on the JDF Color Mapping feature, see The JDF Color Mapping 
user preference. 

Working with JDF Color Mapping 

When you create a project (e.g., with one flat product having 8.5x11” pages) and a layout is selected, the first 
side of the layout might look something like this: 

 

Switching to the Run List, it becomes evident that there is no content assigned to the pages of the product. 

 

Note For more information about the Run List, see What is the Run List? 
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After adding a content file to the File List, and dragging the pages onto the Run List, the pages are populated 
with content, as can be seen in the Previews mode in the Layout View: 

 

Returning to the File List, the color included in the pages of the PDF can be viewed. In the example below, the 
content file includes both process and spot colors: 

• Page 1: C, M, Y, K PANTONE Orange 021 U, PANTONE Green C, and PANTONE Purple M. 

• Page 2: C, M, Y, K PANTONE Red 032 C, Custom Spot Orange, Custom Spot Green, and Custom 
Spot Purple. 

 

Because the planned colors for the product were set for CMYK, there is a difference between the planned colors 
and the file colors. 

When the planned colors and file colors are different, the headers of the “Planned Colors” and “Status” columns 
turn red, and there is a “Colors” error, with a red and white “X” in the “Status” column. 

Note There are warnings in the “Status” list at the bottom of the window that more plates may be produced 
than the Planned Colors for the project allow. 

Changing planned colors 

There are two ways you can change the planned colors list to include the file colors. 

The first method can be started from the two locations. Either: 
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• Select “Custom” from the “Planned Colors” column in the Run List, or, 

• Select “Custom” from the “Planned Colors” menu in the Page Color Error window. 

Either of these selections will open the Custom Page Color window where you can make new planned colors and 
add them to the list. 

The second method is to use the “Add Planned Color” button in the JDF Color Mapping window. 

First method 

If you need to add file colors to the Planned Colors list, select a row in the Planned Colors list. A pull-down menu 
opens with the following options: 

• All of the Default Page Colors listed in the database 

• (None) 

• Custom… 

 

Note As mentioned previously, you can also create a Custom set by selecting “Custom” from the 
“Planned Colors” menu in the Page Color Error window. 

When you select Custom… from the menu, the Custom Page Color window opens where you can make new 
planned colors and add them to the list. 

1. Clicking New… (lower, left-hand corner of the Custom Page Color window) opens the New Ink window. 
Type the name to the file ink color you wish to add. (Names are case-sensitive so must match the File 
Color name exactly.) 

2. Now click in the CMYK Representation field to open the CMYK Color window. Set the 
percentages of the colors you want for the visual representation; these percentages do not affect the 
process color builds used for output. 

3. When you click OK, the CMYK Representation is added to the New Ink window. 

4. When you click OK in the New Ink window, the color is added to the Name list in the Custom Page 
Color window. 

5. Select the new ink color in the Custom Page Color window. 

6. When you click Add>, the ink will be added to the Page Color list. Repeat steps 1-6 to add other colors 
to the Page Color list. 

7. Lastly, when you click OK in the Custom Page Color window, the custom set of planned colors are 
added to the menu in the Run List, and the Custom set will become the planned colors for the layout 
side you selected. 
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Second method 

Here is another way to add all the file colors to the planned colors so the lists are the same. 

You start this process by clicking Add Planned Color in the JDF Color Mapping window. When you do, another 
window opens that allows you to add colors to the Planned Color list. To add colors: 

1. Click the Planned Colors line in the “Value” column. All ink colors in the database appear in the Planned 
Colors pull-down menu. If the color you need does not appear in this list, you must add it to the 
database either by using the first method previously described, or by opening the database and adding 
it to the Inks list. 

2. Click the Product line in the “Value” column and select the product to which you are adding the planned 
color—either an individual product or all products. 

3. Click the Position line in the “Value” column and select whether the Planned Color is being added to 
side one or side two of the layout. (If you selected All Products on the Product line, the only option 
under Pages will be All Pages.) 

4. When you click OK, the color will be added to the Planned Color list on the same line as the File Color 
of the same name. 

 

5. Continue adding planned colors until the Planned Colors list is complete. 

6. When you click Apply, the “Colors” error should be removed from the “Status” column in the Run List. 
This is because the list of planned colors and file colors are the same. 

The Page Color Error window 

Clicking the “Colors” error in the “Status” column opens the Page Color Error window for the selected page. Here 
the essential data is displayed about the colors in the content file, the Planned Colors for the product page, and 
the differences between them. 

The Page Color Error window contains the following information: 

• Which side of the layout contains the error. 

• Any extra colors in the planned colors. 

• Which colors the planned colors are missing. 

• Which colors are contained in the content file for that side of the layout. 

• The planned colors for that side of the layout. 

• The “JDF Color Mapping” button for the layout side(s) on which the page appears will be active. (There 
are some rare circumstances where both buttons could be active.) 
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Resolving Color Mapping problems 

There are several ways the differences between the planned colors and the content colors can be resolved. 
These resolutions all happen in the JDF Color Mapping window, with the exception of editing the planned colors 
for a page, which is done in the “Planned Colors” column. 

There are two ways to access the JDF Color Mapping window. One is through the JDF Color Mapping properties 
fields in the Layout Properties. The other is by clicking JDF Color Mapping (Front or Back) in the Page Color 
Error window. 

The JDF Color Mapping window contains the resources to resolve any color-mapping issues. To access it, click 

 in the Value column next to JDF Color Mapping (Front or Back) in the Properties Editor. 

Rule Sets 

You can use rule sets to configure Color Remapping and Overprint/Knockout settings once so they can then be 
applied to multiple layouts. The Default Rule Set (Front) and Default Rule Set (Back) settings are automatically 
applied to the respective sides of each layout, but you can create custom Rule Sets as well. 

The JDF Color Mapping window shows all planned colors and file colors in the entire project, and the Default 
Rule Sets have those colors mapped to “Print Separately,” with Overprint/Knockout set to “Unchanged.” 

You can edit these settings, and any changes made are applied to all layouts that use that rule set. Using the 
default rule sets makes sense for projects that have the same colors on all layouts, but because different layouts 
may contain different sets of colors, creating custom rule sets allows you to configure the settings separately. 

For example, a book may have a cover that prints CMYK while the text is black plus a spot color. If the content 
file for the cover contains spot colors that should be converted to process builds, you can create a custom rule 
set that has those spot colors converted to process and have a separate rule set for the text layouts that have 
cyan, magenta, and yellow set to “Do Not Print” and black and the spot color set to “Print Separately.”) 

To create a custom rule set, click New next to the Rule Set Name pull-down menu. A new, editable Rule Set 
Name appears: “Color Remapping 2.” Change the “Mapped To” and “Overprint/Knockout” settings as required, 
and then click Apply. 
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If you wish to use this same rule set on another layout, select the layout and then select the new rule set in the 
JDF Color Mapping (Front) or (Back) properties. Alternatively, you can open the JDF Color Mapping window 
for a layout and select the custom rule set from the Rule Set Name menu. 

“Mapped To” options 

Clicking the row of a file color in the “Mapped To” column opens a menu with all colors in the project plus three 
other options: 

• Convert to Process: The spot color is converted to the process build that is defined in the content file. 

• Print Separately: The color will print on its own plate. 

• Do Not Print: The color will not print. 

If another file color or planned color is selected from the “Mapped To” menu, the spot color will print on the same 
plate as the selected color. 

Clicking the row of a process color in the “Mapped To” column pulls down a menu with only two options: Print 
Separately, and Do Not Print. This is because a process color cannot be mapped to another color, so it will 
either print separately, or will not need to be printed, depending on the job. 

Print Separately 

If all colors need to be printed separately, it is possible to click All Spots Separately in the JDF Color Mapping 
window. 

A warning will now appear in the top part of the window: 

“Check that the number of plates to be out put matches the number of Planned Colors.” 

This warning has appeared because the number of plates will now be equal to the number of colors in the file, 
but the number of planned colors is still only four (CMYK). 

Convert to Process 

You can map individual spot colors to “Convert To Process,” or click All Spots as Process to change all of the 
spot colors to process color builds as defined in the content file. In the example below, all the colors on this side 
of the layout are process. 

If the planned colors are set to CMYK, once all of the spot colors are converted to process, if you click “Apply,” 
the warning in the “Status” column of the Run List should change to a green checkmark. Since all the colors—
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process and spot—are now treated as process, the Planned Colors (CMYK) match the file colors, and the 
warning is removed. 

Note Side Two still has a “Colors” status error. This is because the spot colors on side two of the layout are 
different from those on side one, and the sides are handled independently. 

Mapping one color to another 

In the JDF Color Mapping window, clicking in the “Mapped To” column opens a menu with all colors on that side 
of the layout. 

When a file color or planned color is mapped to another color, all elements that use the original color will print on 
the same plate as the “Mapped To” color. 

In the example below, the spot color PANTONE Green C is being mapped to the process color Cyan, so all 
PANTONE Green C elements on that side of the layout will print on the Cyan plate. 

 

Here is the same JDF Color Mapping window with the three spot colors remapped. 

• PANTONE Green C is remapped to the process color Cyan 

• PANTONE Orange 021 is remapped to the process color Yellow 

• PANTONE Purple is remapped to the process color Magenta 

This remapping, together with having the same planned colors as file colors, will resolve the Color error in the 
“Status” Column of Run List. 



The JDF Color Mapping Option | User Guide ⚫ 199 

 

 

 

Planned colors on multiple selected rows 

You can change the planned colors for all the rows in the Run List when only one row is selected, or when all 
rows or no rows are selected. To do this, click the gear icon in the “Planned Colors” header. When you do, a 
window opens allowing you to change all rows in the list. 

Take note of the word “(All)” in the window title. 

 

If multiple rows are selected, either contiguous or non-contiguous, clicking the gear icon in the Planned Colors 
header opens a similar window. The difference here is that only the selected rows will be changed. 

Take note of the word “(Selected)” in the window title. 

 

Color mapping and JDF export 

The PDF Export error 

Since JDF Color Mapping works only with JDF export, if “Imposed PDF” is selected in the Export window, a 
warning will display. 

The warning reads 

“Any JDF Color Mapping that has been defined for this project will be ignored for PDF Output. JDF Color 
Mapping is supported only in JDF output.” 

JDF export color options 
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Under the “Colors To Output” section of the Export window, the “Colors To Output” and “Export Rules” options 
are available. 

The “Export Rules” option allows three different settings: 

• Use Layout Settings—the default 

• Ignore Color Mapping—When this option is selected, colors are output as they are defined in the 
content file(s). 

• All to Process—All colors are converted to the process builds defined in the PDF content files. 

Note This overrides color-mapping settings only for this export operation, but does not change the 
JDF Color Mapping for the project.) 

 

The “Colors To Output” section allows three different output options. If the box is: 

• Checked—Color exists on all layouts. All plates shall be output for that color. 

• Unchecked—Color exists on no layouts. No plates shall be output for that color. 

• Gray—Color exists on some layouts. Plates shall be output only for those layouts on which the color 
exists. 

Trying to export the JDF when the JDF Color Mapping profile does not contain all colors that are in the content 
files(s) results in this warning: 

 

If No is clicked, the warning is dismissed and you return to the Export window. 

If Yes is clicked, the files are exported and the colors that are not handled by the profile are processed according 
to default settings: 

• The default “Map To” setting is “Print Separately.” 

• The default “Overprint/Knockout” setting is “Unchanged.” 

Trying to export the JDF when the JDF Color Mapping profile contains colors that do not exist in the content 
file(s) results in this warning: 

 

• If No is clicked, the warning is dismissed and you return to the Export window. 

• If Yes is clicked, the files are exported and, if you have not overridden the Colors check box settings, 
only plates that contain content will be output. 
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User Preferences Overview 

Some of the Metrix User Preferences are Global, which apply to all workstations; these are stored in the 
database. Other User Preferences are specific to each Metrix user, and some are specific to the computer on 
which Metrix is installed. These preferences are stored in a file named Metrix 2022.1.Properties, which is 
created at the root level of the User folder when you install Metrix.  

• For Windows, the User folder is found in: 

DriveLetter:\Documents and Settings\UserName 

• For Mac, the User folder is found in: 

MacHardDiskName > Users > UserName 

Global search for the User Preferences: 

• Search: Enter a search term into the Search field, and each tab where the search term can be found 
will appear in bold. When you select the tab, only the fields that contain the search term will be 
available. Click the red X to remove the search filter and view all the fields in the selected tab.  

 

 

Each tab in the Preferences window contains the following functionality: 

• Reset Panel To Defaults: Click the Reset Panel to Defaults button to clear your changes and revert 
the tab back to the default options.  

• Tooltips: Hover the mouse cursor over the name of the User Preference to view a tooltip regarding its 
functionality. 
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• Help: Click the question mark icon next to the appropriate field to view a pop-up window containing 
additional helpful information about the User Preference.  
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Auto Layout Preferences 

• To view the Auto Layout preferences, select Settings > User Preferences...and then click Auto 
Layout. 

 

Auto Layout Preferences 

Field Explanation 

Target Layouts The minimum number of successful layouts Metrix will calculate 
for a specific ratio of products before trying a better ratio. For 
more information, see Target Layouts and Time Out.  

Time Out (seconds) The longest amount of time Metrix will work on calculating layouts 
before timing out. 

Increase this number if you want to give the Metrix engine more 
calculation time. For more information, see Target Layouts and 
Time Out. 

Enable Blocks Algorithm True/ False 

Allows you to enable the blocks algorithm feature, which 
organizes the layout into blocks of similar size products. Disable 
the feature to group larger products at the bottom of the sheet. 
Blocks Algorithm works with Classic and Same Size but has no 
effect with Media Optimization or Display Graphics. 

Placement Origin Left / Right 

Metrix begins placing products on this edge of the sheet. 
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Work And Turn Placement 
Origin 

Center / Outside Edge 

Metrix begins placing products at this point on a work and turn 
layout. 

Auto Center Horizontally True / False 

Centers the entire layout horizontally on the sheet. Setting this 
preference to True automatically centers all layouts horizontally. 
When this preference is set to False, you can still center layouts 
horizontally by the operator as needed. 

Auto Center Vertically True / False 

When set to True this centers the entire layout vertically on the 
sheet. When this preference is set to False, the operator can still 
center layouts vertically as needed. 

Auto Align Outside Cuts True / False 

Aligns the outside (horizontal and vertical) cuts of products on 
layouts, leaving any extra space in the interior of the layout. 

 

Gap Between Placement 
Groups 

The amount of space to insert between placement groups 
originating from one or more product groups. 
Flat/Folded Work chapter has complete details on this. You can 
also see Assigning product groups. 
 

 
 

Product Group Placement Rows/ Columns/ Sheet Usage 
Placement of product groups on the sheet. You can arrange the 
groups in Rows from bottom to top, Columns from left to right, or 
Metrix will choose the most efficient way if you select Sheet 
Usage.  

AutoPlan Sort Order Highest Cost First / Project Component Order / Sheet Area 
Use 
Choose how the Auto Plan option will sort layouts. You can sort 
your layouts by the highest cost first, by project component size 
starting with the largest component, or by sheet area use starting 
with the highest sheet area use. This setting affects the order in 
which the layouts appear in the Layout Editor.  

Auto Expand/Contract Face 
and Non-jog trim to Fit Sheet 

True/ False 
Automatically expands or contracts the face and non-jog trim to fit 
the selected sheet size.  

Allow a Component to be on 
Multiple Layouts 

True/ False 
Allows the same component to be manually placed on multiple 
layouts.  
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How to Handle Die-cut Layouts 
Without a Standard 

Error/ Warning/ Ignore 
Choose how Metrix will respond if you use the Auto Layout 
option on a die-cut product that does not have a standard. You 
can display an error message, a warning message, or ignore the 
setup and create a layout without a message appearing first.  

Target Layouts and Time Out 

Target Layouts 

If you do a lot of complex layouts, you may want to increase the number of Target Layouts. Otherwise, the 
default (2) is usually enough. 

Time Out 

The minimum Time Out is 10 seconds. Adjust this value upwards to allow Metrix to calculate for a longer period. 

For more information, see The Metrix User Interface chapter and Using the Metrix Auto Layout Engine.  

Note Stop does not mean cancel – it only means that Metrix will stop calculating and present the solutions 
already found. 

Automation Preferences 

• To view the Automation Preferences, select Settings > User Preferences... and then click 
Automation. 

 

Automation Preferences 



208 ⚫ Productivity Suite | User Guide 

 

 

Preference Explanation 

SMTP Host Enter the address of the SMTP account. The address is site 
specific.  

SMTP Port Enter the port number of the SMTP account. Examples of 
SMTP ports include 587 (most common), 456, 25, and 2525.  

Note    If you do not know the port number, then 
contact your IT department or email hosting 
service.  

SMTP Account Enter the name of the SMTP account.  

Password Enter the password for the SMTP account.  

Email From Address Enter the email address Metrix uses as the from address 
when sending emails to the Administrator and Planners.  

Automatic Restart Day Sunday / Monday / Tuesday / Wednesday/ Thursday / 
Friday/ Saturday 

Select the day(s) of the week for an automatic restart of the 
Automation Server.  

Note    Auto restart allows you to configure the 
Automation Server to safely restart without 
losing any jobs that are currently running or 
in the queue.   

Auto Restart Hour (0-23) Enter the hour to restart the Automation Server.  

Note    You can only enter a whole number (i.e., 1, 
2, 3, etc.) into the Auto Restart Hour field. 
0 represents 12:00AM and 23 represents 
11:00PM.  

 

Notes Automation Preferences are global and changes will be applied to all workstations.  

 For more information on the Automation Preferences, see The Metrix Automation email process.  

  



Metrix User Preferences | User Guide ⚫ 209 

 

 

Content Handling Preferences 

• To view the Content Handling preferences, select Settings > User Preferences... and then click 
Content Handling. 

 

Content Handling Preferences 

Preference Explanation 

Default Content Folder The default location for PDF content files for products 
imported via CSV and MXML and in the user interface. 
Applies to this Metrix client only. 

PDF Import Method Speed Optimized / Size Optimized 

Use the default (Speed Optimized) unless you experience 
difficulties assigning PDF content and/or exporting an 
imposed PDF of large or memory-intensive PDF files. 

Enable Shared Cache True / False 

Note: Metrix 22.1 allows you to place the PreviewCache 
folder on a shared network drive so it can be accessed by 
multiple installations of Metrix. This allows all users to access 
previews more quickly. 

Shared Cache Folder Click Browse… and navigate to the shared PreviewCache 
folder, select it, and then click Open. 

Note: The change will be applied to all workstations.  

Preview Quality/Speed This slider controls the quality of the Content Previews 
images. The farther left the slider’s position is, the lower the 
quality of the displayed image, but the faster the image 
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processing. The farther right the slider’s position is, the 
higher the quality of the displayed image, but the image 
processing will be slower. For more information, see Setting 
Content Handling preferences. 

Content Positioning Rule Match PDF Page Trimbox Size and Center 

The content file contains a trimbox for each page that 
matches precisely the Metrix page size. 

Center Each PDF Page Trimbox 

The content file contains a trimbox for each page that does 
not necessarily match precisely the Metrix page size. Metrix 
centers the PDF page trimbox on the Metrix page, and crops 
any PDF content falling outside Metrix page size plus bleed. 

Center Each PDF Page 

The content file does not necessarily contain a trimbox for 
each page. Metrix centers the PDF page on the Metrix page, 
and crops any PDF content falling outside Metrix page size 
plus bleed. 

You can override this default at the content file level. 

Default Run List Filename (Unassigned) / (Blank) 

Sets the default filename for product pages that do not have 
PDF content to (Unassigned) or (Blank), depending on the 
setting. 

Show Page Identifier True / False 
The page identifier—page number of folio—will display on 
the Content Preview image (True), or not (False), depending 
on the setting.  

Show Jog, Spine, Lay and Folds True / False 

Jog, spine, lay, and fold marks display on the Content 
Preview image (True), or not (False), depending on the 
setting. 

 

Default Show Previews in Exported 
Layout Images  

True / False 

Default setting for whether or not to show preview images for 
MXML output when using the ExportLayoutImages 
command. Used only when an Automation process reads 
an MXML command file that specifies ExportLayoutImages. 
This setting is then used as the default value if the MXML file 
does not contain a value for that field. 

Irregular Shapes using PDF Boxes True / False 

Select True to be able to create Irregular Shape products 
using the rectangular Media Box or Trim Box in content files 
that do not contain any contour lines.  

No Ink is Blank Page True / False 

When set to True, a page side that is Unassigned with no 
planned colors is considered blank and Auto Plan or Auto 
Layout considers one-sided layouts to be valid. When set to 
False, the page side is not considered blank.  

Note     If a page side filename is set to Blank in the 
Run List, then it is considered blank even if 
there are planned colors on the page. If the 
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page side has content assigned, then it is 
never considered blank even if there are no 
planned colors on the page.  

Allow PDF with OCG/Layers to be 
Exported 

True / False 

If set to True, you can export PDF content files with OCG 
(Optional Content Groups) / Layers as flattened Imposed 
PDF files. 

If set to False, the PDF content files’ layers must be resolved 
before importing into Metrix. 

This setting does not apply to JDF export, because no 
processing is done on the content files. 

How to Handle PDFs with Rotated 
Pages 

Error / Warning / Ignore 

This setting governs how Metrix handles PDF files with 
rotated pages on import. 

If you select Error, an error message appears stating, “The 
PDF content file contains page rotations that may cause 
unexpected results. (file:<path and file name>),” and the 
content file will not be imported. 

If you select Warning, a warning message appears, same as 
for Error but with a warning symbol, and the content file is 
imported. 

If you select Ignore, no message appears and the content 
file is imported. 

How to Handle Page Size Error Warning/ Error 

This setting lets you choose how Metrix will handle a product 
whose page size and content file page size do not match.  

If you select Warning, the yellow Warning icon will appear in 
the status area and you can either address the issue or 
ignore it.  

If you select Error, the red Error icon will appear in the 
status area and you will be unable to export the project.  

How to Handle Unassigned Content 
when Exporting 

This setting governs how Metrix handles products that do not 
have content assigned on export. 

If you select Error, the result depends on the current user 
role permissions. If your role has permission to export with 
errors, a warning message appears stating, “One or more 
products has unassigned content. Exporting PDF Imposition 
is not recommended. Continue to export?” If your user role 
does not have permission to export with errors, an error 
message appears stating, “This action is not authorized for 
your role. User: (username) Role: (user role) One or more 
products has unassigned content. Exporting PDF Imposition 
is not permitted.” 

If you select Warning, the warning message appears 
regardless of the current user role permissions. 

If you select Ignore, no messages appear and the project is 
exported. 

For more information, see Exporting with errors.  

Minimal Run List for JDF Imposition Drops unused pages from JDF export. This specifically 
applies to inactive components and back sides of one-sided 
products. 

Enable JDF Color Mapping True / False 

Turns on the JDF Color Mapping feature (True), or not 
(False), depending on the setting. For more information on 
JDF Color Mapping, see “JDF Color Mapping” below. 
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Setting Content Handling preferences 

Select User Preferences from the Settings menu, and then click Content Handling in the User Preferences 
window, to see a slider bar for setting the display quality of your previews to Lower/Faster or Higher/ Slower. 
“Lower/Faster” means the resolution is lower, but the generation is faster. “Higher/Slower” means the resolution 
is higher, but the generation of the previews is slower. 

If you set the Quality/Speed bar in the Content Handling window to Lower/ Faster, you should see an image like 
that below on the left. If you set the bar to the Higher/Slower setting, you should see an image like that below on 
the right. 

 

As Metrix works to rasterize the previews, you may see a progress bar appear to the right of the hot folder status 
indicator in the lower, left corner of your Metrix window. How long Metrix takes to rasterize and display the 
previews depends on the Quality/Speed settings in the Content Handling window, the size and/or complexity of 
file being imported, the speed of CPU where Metrix is running, and whether the files are on a local drive or being 
accessed over a network. 

Another option you have in the Content Handling window is to show or not show the page identifier in your 
product or layout display. If you select False on the Show Page Identifier menu, the identifiers are not displayed. 

Here is an example of how the display either shows or hides the page identifier, depending on whether you set 
the menu to True or False in the Content Previews window. 
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Using the Content Handling window, you can also display or hide the jog, spine, lay and folds indicators on a 
layout. Selecting True sets them to display. Selecting False hides them. 

Here is an example of how the display either shows or hides the jog, spine, lay and folds, depending on whether 
you set the menu to True or False in the Content Previews window. 

 

Note For a list of options available with this feature, see Content Handling Preferences.  

Problems with content files 

When there is a problem with your content files, the preview will not be displayed. Possible potential problems 
include: 

• Files that do not match the product specifications 

• Files that cannot be found 

• Files that are corrupted 

When any of these occur, a red checkerboard pattern, like the following, will be displayed. 
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Minimal Run List 

The Minimal Run List for JDF Imposition feature drops unused pages from JDF export. This specifically 
applies to inactive components and back sides of one-sided products. In previous versions of Metrix, the Minimal 
Run List was configured by adding a line to the metrix.properties file. In Metrix 22.1, you can enable Minimal 
Run List directly in the User Preferences on the Content Handling window. 

 

The JDF Color Mapping user preference 

JDF Color Mapping can be turned on or off in the Content Handling node of the User Preferences window. Select 
User Preferences from the Settings menu, and then click Content Handling. On the right, from the “Enable JDF 
Color Mapping” menu, select True to turn JDF Color Mapping on, and False to turn it off. The default setting is 
False. 
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General Preferences 

• To view your General preferences, select Settings > User Preferences... and then click General. 

 

General Preferences 

Preference Explanation 

Date Format Select your preferred date format from the drop-down menu. 
Changes to the format take effect when you restart Metrix. Dates 
already entered in the Properties Editor will be updated to the new 
format on restart. This data is only used in those fields in the 
Properties Editor requiring a date format. Dates typed in text-
formatted fields will not be affected (e.g., the Due Date field). 

YYYY-MM-DD (2014-01-17) 

MM/DD/YYY (01/17/2014) 

MM/DD/YY (01/17/14) 

M/D/YY (1/17/14) 

DD/MM/YYYY (17/01/2014) 

DD/MM/YY (17/01/14) 

D/M/YY (17/1/14) 

Display Numbers and 
Currency using System 
Locale 

True / False 

This setting allows Metrix to display numbers and currency based on 
the OS System Locale when the selected language is not supported 
by Metrix. To enable the setting, set to True and restart the program.   
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Language English / German / Spanish / French/ Italian/ Simplified Chinese 
/ Swedish/ Japanese 

Company Name Enter the company name to appear on the Metrix reports. 

MIS Workflow (None) / Select from List 

Choose your MIS or choose (None) or (Other) if it isn’t listed. This 
change will take effect the next time you start Metrix. 

Prepress Workflow Generic / Select from List 

Choose your prepress workflow or choose Generic if it isn’t listed. 
The change will take effect the next time you start Metrix. See the 
relevant appendix for your chosen workflow at the end of this guide 
for information on each workflow. 

Import Project Preferences 

• To view the Import Project preferences, select Settings > User Preferences... and then click Import 
Project. 

 

Import Project Preferences 

Preference Explanation 

Add Default Bleeds True / False 

Adds the default bleed amount to all imported products 
when bleed has not been specified. 
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The default bleed amount is specified in the Conventions 
node of the Metrix Database window. This setting will 
overwrite bleed amounts specified in the imported data 
when using Import Project and will not overwrite bleed 
amounts when using Import Products. 

Add Default Jog and Spine Trim 
(JDF Only) 

True / False 

Adds the default jog and spine trim amounts to all products 
imported via JDF, when jog and/or spine trim have not been 
specified. 

Notes The jog and spine trim amounts added are 
relative to the binding machine specified. 
This setting will overwrite jog and spine trim 
amounts specified in the imported data 
when using Import Project and will not 
overwrite jog and spine trim amounts when 
using Import Products. 

Default CSV Delimiter Allows you to set the comma or the semicolon for the default 
delimiter in imported CSV files. 

Hot Folder Preferences 

• To view the Hot Folder preferences, select Settings > User Preferences... and then click Hot Folder. 

 

Hot Folder Preferences 

Preference Explanation 
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Hot Folder 

 

The name and location of the Hot Folder for imported JDF 
and MXML projects. 

Run Hot Folder True / False 

Starts the hot folder when this Metrix client is launched. 

Copy to Shared Folder The name and location of the shared working folder for 
imported JDF and MXML projects. When a JDF or MXML 
project is imported via hot folder, the network hot folder 
location may only be available temporarily, so Metrix copies 
the incoming JDF or MXML to the shared folder. Mostly 
used in a complete JDF environment – that is, where Metrix 
projects are imported as JDF and are then exported as 
Complete JDF to the prepress system. 

 

Notes The hot folder should be accessible to MIS and Metrix operators. The shared folder is where Metrix 
copies the incoming JDF. 

 Both folders are in the Program Data folder on Windows. 

Layout View/Display Preferences 

• To view the Layout View preferences, select Settings > User Preferences... and then click Layout 
View/Display. 

 

Layout View/Display Preferences 

Preference Explanation 
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Display Digits Sets the number of digits displayed after the decimal point. 

Show Folio / Page Number True / False 

When you select Folio as the Bold Page ID, the Page 
Number is displayed. When you select Page Number as the 
Bold Page ID, the Folio is displayed. 

 

Show Fold Page True / False 

Displays the fold page number. 

 

Show Page Colors True / False 

Displays the page colors (inks). 

 

Layout Show Grain True / False 

Displays the grain direction indicator. 

Grain can be Vertical, Horizontal, Either (Instances of 
component can face either direction), or Either-All Same 
(Instances of component can face either direction, but all 
instances of the component must face the same direction). 

 

Show Page Size True / False 

Displays the page size. 
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Show Page Shingling True / False 

Displays the page shingling amount. 

 

Drag and Snap Sensitivity A slide bar allows you to adjust the sensitivity for 
components snapping into place relative to other 
components on the layout. A sensitivity of 1 requires the 
closest proximity, while 20 allows the farthest distance. The 
default of 10 will probably suit most. 

Flat and Folded Product Pages Bound Style / Ganging Style 

Set flat and folded (not bound) products to “ganging style” 
or “bound style” for display in the View Area and project 
reports Bound products are always displayed as bound 
style. 
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Bound Style Preferences 

• To view the Bound Style preferences, select Settings > User Preferences.... and then click Bound 
Style. 
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Bound style 

 

Bound Style Preferences 

Preference Explanation 

Bold Page ID Folio / Page Number 

For bound work, it indicates which page identifier to make 
larger and bold. 

 

Relative Font Size % – Bold Page ID For bound product components, it controls the relative font 
size for the display of the Bold Page ID. The font size is 
calculated as a percentage of the smallest page dimension. 
For example, 20% of 8.5" when the Page Size is 8.5x11". 

When the text won’t fit at the selected Font Size 
percentage, the font size will be reduced so the text will fit. 

Outline Bold Page ID True / False 

For bound product components, this option creates an 
outline around the page ID. This can make the page ID 
easier to read on dark backgrounds. 
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Relative Font Size % – Other For bound product components, this controls the relative 
font size for the display of all other selected properties. The 
font size is calculated as a percentage of the smallest page 
dimension. For example, 20% of 8.5" when the Page Size is 
8.5x11". 

When the text won’t fit at the selected Font Size 
percentage, the font size will be reduced so the text will fit. 

Ganging Style Preferences 

• To view the Ganging Style preferences, select Settings > User Preferences... and then click Ganging 
Style. 
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Ganging style 

 

Note The above is an example of bound work component with all Page properties set to True. 

 

Ganging Style Preferences 

Preference Explanation 

Relative Font Size % – Name When you select ganging style for non-bound products, it 
controls the relative font size for the display of the product 
name. The font size is calculated as a percentage of the 
smallest page dimension. For example, 5% of 8.5" when 
the page size is 8.5x11". 

When the text won’t fit at the selected Font Size 
percentage, the font size will be reduced so the text will fit. 

Outline Name True / False 

When you select ganging style for non-bound products, this 
option creates an outline around the name of the product. 
This can make the product name easier to read on dark 
backgrounds. 
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Relative Font Size % – Other When you select ganging style for non-bound products, it 
controls the relative font size for the display of all other 
active properties. The font size is calculated as a 
percentage of the smallest page dimension. For example, 
5% of 8.5" when the Page Size is 8.5x11". 

When the text won’t fit at the selected Font Size 
percentage, the font size will be reduced so the text will fit.  

Marks Preferences 

• To view the Marks preferences, select Settings > User Preferences... and then click Marks. 

 

The Marks user preference allows you to choose whether marks sets will be: 

• Automatically applied to one or both sides of single-sided or double-sided layouts (respectively) 

• Left as set originally, or 

• If you should be prompted for a selection when necessary, and 

• What to do with missing file mark PDFs 

Marks Preferences 

Preference Explanation 

Placement Property During Copy 
and Paste 

Auto Set ('Front Only' for Single-Sided, Both for Double-
Sided Printing Methods) / Leave As Original / Prompt 
Whenever Relevant 

This determines the placement settings for marks that are 
copied and pasted.  

How to Handle Missing File Mark 
PDF 

Error / Warning / Ignore  

If you select Error, the result depends on the current user 
role permissions.  

• If your role has permission to export with errors, a 
warning message appears stating, “One or more 
products or layouts has an error. Exporting is not 
recommended. Continue to export?”  

• If your user role does not have permission to export with 
errors, an error message appears stating, “This action is 
not authorized for your role. User: (username) Role: 
(user role) One or more products or layouts has an 
error. Exporting PDF Imposition is not permitted.” 
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If you select Warning, the warning message appears 
regardless of the current user role permissions. 

If you select Ignore, no messages appear and the project is 
exported. 

Note: For more information, see Exporting with errors.  

How to Handle No Space on Sheet 
for Cutter Alignment Marks 

Error/ Warning/ Ignore 

Choose how Metrix will respond if you use Auto Layout and 
there is no space on the sheet for cutter alignment marks. 
You can display an error message, a warning message, or 
ignore the setup and create a layout without a message 
appearing first. 

Bundle Separator Mark Size The thickness in points of the mark that separates different 
bundles that appear on the same sheet.  

Notifications Preferences 

• To view the Notifications preference, select Settings > User Preferences.... and then click 
Notifications. 

 

Notifications Preferences 

Preference Explanation 

Foreground Color 

 Clicking  allows you to change the foreground color (color of 
the text) in non-modal notification boxes. The default is set for white 
text. Here is an example. 
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Background Color 
Clicking  allows you to change the background color (color 
of the box) in non-modal notification boxes. The default is set for 
black. Here are examples of the default, and a box with the 
background set for red. 

 

Maximum % Opacity Controls how much of the Metrix interface will show through the 
notification box. Lower opacity=more showing through. Higher 
opacity=less showing through. The opacity of the box will also 
influence how easily the text can be read. A sample will be 
displayed each time you change a setting. 

Project Preferences 

• To view your Project preferences, select Settings > User Preferences....and then click Project. 

 

Project Preferences 

Preference Explanation 
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Default Project Type Production/ Estimate / Template 

The default project type for all new projects. The project type is a tag 
only. 

You can override this default at the project level. 

Determine Number Out Auto Calculate / User Define 

The default method for determining the number of product instances 
placed onto the layout. 

You can override this default at the project level. 

Show Production Costs True / False 

Displays the layout cost and production time calculated by Metrix, 
based on the cost-associated properties of the selected press and 
stock/sheet size. 

Set New Product Display 
Color 

Individually / By Product Group 

When you add new products to a Metrix project where product 
groups are used, you can set the display color as unique for each 
product or unique for each product group. 

You can override this default by selecting Project > Set All Product 
Display Colors. 

Default Product Grain 

 

Horizontal / Vertical / Either / Either-All Same 

Allows you to set the default grain direction for new products. 

Default Spine Side Left / Right 

The default spine side for new products. 

You can override this default at the project level. 

Calculate Side-by-Side 
Bound Cover Spine 

Manual 

No automatic calculation of side-by-side (perfect bound) cover spine 
– the spine amount will be entered manually for each product. 

You can override this default. 

Auto, No Rounding 

The spine amount for side-by-side covers is calculated 
automatically, without any rounding. 

You can override this default. 

Auto, Round Up to Next: 0.5 mm or 0.03125” 

The spine amount for side-by-side covers is calculated 
automatically, rounding up to the nearest 0.5 mm or 0.03125”. 

You can override this default. 

Auto, Round to Nearest: 0.5mm or 0.03125” 

The spine amount for side-by-side covers is calculated 
automatically, rounding up or down to the nearest 0.5 mm or 
0.03215”. 

Auto, Round Up to Next: 1 mm or 0.0625” 

The spine amount for side-by-side covers is calculated 
automatically, rounding up to the nearest 1 mm or 0.0625”. 

You can override this default. 

Auto, Round to Nearest: 1 mm or 0.0625” 

The spine amount for side-by-side covers is calculated 
automatically, rounding up or down to the nearest 1 mm or 0.0625”. 

You can override this default. 

Default Stop Bleeds 
Overlapping 

True / False 

Allows you to stop bleeds from overlapping (True) or not (False) as 
a default for Metrix projects. The selected default is applied to all 
new projects. 

Add Product Clones to 
Layout 

True / False 
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This setting lets you choose whether or not clones of a product 
assigned to a layout will be placed on the existing layout. The default 
setting is True. Set to False if you do not want clones of a product to 
be assigned to a layout.  

Transparency Tolerance The Transparency Tolerance is used in conjunction with the 
transparent color of a thumbnail Image, a low-resolution JPG, PNG, 
or GIF used to assist in the nesting of irregularly shaped objects. 
This preference is the default range of red, green, and blue (RGB) 
values, either side of the selected transparent color’s values, to be 
rendered transparent for the thumbnail image. Pure white pixel 
values are R=255, G=255, B=255, but the thumbnail image 
background may not be pure white. With a tolerance of =/- 20, all 
pixels within the following range are rendered transparent: R=215-
255, G=215-255, B=215-255. 

You can override this default at the product page level. 

Substitute Metrix Standard True / False 

Automatically applies matching Metrix standards to new layouts. 
Applicable to imported projects as well as those generated within 
Metrix. 

Project Reports Preference 

• To view the Project Reports preference, select Settings > User Preferences... and then click Project 
Reports. 

 

Project Reports Preferences 
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Preference Explanation 

Layout Diagram Page Percentage This determines what percentage of the page the layout 
diagrams use when printing project reports. 
 

Note Selecting a percentage on the slider bar changes the size of the diagram on the report page. For 
example, if the slider bar is set for 50%, Metrix sizes the diagram to 50% of the report page. If there is 
not enough room for the diagram on the page, together with the other elements on the page, Metrix 
moves the diagram to the next page. 

Shingling Preferences 

• To view the Shingling preferences, select Settings > User Preferences... and then click Shingling. 

 

Shingling Preferences 

Preference Explanation 

Apply Auto Shingling True / False 

Automatically applies shingling to each set of 4 pages based on the 
Inner % specified, the set’s placement relative to the spine, the total 
number of 4-page sets, and the stock thickness(es) used. This 
preference is a default only and can be overridden for specific products 
by selecting the Product node and changing the Shingling property. 

Note Metrix applies shingling (automatic and/or manual) to the 
following Export formats: 

 —Imposed PDF 
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 —JDF Imposition 

 —Complete JDF 

 

Default Shingling Method Move / Scale 

Metrix shingles the pages either by moving them, or by scaling them. 

Default Inner % 0 – 300 

The default percentage of the total calculated shingling amount to be 
applied to the center (inner) 4-page set of the product. For more 
information, see Shingling Calculations – Inner %. These are defaults 
only. You can change shingling values on a Product or Page level. 

Shingle Trim Marks True / False 

Trim marks either move with the shingled pages (True) or they do not 
move (False). 

Shingling calculations – Inner % 

Note Metrix applies the default shingling parameters in the User Preferences window to all new projects. You 
can use the Shingling (Creep) property in the Properties Editor to change the parameters in an open 
project (as in the following examples). 

 

A few examples will illustrate how the Inner % value of Metrix shingling works. 

Example 1: 100% inner 

We have inserted 100% of the total shingling amount calculated for this product (.061”) on the innermost pages, 
feathering out to 0” for the outermost pages. 

 

Example 2: 80% inner 

We have inserted +80% of the total shingling amount calculated for this product (.0488”) on the innermost pages, 
feathering out to –20% (–.0122) for the outermost pages. 

Note We are changing these settings in an open project using the Shingling (Creep) property in the 
Properties Editor. If you want these parameters to apply to all new projects, you can set them in the 
User Preferences window (Settings menu). 
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Press Properties and Gutters 

Note Press guide allowance refers to the functionality previously called vertical press gutters.  

The press guide allowance refers to the press wheel allowance, which is a reserved area on the sheet. Metrix 
22.1 contains enhancements to handling press guide allowances, including the ability to configure gutters directly 
in the Database window. 

Setting up gutters 

Note The maximum number of press guide allowances for each press is 5. 

1. Select Equipment > Presses and either select the existing press you want to edit or create a new 
press. 

Note The image below shows the Edit Press window. 

 

2. Scroll down to Press Guide Allowance and click . 

Note  is at the right edge of the field. The button does not appear until you click on it. 

3. On the Press Guide Allowance screen, click New and choose the appropriate value to Offset from 
Center. 

Note The Offset from Center value determines the position of the gutters. Entering a negative 
number places the center of the gutter that distance to the left of the center of the sheet; a 
positive number places the center of the gutter that distance to the right of the center of the 
sheet. Entering 0 places the gutter in the center of the sheet. 
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4. Enter the width of the press guide allowance in the Width column. 

5. Select other press guide allowance options: 

• Ignore Bound Products for Auto Layout: Select this option if you want Metrix to ignore press 
guide allowances for layouts that contain bound products. 

• Allow Finished Products in Press Guide Allowance: Select this option if you want to allow non-
ink areas (e.g., areas with negative bleeds) to intrude into the press guide allowances. 

• Mirror Press Guide Allowance for Sheetwise: Select this option when you are printing with a 
Sheetwise printing method with just one pass through the press, using the same lead edge. 

• Printing Methods: Select the appropriate printing method(s): 

• Perfected 

• One-sided 

• Sheetwise 

• Work And Turn 

• Work And Tumble 

6. When you are finished configuring the press guide allowances, click OK to exit the Gutters window. 

7. Click OK again to exit the Edit Press window. 

Notes To see the specifications for the press guide allowances you created, scroll horizontally across 
the Database screen. 

 For more information about setting up presses, see the Setup Guide. 

Grip Edge rules 

Each press in the Metrix database has properties for no image and no page areas. These areas are considered 
when Metrix calculates a layout. 
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• No Image: Metrix will not place any image into this area, but Negative Bleed area is allowed. The no 
image areas are measured from the edge of the sheet inward. 

• No Page: Metrix will not allow any product trim into this area but will allow product bleed. The no page 
areas are measured from the edge of the sheet inward. 

Example 

 

Using Custom Sheet Sizes 

If you assign products to a layout, using Assign Component(s) to Layout… from the Project menu, and the 
stocks for the products and layout do not match, a warning window informs you which layouts match the product 
stock, and which do not. But Metrix will still allow you to assign those products to the mismatched layout. 

If you then want to assign the same stock to the layout as the products, the sheet size of the current stock may 

not exist for the stock you are attempting to assign to the layout. If this is the case, you will see a warning icon  

or  to the right of the name of the stock in the Stock Selector window. 

If you click OK and continue to change the stock, the Properties Editor will now display the above warning icons 
for the stock and sheet size you have selected. 

Note The Status area warns “A temporary stock sheet is in use and will require saving before exporting.” 

When you click Saveto save the project, Metrix displays the window below, giving you the opportunity to cancel 
the action, or proceed with saving the temporary stock sheet. 

Note The window states “By default they will have a zero cost so they should later be edited as required.” 

When you click Yes, the warnings in the Properties Editor and Status area will be resolved. 

 

Though you could proceed to export the project at this point, the recommendation is to follow these steps. 

1. Close the project. 

Positive 

Bleed 1/8” 

No Image / 
No Page 
Area Negative 

Bleed ¾” 



 | User Guide ⚫ 237 

 

 

2. Open the Database (Settings menu). 

3. Select Stocks. 

4. Then, select the stock with the custom sheet size, and change the Cost / Thousand option. 

Note If you do not adjust the cost for this new sheet size, any calculations Metrix performs using this sheet 
size will be inaccurate. 

 

Setting Up Grainless Stocks 

Metrix 22.1 supports for stocks or substrates that have no grain. When products are planned on stock that has 
no grain, they are planned the same as when Either is selected.  

To set up and use stocks with no grain 

1. Select Database > Stocks.  

2. Click New in the upper portion of the window to create a new stock. 

3. From the No Grain menu, select True. 

Note In the New Product wizard, the Stock window now appears before the Grain screen. When you 
select a stock with no grain, Either is selected by default on the Stock Grain window and all other 
grain options are disabled. Grain is also uneditable in the Product Properties. 
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Using Optional Modules 
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The Auto Plan Module 

• The Auto Plan module is optional for Metrix. 

• Auto Plan automatically and dynamically determines how many layouts are required for the products in 
the project – flat products, folded products, bound products, and die-cut products. 

• Plans and simultaneously imposes across multiple press sheets and even multiple presses. 

• Auto Plan does not take product inks into consideration – products must be pre-sorted to ensure layouts 
contain only common ink sets (Page Colors). 

• Uses real costing data from the Metrix database. 

• Applies standards where appropriate. 

• Uses proprietary and sophisticated algorithms to consider dozens, hundreds, or even thousands of 
options to find the most cost-effective project solution. 

What does Auto Plan do? 

• Auto Plan analyzes all the products in your project and generates the layouts based on the lowest 
production cost and most efficient use of press time. 

• Auto Plan makes this calculation based on the cost and time entries in the Metrix database for the 
selected Press and Stock. These entries are explained in the MetrixSetup Guide. 

• The Auto Plan engine considers the selected Algorithm, type of press (digital or offset), make-ready 
time, number of plates, and passes through the press and so considers the inks (the Page Colors) of 
product pages (but not marks) when making its cost calculations. Thus, it is very important to correctly 
identify the product page colors, since this will significantly impact the solutions generated by Auto Plan, 
from a cost perspective. Auto Plan does not consider inks when determining which products go on 
which layouts – so products must be pre-sorted for common inks. 

• Auto Plan can generate all the layouts for one press and sheet size or can divide the work between two 
different presses and/or sheet sizes. 

• The layouts generated by Auto Plan are fully editable. 

• You can apply standards automatically to Auto Plan layouts, or you can apply them manually after the 
layouts are created. For more information, see Saving, Applying, and Updating Metrix Standards.  

Creating an Auto Plan project 

There is no difference between creating an auto plan project and any other, except that you don’t have to create 
the layouts and assign the products to them. 

You can create an auto plan project and populate it with products in any of the following ways: 

• Create a new Metrix project and add/clone the products you want to plan. 

• Create a new Metrix project and import JDF, MXML, or CSV products. 

• Import a JDF or MXML project that contains the products you want to plan. 

Keep in mind these constraints: 

• Auto Plan generates the layouts for one stock at a time. Though you could theoretically have a project 
containing many different stocks, it may be more efficient to pre-sort the products so each Auto Plan 
project contains a few stocks. After you experiment, you will find the best method for your specific 
production needs. 

• Auto Plan can generate all the layouts for one press and sheet size or can divide the work between two 
different presses and/or sheet sizes. Metrix tracks both cost and parallel printing time and allows you to 
sort the results by either. 

• Auto Plan uses the ink colors to calculate cost. However, it does not sort products according to colors 
used. Therefore, all the products in your project should be limited to the number of colors your press or 
presses can handle and share the color combinations being planned for. 
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• Metrix configured with the optional Capacity Plus module allows up to 2000 products per project, and up 
to 200 different products per layout. 

Using Auto Plan 

To run an auto plan 

1. Select products from the Project Explorer. 

2. Click Auto Plan to open the Auto Plan window and begin the planning process. 

The Auto Plan window is divided into five sections, each containing customizable preferences. Many of these 
sections can be opened and closed by clicking the heading. The customizable preferences can be configured 
through drop-down list, check-boxes, radio buttons, or number fields. The five sections include: 

• Main: This section contains the primary preferences for Auto Plan. These preferences are Stock, 
Components, and Algorithm.  

Notes You sort the Components field by All, Selected, Tagged, or Filtered. Metrix then tells you 
which components meet those criteria. This gives you precise control over which components it 
will add to layouts in the auto plan run. 

 You need to run the Auto Plan feature once for each stock in the project. 

 You can only select the Same Size option for Algorithm when the product size, bleed, and 
offcut are the same. Same Size then becomes available as a preference in the Algorithm drop-
down list. Using this option can greatly increase the speed of calculations. Otherwise, the only 
preferences are Automatic, Classic, Media Optimization, and Display Graphics. 

 The Media Optimization algorithm is designed to address customer concerns about inefficient 
use of expensive substrate media. This algorithm works well with offset or digital presses, and it 
is best suited for projects that contain 8 or fewer different products. Media Optimization 
places each component on only one layout, but unlike the Same Size or Classic algorithms, 
Media Optimization provides better results by using more complex product combinations to 
find the best optimization.  

 The Display Graphics algorithm is designed specifically for digital presses with expensive 
substrate media. This complex algorithm produces a dense imposition layout which helps to 
minimize media waste. Display Graphics may impose a component on multiple layouts, which 
can result in a greater number of layouts, but reduces calculation time by employing all CPU 
cores.   

 For more information on the Media Optimization and Display Graphics algorithms, please see 
EFI Metrix Tech Note-Media Optimization and Display Graphics.  

 The Automatic algorithm will assign the Digital Graphics algorithm when any digital press is 
selected in one of the Press fields. If you select a specific algorithm from the Algorithm drop-
down list, then Metrix will use that algorithm for both presses. For more information on how the 
Automatic algorithm makes a selection, please see EFI Metrix Tech Note-Auto Plan Dialog and 

"Automatic" Algorithm Selections. 

 Metrix will not include any digital cutting machines in the Cutting Machine lists that cannot 
accommodate the selected Stock, because digital cutting machines have minimum and 
maximum stock thickness parameters. If the selected stock is not supported by the digital 
cutting machine, the default cutting machine will be selected; if the default cutting machine is not 
compatible, then (None) will be selected.  

• Production 1: This section contains the preferences available for press one.  

• Production 2: This section contains the preferences available for press two.   

• Settings: This section contains the secondary preferences for Auto Plan.  

• Overrides: This section contains settings from the User Preferences that you can override for the 
current Auto Plan event. The override is temporary, so to make the changes permanent you need to 
update the appropriate preferences in the Preferences window.   

https://chilp.it/e4b7930
https://nam12.safelinks.protection.outlook.com/?url=https%3A%2F%2Fchilp.it%2Fcbb42e4&data=04%7C01%7CJames.Hall%40efi.com%7C38e8f1adddb04bee92d408d917081626%7C3fe4532499b245c397517034bae71475%7C0%7C0%7C637566145778819919%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C1000&sdata=EuYbtDyt06FW7WRRY5VK9Od4fmVkBw8Wo74MkkktV70%3D&reserved=0
https://nam12.safelinks.protection.outlook.com/?url=https%3A%2F%2Fchilp.it%2Fcbb42e4&data=04%7C01%7CJames.Hall%40efi.com%7C38e8f1adddb04bee92d408d917081626%7C3fe4532499b245c397517034bae71475%7C0%7C0%7C637566145778819919%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C1000&sdata=EuYbtDyt06FW7WRRY5VK9Od4fmVkBw8Wo74MkkktV70%3D&reserved=0
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3. Set the preferences for Auto Plan by following the descriptions in the following table, and then click OK. 

Auto Plan Properties 

Property Explanation 

Main 

Stock The stock to be used for this particular run of Auto Plan. 

Components All / Selected / Tagged / Filtered 

All = All components in the project that match the selected stock 

Selected = Only the selected components that match the selected 
stock 

Tagged = Only the tagged components that match the selected stock 

Filtered = Only the components that are filtered in the Component 
Picker that match the selected stock 

Algorithm Classic / Same Size / Media Optimization / Display Graphics / 
Automatic 

The kind of algorithm used in the Auto Plan process. 

The default selection is Classic. When the product size, bleed, and 
offcut are the same, Same Size becomes available. Media 
Optimization and Display Graphics algorithms are designed for 
digital presses using expensive substrate media. Selecting 
Automatic allows Metrix to determine which algorithm(s) will create 
the most cost-effective layouts by considering the types of products, 
their sizes, and the selected press(es) in the project. Different 
algorithms may be used for different product types.   

Production 1 

Press  List of presses in the Metrix database. 

Creates layouts for this press. 

Cutting Machine  (None) / (Default) / Specific** List of cutting machines in the Metrix 
database.  

Choose (None) to calculate no cutting cost.  

Choose (Default) to calculate cutting cost based on the cutting 
machine designated as the default for the selected press.  

Choose a specific cutting machine from the list to calculate costing 
cost based on that cutting machine.  

Printing Method  One-Sided / Sheetwise / Work And Turn / Perfected / Work And 
Tumble* 

The printing method to use for Production 1 layouts. 

Sheet  Drop-down menu with a list of available sheet sizes in the Metrix 
database compatible with Press 1. 

Use this sheet size for Production 1 layouts. 

Page To Bleed Gap  Use this value for page to bleed gap for Production 1 layouts. 

Auto  Click the check box to use the largest bleed amount to determine the 
Page to Bleed Gap for all instances on the Production 1 layout.  

Production 2 

Press  (None) / (Default) List of presses in the Metrix database 

Calculate layouts using a second press. The work may be divided 
between the two presses, or one press may provide a more cost-
effective solution. 

This may be a different press or the same press with different 
properties selected. 

Cutting Machine  (None) / (Default) / Specific** 
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List of cutting machines in the Metrix database 

Calculate layouts using a second cutting machine. The work may be 
divided between the two cutting machines, or one cutting machine 
may provide a more cost-effective solution. 

This may be a different cutting machine or the same cutting machine 
with different properties selected. 

Printing Method  Sheetwise / Work And Turn / Perfected / Work And Tumble* 

Use this printing method for Production 2 layouts. 

Sheet  List of sheet sizes in the Metrix database compatible with Press 2. 

Use this sheet size for Production 2 layouts. 

Page to Bleed Gap   Use this value for page to bleed gap for Production 2 layouts. 

Auto  Select the check box to use the largest bleed amount to determine 
the Page to Bleed Gap for all instances on the Production 2 layout.  

Settings 

Apply Standards Select the check box to automatically apply a matching standard if 
one is found for a layout created. 

Use Die-cutting Tool 
Geometry 

Select the check box to use the die-cutting tool geometry. Do not 
select the check box to use the nesting algorithm for irregular shapes 
when creating an auto layout using a die-cut product.  

Area to Start Tests (%) The minimum percentage Metrix will fill each sheet before running 
tests with the Auto Layout engine. Think of this parameter as a “start 
test threshold.” 

Each Time Out (seconds) The amount of time given to the Metrix Auto Layout engine to find a 
solution before it times out. When no solution is found, Metrix 
typically uses the entire amount specified. 

After each failure, Metrix takes one product out of the test set and 
tries again. Therefore, setting the Area to Start Tests too high will be 
counter-productive, particularly when Each Time Out is also set to a 
high number. When you begin working with Auto Plan, we suggest 
you use the default values for these parameters until you have a 
better understanding of how to modify them to get the desired results 
in the shortest amount of time. 

Total Time Out (minutes) The total amount of time given to the Metrix Auto Layout engine to 
find a solution before it times out.  

Overrides (used to change some settings for the current Auto Plan event only) 

Blocks Algorithm Select the check box to enable the blocks algorithm feature, which 
organizes the layout into blocks of similar size products. Disable the 
feature to group larger products at the bottom of the sheet. Blocks 
Algorithm works with Classic and Same Size but has no effect with 
Media Optimization or Display Graphics. 

Bundling The check box will selected by default if you have configured product 
bundling for the project. Click the check box to turn off bundling for 
this Auto Plan event only. You cannot turn on bundling with this 
override option. 

Bundles to Start on New 
Sheet 

Select the check box to make each new bundle populate on a new 
sheet.  

Separator Marks Select the check box to add separator marks that divide bundles that 
appear on the same sheet.  

This preference is not available if you select the Bundles Start on 
New Sheet check box.  
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Spacing The amount of space between product bleeds and the marks. 
Spacing is measured in the Measurement Units, inches or 
millimeters, you selected when setting up Metrix.  

Auto Center Horizontally Select the check box to automatically center the entire layout 
horizontally on the sheet. When this preference is not enabled, you 
can still center layouts horizontally by the operator as needed. 

Auto Center Vertically  False / Center On Sheet / Center In Imageable Area 

Set to Center On Sheet to center the entire layout vertically on the 
sheet. Set to Center In Imageable Area to center the entire layout 
vertically in the imageable area. When this preference is set to False, 
the layout will be positioned to the bottom of the sheet. 

Align Outside Cuts Select the check box to align the outside (horizontal and vertical) cuts 
of products on layouts, leaving any extra space in the interior of the 
layout. 

Layout Sort Order Highest Cost First / Project Component Order / Sheet Area Use / 
Bundle Order / Finishing Group 
Choose how the Auto Plan option will sort layouts. You can sort your 
layouts by the highest cost first, by project component size starting 
with the largest component, by sheet area use starting with the 
highest sheet area use, by bundle number starting with the first 
number, and by Finishing Groups starting with the first alphabetically. 
This setting affects the order in which the layouts appear in the 
Layout Editor. 

  

*Note When planning projects that contain both one-sided and two-sided products, Metrix will not place the 
one-sided products on a separate layout from the two-sided products. If you select One-Sided as the 
printing method for this type of project, there will be errors. You can resolve the errors by using Auto 
Production and selecting a compatible printing method for the layout. 

  When you are setting up the Auto Plan Production Properties with two presses, both presses must 
be set to One-Sided, or neither press must be set to One-Sided. 

  If you select One-Sided as the printing method for Press 1 (Printing Method 1), the printing method 
for Press 2 (Printing Method 2) will be restricted to One-Sided. 

  If you select any printing method other than One-Sided for Press 1 (Printing Method 1), the One-
Sided option will not be available for Press 2 (Printing Method 2). 

**Note Metrix will not include any digital cutting machines in the cutting machine list that cannot 
accommodate the selected Stock. If the selected stock is not supported by the digital cutting 
machine, the default cutting machine will be selected. If the default cutting machine is not compatible, 
then None will be selected.  

4. Auto Plan may jump immediately to the Auto Plan Selector window, when the solution is calculated. Or, 
for more complex projects, Auto Plan displays the Progress window below, and Stop becomes 
available. When you see that the total cost is not declining and are satisfied with the efficiency 
displayed, click Stop. 

Notes Stop means to stop calculating.  

 When using the Media Optimization or Display Graphics algorithm, there is a Cancel button 
instead of a Stop button. Clicking Cancel, cancels all calculations and no workable layouts will 
be shown. Only one solution can be found with the Media Optimization or Display Graphics 
algorithm, so you will not see multiple options. 

For complex projects, the number of potential solutions could be in the millions or more, and to exhaust all 
possible combinations could take hours or even days. For these types of projects, Metrix may not finish finding 
solutions – in almost all such cases you will probably want to click Stop when you see that the solutions are not 
getting any better. 
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Auto Plan ranks the plans it generates according to cost and printing time. You can sort the solutions by clicking 
any of the column headers. This is especially useful when you are planning for two presses at once. 

The Auto Plan Selector window has three sections: 1) the different plans, 2) the layouts included in the plans, 
and 3) a display of the layout. 

In the first section, you can select the plan you prefer. In the second section, you can look at the layouts in the 
plan, and see which components have been assigned to the layout. In the third section, you will see the layout 
displayed the same as it would be in the View Area of the Project Explorer. 

5. Select one of the solutions, and then click OK. 

 

You may improve on your results by altering the Area to Start Tests (%) and the Time Out properties in the 
Production Properties window. 

A subsequent Auto Layout or Auto Production, particularly for complex ganged layouts, may result in further 
optimization. 

The N-Up Binding Module 

• The N-Up Binding module is an option you can add to Metrix. 

• The N-Up Binding module automates the setup of products that print and fold, or print, fold, and bind 2- 
or 3-up on a press sheet. 
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• Customers who need this functionality generally own binding equipment that can accommodate 2- or 3-
up binding, such as a book saw or specialized knife-trimmer. N-Up Folding does not necessarily require 
this specialized equipment. 

• This module provides instant visual feedback on how the project will fit on a press sheet with the new 
manufacturing configuration. 

• The Metrix N-Up Binding module is easy to work with – even editing the options are easy. 

• Metrix takes care of all the details like shingling/creep compensation automatically. 

Descriptions of N-Up Binding and N-Up Folding 

• N-Up Binding: 2-up takes two full products of the same dimensions through to the binding process; 3-up 
binding does the same with three products. The content can be different, as long as the dimensions are 
the same. 

• N-Up-Folding: The operator can select common signatures from a single product or across multiple 
products and print and fold them together to save folding time and costs. Signatures can be from 
different products but must be structurally the same. 

How N-Up Binding Works: N-Up Folding 

The Assembly View of Product A automatically displays in the View Area. Components are given labels for easy 
recognition and arrangement. 

 

Note The View Area displays the item currently selected in the Project Explorer. 

 When a bound product is selected, the Assembly View displays. 

Folding components 2-Up 

1. Right-click (CTRL-click for Mac) a component in the Project Explorer to open a contextual menu. Select 
the option Fold Component 2-Up. This will produce a 2-up fold of the component. 
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2. Perform an auto layout on the layout containing the product, and then select the layout to view the 
results. 

Folding components 3-Up 

1. Right-click (CTRL-click for Mac) a component in the Project Explorer to open a contextual menu. 

2. Select the option Fold Component 3-Up. This will produce a 3-up fold of the component. 

Note Another way to perform a 3-up fold is to perform the 2-up fold twice from the contextual menu. 

3. Perform an auto layout on the layout containing the product, and then select the layout from the window 
to view the results. 

Splitting an N-Up folded component 

To “unfold” folded components: 

• Right-click (or CTRL-click for Mac) the folded component(s) in the Project Explorer, and then select 
Split N-Up Folded Component on the contextual menu. 

Folding different components together 

You can also fold different components together (from the same or different products) by dragging one 
component over another in the Project Explorer. To do so: 

1. Click one of the components you want to fold and drag it over the other. 

2. When the regular cursor changes to a drag cursor, release the mouse button. 

Notes When you fold two different components together, as opposed to making a 2-up fold of the 
same component, the components must be the same size. Otherwise the component you are 
dragging may change its size to match the component with which it is being folded. 

 If you drag another component onto the two you have already folded together, you can make a 
3-up fold of the three different components. 
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N-Up binding machine 

To create 2­ or 3­Up layouts, you must first have a binding machine capable of N-Up binding in your Metrix 
database. 

Note For more information about setting up your binding machine in the Database window see the Metrix 
Setup Guide. 

 

N-Up Binding Machine Properties 

Property Explanation 

Maximum Binding Number Up 1-Up/2-Up/3-Up 

The maximum binding number up for this binding machine. 

Minimum N-Up Offset The minimum margin required between 2-Up and 3-Up products. 

Default N-Up Offset The default (preferred) margin between 2-Up and 3-Up products. 

Maximum N-Up Offset The maximum margin allowed between 2-Up and 3-Up products. 

Adding an N-Up product 

When you add a new product with the New Product Wizard, the N-Up properties are specified on the New 
Product Binding window. 
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N-Up Product Properties, Binding window 

Property Explanation 

Binding machine Select a binding machine capable of binding 2-Up or 3-Up. 

Binding Number Up Select the number up. 

1st-Up Content Orientation The content orientation of the 1-Up product. 

N-Up Content Orientation The content orientation of the N-Up product(s), relative to the 1-Up. 

Editing N-Up properties 

You can change the N-Up Binding properties after you create the product using the following steps. 

1. Select a product from the Project Explorer. 

2. From the Properties Editor, Select Binding Number Up > Select… 

3. Edit properties. 
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Populated and unpopulated content 

Populated workflows: Content 

For populated JDF and imposed PDF workflows, the N-Up product is assigned after the product is added. For 
each product instance, the content can be common or unique. 

1. Select a product in the Project Explorer. 

2. In the Properties Editor, select Content > Select… 

3. In the Content window, select Common Content > True / False. 

4. Navigate to your content file(s). 

Unpopulated workflow: Content 

For unpopulated JDF, the specific content file is not assigned within Metrix. However, you do need to specify 
content characteristics for each N-Up – whether the content is common or unique. To do this, follow the steps 
below. 

1. Select a product in the Project Explorer. 

2. In the Properties Editor, select Common Content > True / False. 

N-Up Common Content: True 

When all N-Up product instances have the same content (the default), there is one page list for both product 
instances. 

Any page edits on one N-Up instance (e.g., Page Colors, Custom Shingling, Folios, etc.) are automatically 
applied to the other(s). 

Note To make each N-Up Common Content, True is the default. 

N-Up Common Content: False 

When you change the Common Content settingfor Each N-Up property to False, there are multiple Page Lists, 
one for each N-Up instance. They are label based on the number N-Up that you are working on. 

Page edits on one N-Up instance (e.g., page colors, custom shingling, folios, etc.) are completely independent of 
the other instances. 

Note When Common Content is False but layouts have already been generated with Common Content set to 
True, then Metrix needs to re-calculate the number of sheets required because the press run cannot be 
halved as it was previously. Select a layout in the Project Explorer, and then select Layout> Set 
Required Sheets to have Metrix calculate the number of sheets required. 

Common Content=False, partly populated 

When you set Common Content to False, you can specify one product as populated and another as 
unpopulated. 

The Irregular Shapes Module 

Support for irregular shapes and die-cut products 

Metrix now supports irregularly shaped products, such as labels and packaging, with the Irregular Shape Using 
Contour Line in Content File product type and the Die-Cutting Tools and Multi-up Die Standards feature. Irregular 
Shape products can be nested to optimize space on the sheet.  

Use of the Die-Cutting Tools feature involves several tasks: 

1. Creating a die-cutting tool that references a single-up die and a multi-up die 

2. Creating a multi-up die standard (optional) 
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3. Creating a die-cut project  

4. Planning the project and applying the standard 

5. Planning a die-cut product with another type of product 

(1) Creating a Die-cutting Tool 

Die-cutting tools are used in the creation of multi-up die standards and projects. A die-cutting tool uses the 
geometry of a multi-up die to position die-cut products on a press sheet. 

To add a Die-Cutting Tool to the Metrix Database 

1. Select Database > Equipment > Die Cutting Tools. 

2. Choose Add New in the Die-Cutting Tools toolbar. 

 

3. Click Select to open a PDF file for the 1-up Die in the New Die Cutting Tool window.  

4. Assign a Cutter Operation from the drop-down list to the appropriate Contour Name in the 1-up die 
Contour Mapping window.  

 

Note Operations such as Crease and Perforation can be assigned to other contours.  

5. Click Select to open a PDF, CFF2, or DXF file for the Multi-up Die in the New Die Cutting Tool window.  

Note  The multi-up file is a PDF, the Contour Mapping dialog opens. DXF and CF2 files are unaware 
of colors. 

6. Assign a Cutter Operation from the drop-down list to the appropriate Contour Name in the multi-up die 
Contour Mapping window.  
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Note The multi-up die Contour mapping window will not open for DXF or CF2 files because those 
filetypes are unaware of color.  

7. Edit the fields if necessary. 

Note  Many of the fields will automatically populate. 

 

Property Explanation 
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1-Up Die Select a file of a single die-cut item. A preview of this file will 
appear in the 1-up Die box.  

Multi-Up Die Select a file with the layout of multiple die-cut items. The 
individual die shapes must be the same as the 1-up die. A 
preview of this file will appear in the Multi-up Die box.  

Name 
 

Name of the die-cutting tool. Defaults to the name of the multi-up 
die file.  

Device ID 
 

The ID number of the die-cutting tool. Defaults to the name of 
multi-up die file. 

Item Width Width of the 1-up die-cut item.  

Item Height Height of the 1-up die-cut item.  

Minimum Sheet Width Minimum sheet width that can accommodate the multi-up die.  

Minimum Sheet Height Minimum sheet height that can accommodate the multi-up die. 

Grain Direction Grain direction specified for the 1-up die.  

Allowed Bleed Intrusion Choose to allow specific edge bleeds to overlap other bleeds. 
Settings are applied when the product property Resolve Bleed 
Conflicts is set to True. 

Die Cutter Tool Type Flat/ Rotary 

Select the die-cutter tool type.  

Anchor to Sheet Position of the die tool relative to the sheet.   

To change the anchor point, select the Die File or Bounding Box 
radial button in the Anchor to field.  

 

Anchor Horizontal Offset Distance from the lower left corner of the sheet to the anchor on 
the X axis.  

If the Anchor Horizontal Offset is 0, the die-cutting tool may 
infringe on the no-page or no-image areas defined for the press.  

Anchor Vertical Offset Distance from the lower left corner of the sheet to the anchor on 
the Y axis.  

If the Anchor Vertical Offset is 0, the die-cutting tool may 
infringe on the no-page or no-image areas defined for the press. 

Number Up Number of items cut per sheet.  
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Number Across Number of items cut across the sheet on the X axis.  

Number Along  Number of items cut along the sheet on the Y axis.  

Streams Columns designated to repeatedly print a single product using 
roll-fed equipment. Specify the number of streams for a multi-up 
die. 

Stream Number Across Number of items in each stream across the X axis.  

Manufacturer Manufacturer of the die-cutting tool.  

Model Name Model name of the die-cutting tool.  

Model Number Model number of the die-cutting tool.  

Serial Number Serial number of the die-cutting tool.  

Note The properties in red are required.  

8. Select the 1-up Die: DieLine button or the Multi-up Die: DieLine button to change dieline colors.  

Note     Dieline buttons are only available if there are multiple possible dielines in a file, and/or it is a      
new die-cutting tool.  

9. To define the Allowed Bleed Intrusion, click Select. 

• The Allowed Bleed Intrusion screen shows one die station in the multi-up die in relation to the 
others surrounding it. 

• The areas where the bleeds overlap are highlighted. 

• The bleeds are shown as light red lines. 

• The red rectangles encompass the areas where bleed intrusion occurs. 

Note Selecting a red rectangle (which will turn it green) allows the bleed from the adjacent 
die station to intrude into the present die station (illustrated with thick black lines). 

• The Bleeds (All Edges) value simulates how the bleeds will appear in a project, but does not 
affect the bleed amount in the Die-Cutting Tool. 

Note The actual bleed amount in a project is determined by the value entered in the 
Product Properties. 

 The bleed amount in the Multi-up Die Standard is determined by the Default Bleed 
setting in the Metrix Database > Conventions. 

• The image below shows an example of what the Allowed Bleed Intrusion screen might look 
like for a die-cut product. 
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• When you are finished, click OK. 

• Then click OK in the New Die Cutting Tool window. 

Note You should now see the new die-cutting tool listed in the database under Die Cutting 
Tools. 

(2) Creating a Multi-up Die standard for Die-Cutting Tools 

Creating multi-up die standards is the next step in producing die-cut products. This step is optional. The Anchor 
Horizontal Offset and Anchor Vertical Offset settings determine the position of the die-cutting tool relative to 
the selected sheet.  

To create a multi-up die standard 

1. Select Standards Manager >File >New Standard: Multi-up Die. 

Note You can only open the Standards Manager when no project is open. 

2. Click Select and choose your Multi-up Die from the Select Die-cutting Tool window.  

3. Choose the Press, Printing Method, and Sheet from the appropriate drop-down lists.  

4. When you are finished, click OK. 

Notes You will then see the Multi-up Die Standard and can edit it as necessary. 

 The Multi-up Die can only be moved as a unit. It is not possible to edit or move an individual die 
station. 
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(3) Creating a die-cut product 

To create a die-cut product 

1. Click . 

2. Enter the product properties.  

 

3. Select the Die-cut using Die-Cutting Tool product type.  

 
 

Note The Irregular Shape Using Contour Line in Content File option replaced the Die-cut 
using Dieline in Content File option. It is designed for products that use a digital cutting 
machine, but can be used to add die-cut products without a die cutting tool.   
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4. Enter a Quantity.  

 

5. Select the Die-Cutting Tool from the list or Add New. 

a. If you choose Add New, fill out the New Die-Cutting Tool window.  

 Note For information on adding a new die-cutting tool, see To add a Die-Cutting Tool to the 
Metrix Database. 
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6. Select the Stock media to use for the product. 

 

7. Choose the Stock Grain (direction) for the finished product.  
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Note For information on setting up grainless stocks, see Setting Up Grainless Stocks. 

 When a grainless stock has been selected, the Stock Grain is restricted to Either. 

8. Define the default Page Properties for the product, and then click Finish. 

 

Note You cannot set the bleed for each edge individually, because dies are often irregular shapes. To 
set the edge bleed, fill out the Bleed All Edges field. 

9. Assign PDF content files in the Run List. For die-cut products, you must set the Content Positioning 
Rule to Center Each PDF Page Trimbox. Otherwise the content may not be correctly aligned with the 
die. 
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Notes  You can open the Contour Mapping dialog to assign a dieline color to the product by selecting 
the Dieline Color field in the Product properties. 

 The sample files for the “Gum” Die-Cutting Tool are in the EFI/Metrix/Content folder. 
“6_Gum_Source_CutCrease.pdf” is the 1-up Die file and “6_GUM-Imposed.pdf” is the Multi-up 
Die file. “6_Gum_Source_Blue_CutCrease.pdf” and “6_Gum_Source_CutCrease.pdf” can both 
be used as content files. 

 The PDF files used for die-cutting tools and die-cut products cannot contain layers. The files 
must be flattened so they can be exported. 

To create an irregular shape product 

1. Click . 

2. Enter the product properties.  
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3. Select the Irregular Shape Using Contour Line in Content File product type.  

 

4. Enter a Quantity.  
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5. Click Select and choose a PDF file to upload.  

Notes The files used to create Irregular Shape products must contain at least one Contour Line in a 
spot color or you can use the Trim Box or Media Box as the Cutting Contour Line. To show the 
PDF Trim Box and Media Box set the User Preference Irregular Shapes using PDF Boxes to 
True and click the Use PDF Boxes checkbox.  

 Spot color Cut Lines must be a closed path. If there is a gap of 5 points or less, Metrix will 
automatically fill in the gap. If the gap is greater than 5 points, the Cutter Operation “Cutting” will 
not be available for that Contour Line and there will be a red X under Cut Line.  

 If the selected file has multiple pages, one or more of which contain Contour Lines, you can 
view each page in the PDF by toggling through the Page Number list to find and select the page 
you want to use.  

a. A preview of the file along with a list of spot colors contained in the file will appear in the New 
Product window. 
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i. The Preview Color column shows the color of the contour line as it appears in the 
preview.  

ii. The Contour Name column shows the name of the color as described by the PDF 
file.  

iii. The Cutter Operation column shows the operation associated with the specific color.  

Note Cutter Operations for digital cutting machines are defined in the Cutter 
Operations window accessed through the database.  

   

iv. The Cut Line column shows the status for each Contour Line.  

1. A green checkmark indicates the Contour Line is a valid cut line.  

2. A red X indicates the Contour Line is not a valid cut line so it cannot be 
associated with the Cutter Operation.  
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3. A black question marks indicates Metrix is validating the Contour Line. 
Complex Contour Lines can take up to several minutes to validate.  

Note If the Contour Line is not validated within several minutes, click 
Cancel and select a different file or edit the file to be less complex.  

b. To assign the Preview Color to a different Cutter Operation, select the appropriate Cutter 
Operation box, and choose an option from the drop-down list.  

i. Cutter Operations can be reassigned from the Product Properties editor: 

1. Select the Cutting Line Color field.  

2. Click . 

3. Reassign the Cutter Operation in the Contour Mapping window.  

4. Click OK.  

 

Note You cannot edit the Width and Height since they are determined by the 1-up file. 

6. Select the Stock media to use for the product. 
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7. Choose the Stock Grain (direction) for the finished product.  

 

Note For information on setting up grainless stocks, see Setting Up Grainless Stocks. 

 When a grainless stock has been selected, the Stock Grain is restricted to Either. 

8. Define the default Page Properties for the product, and then click Finish. 
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Note You cannot set the bleed for each edge individually, because dies are often irregular shapes. To 
set the edge bleed, fill out the Bleed All Edges field. 

9. Assign PDF content files in the Run List. For die-cut products, you must set the Content Positioning 
Rule to Center Each PDF Page Trimbox. Otherwise the content may not be correctly aligned with the 
die. 
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Planning a die-cut project using a die-cutting tool 

To plan a die-cut project using a die-cutting tool 

1. Click Auto Plan. 

 

2. Complete the appropriate fields in the Auto Plan window. 

• If you select False in the Use Die-Cutting Tool Geometry property, then Metrix nests the irregular 
shapes to maximize the space on the sheet.  
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• If you select True in the Use Die-cutting Tool Geometry property, then the layout uses the same 
geometry as the multi-up file selected for the die-cutting tool. Metrix uses the Anchor Horizontal 
Offset and Anchor Vertical Offset to position the die-cutting tool on the sheet. 

 

• If you want to use a multi-up die standard, click Apply Standard. 

         

Note The Resolve Standard window shows all standards that use the same Die-Cutting 
Tool as the product. Metrix displays the differences between the existing standards 
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and the layout values entered in the Auto Plan window. 

 

• You can then select one of the standards and choose one of the following options: 

• Use Selected Standard: Metrix discards all values entered in the Auto Plan window and 
replaces the layout with the standard. 

• Apply Layout from Standard: This option uses the geometry of the die-cutting tool, 
along with any marks that are on the standard, and applies them to the current layout. The 
Press, Sheet Size, and Printing Method used for the layout are retained whenever 
possible. 

Note If the layout uses a printing method that is incompatible with the Die-Cutting Tool 
(for example, Work And Turn or Work And Tumble when the standard is 
Sheetwise, One-sided, or Perfected and the Die-Cutting Tool will not fit two-up 
on the sheet), a warning message appears in the Resolve Standard window. If you 
select Apply Layout from Standard, a warning message appears that says: 
 
“The Printing Method of this standard is incompatible with the current Printing 
Method. Applying this standard will also change the Printing Method on the current 
layout. Continue?” You can click Yes or No. 

• Cancel: Allows you to exit the window without making any changes. 

Planning Die-cut or Irregular Shape Products with Rectangular Products 

Flat, bound, and folded (rectangular) products will not be planned on the same layout as die-cut or irregular 
shape products. If you want to plan rectangular products on the same layout as die-cut or irregular shape 
products, see Creating an Irregular Shape Product using a Rectangular Content File. 

• Separate Window for Die-Cut and Irregular Shape Solutions: 

In the Auto Plan Selector window, there is an additional Next button so the results for the die-cut and non-
die-cut layouts are not displayed in the same window. Clicking this button will open a separate window that 
displays solutions found for the die-cut product layouts. If you plan die-cut products using a die-cutting tool 
with irregular shapes or products and select True for the Die-cutting Tool Geometry field, then the die-cut 
products are placed on a separate layout from the irregular shape or rectangular products. If you select 
False for the Die-cutting Tool Geometry field, then the die-cut products are considered to be the same as 
irregular shape products and can be nested with them. Rectangular products cannot be planned on the 
same layout as die-cut or irregular shape products.  
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Creating an Irregular Shape Product using a Rectangular Content File 

1. Set the User Preference > Content Handling > Irregular Shapes Using PDF Boxes option to True.  

2. Create a new product in the project.  

3. Select Irregular Shape Using Contour Line in Content File on the Product Type screen.  

4. Click Select and browse to the PDF content file on the Contour Line File screen.  

5. Click Include PDF Boxes and the Media Box and/or Trim Box options will appear in the Contour Line 
column.  
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6. Select Cutting from the Cutter Operation column for the Contour Line (Media Box or Trim Box) you 
want to use.  

 

 

7. Finish creating the product.  

Note When you plan the project, Metrix can put this product on the same layout as Irregular Shape 
products that print on the same substrate.  

Nesting Products without the Irregular Shapes Module 

1. Select the product in the Project Explorer and set the Nesting property to True to disable Status Area 
errors that would ordinarily be reported when one product instance overlaps another. 

2. Optional: Disable bleed shading (View > Shade Product Bleed) so you can visualize the nesting more 
clearly. 

3. Optional: Add a thumbnail image of the page. Select the Product node, then the Page (Side 1) in the 
View Area. Choose the Thumbnail Image property, and then select the low resolution RGB preview 
(JPG, PNG, or GIF) for the first side. 

4. If you've assigned a Thumbnail Image, select the background color of the image as the Transparent 
Color property (usually white). You can change the Transparency Tolerance property if necessary. A 
larger number renders more colors transparent. 

5. If there are no product instances currently on the layout, add one using Layout > Add Component 
Instance... 

6. Add one or more product instances as required, then rotate and move product them as required for 
nesting. Use the Nudge function if required to move the instances into position. For more information, 
see Nudging product instances. 

7. Select the group of nested product instances. Step-and-repeat by holding down the ALT key (Windows) 
or the OPTION key (Mac) then dragging across the sheet horizontally and/or vertically. 

8. Select and center the entire nested group horizontally and/or vertically. 

9. Set the Required Sheets property.
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The Metrix Automation Modules 

Description of Automation Server 

Automation Server is a separate EFI program that automatically processes incoming projects submitted via 
Metrix XML format, or directly from a Metrix client. Automation Server then applies Metrix algorithms and settings 
and analyzes potentially thousands of manufacturing options to produce optimized layout projects without human 
intervention. When finished, Automation Server can automatically send completed projects directly to the 
prepress workflow and send setup data to the finishing department. If problems occur, the project is saved into 
the Metrix database and operators are emailed details so they can resolve them in Metrix. 

Automation Server is highly configurable and able to handle an enormous volume of work, allowing you to define 
a virtually unlimited number of incoming hot folders, each with unique processing options and each able to work 
on multiple projects simultaneously. The current number of multiple projects is ten, but you can contact EFI for 
options if you need to process more than ten projects at a time. 

The server automatically applies sets of press sheet marks based on user­defined rules considering the press, 
printing method, and the number and type of ink colors on a layout. Operators no longer need to sort through 
lists of marks wondering if they’re selecting the correct set. 

Automation Server connects to your existing Metrix database, leveraging all your existing equipment, shop 
settings and the standard layouts you’ve created over time. Processed projects are saved to the shared Metrix 
database. 

Note A series of movies explaining Metrix Automation is available at no cost from ePS. Email Metrix technical 
support to request the movies. 

Description of Automation Lite or Pro 

Automation Lite or Pro is an advanced, hot-folder driven module for Metrix which accepts MXML files and fully 
automates their processing in Metrix. It is similar to the existing hot folder in Metrix, but much more sophisticated 
and automatic in its operation. 

When the Metrix Automation module is licensed, a new File menu item “Automation Mode” will switch the user-
interface from the traditional Metrix interface to the Automation Mode interface. 

Once in Automation mode, the operator can load a Default Commands file and start the hot folder running. The 
Input folder will then be ready to receive and process files. 

When MXML files arrive in the Automation Input Folder, Metrix applies settings, performs tasks, creates a 
project, and automatically exports the output (JDF, PDF, etc.). 

Automation can operate in one of two modes: 

• Default Commands Mode – Metrix can use a Default Commands file, like one of those included with 
Metrix, to process the project. In this case, the resources in the regular Metrix Database will be used to 
process the MXML file. 

• MXML Commands Mode – If processing instructions are embedded in the incoming MXML file, 
Automation Pro (this will not work with Automation Lite) will ignore the Default Commands file and use 
the instructions in the MXML file. Further, if equipment resources are also found in the MXML file (items 
like presses, binding machines, stocks, inks, etc., Automation Pro will ignore the Metrix Database 
resources and use those found in the MXML file. 

You can modify mark sets to help Metrix determine which mark sets should be used with a particular layout. 
Editing mark set properties is especially helpful for those running Automation, as it gives the operator precise 
control over which mark sets will be automatically applied to layouts during the automation process. Mark set 
properties apply whether the mark set is being added manually by an operator or automatically by Automation. 

Note A series of movies explaining Metrix Automation is available at no cost from EFI. Email Metrix technical 
support to request the movies. 

Comparison of Automation Server and Automation Lite or Pro 

The three major differences between Automation Server and Automation Lite or Pro are basically in licensing, 
input, and processing. 
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• Licensing - Automation Server is a separate product, with completely separate licensing, and a separate 
security key. Automation Server does not use any Metrix client licenses. 

• Input - Automation Lite or Pro has a single hot folder for each Metrix client used, but Automation Server 
can have a virtually unlimited number of hot folders. 

• Processing - Whereas Automation Server can process multiple concurrent projects per hot folder, 
Automation Lite or Pro processes one project at a time from each hot folder. Also, Automation Server is 
tuned for higher performance and faster processing than Automation Lite or Pro. 

Comparison of Automation Pro and Automation Lite 

Automation Module is now available as “Automation Lite” or “Automation Pro.” One difference is that Automation 
Pro includes the ability for incoming MXML Projects to include the processing instructions, and Automation Lite 
does not. In other words, “Automation Pro” is identical to what was called “Automation Lite” prior to version 2013 
.0. Automation Lite has been scaled back functionally by losing this one ability. One other difference is that with 
Automation Lite there is no requirement to maintain an MSA. 

Overview of Metrix Automation MXML commands 

Metrix Automation uses as series of MXML commands to do its work. The six basic categories of commands 
include: 

• The Hot Folder Command 

• Transform Commands 

• The SaveToDatabase Command 

• Email Command 

• Checking Commands 

• Export Commands 

Here is a more detailed description of these commands: 

The HotFolder command 

When run, the HotFolder Command starts watching the hot folder for an incoming MXML file to consume and 
process. The HotFolder Command is required and must be the first command in the list of commands. 

When an incoming MXML file is found, the HotFolder Command performs these tasks: 

• Moves the file from the Input Directory to the Output Directory 

• Reads and interprets the MXML file, creating a Metrix project in memory (unless an error is 
encountered) 

• Unless the incoming MXML file specifies that it should be run in memoryonly, it checks the Metrix 
database for a matching project ID. If a matching project ID is found, it tries appending numbers like 
“(2)” or “(3)” to the ID until a unique database ID is found and locked. In this way Automation will treat 
each new incoming MXML non-memory-only project as unique and will always be able to save it to the 
database. 

Transform commands 

Transform Commands modify a project. For instance, one may arrange component instances on a layout, 
another may apply a standard layout from the database to a layout, and another may add default bleeds to all 
pages in a project. 

Transform Commands available for Metrix Automation include: 

 

Command Objects Modified or Potentially 
Modified 
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Add Default Bleed Product Pages 

Add Default Jog And Spine Trim Bound Products 

Auto Plan Layouts 

Auto Production Layouts 

Auto Layout Layouts 

Apply Standards Layouts 

Set Property Project 

Assign Layout Rampage Workflows Layouts 

Assign Page Rampage Workflows Pages 

 

Assign Layout Rampage workflows command 

The goal of Metrix Automation is to automate the Metrix workflow as much as possible. Rampage users often 
assign a Rampage workflow to each side of the Metrix layouts so this information will be passed via JDF to their 
Rampage system. The Assign Layout Rampage Workflows Command performs this automatically using these 
rules: 

• The Assign Layout Rampage Workflows Command will not have any effect unless the User 
Preferences > Prepress Workflow = “Rampage”. 

• The Assign Layout Rampage Workflows Command attempts to assign a Rampage Workflow to each 
side of layout using the following naming convention: 

• For layouts on coated stock: <Press.Name>_Coated 

• For layouts on uncoated stock: <Press.Name>_Uncoated 

Whether the stock is coated or uncoated is determined by the stock’s Grade property. The first three grades are 
coated stocks, the last two are uncoated. 

 

• If Metrix does not find a Rampage workflow in the Database for the relevant name, no Rampage 
workflow will be assigned to the layout side. 
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If you want to ensure that only projects with a Rampage workflow assigned to every layout side are exported to 
prepress, you should set the 
AssignLayoutRampageWorkflowsCommand/@OnlyExportIfAllLayoutsHaveRampageWorkflows attribute to True. 

SaveToDatabase command 

The SaveToMetrixDatabase Command saves the project to the Metrix Database. 

Email Commands 

The SendEmail Command sends emails to either the Administrator or Planners. The subject and body of the 
emails must be defined in text files in the / Automation/EmailTemplates subfolder. 

Checking Commands 

The CheckProject Command checks the status of all products, components, and layouts in the project, just as 
the Project Explorer and Status Area of the Metrix GUI display the status of each item. 

The CheckLayoutSheetAreaUse Command checks the percentage of imposed component area divided by the 
sheet area and compares it to the required amount. 

The Checking Commands also perform one housekeeping action – they remove any empty layouts in the 
project. Some incoming MXML files may deliberately include empty layout elements describing press and stock 
sheets to be used for Auto Plan, and under some circumstances Auto Plan will leave empty layouts behind. 

The results of the Checking Commands can be used to allow or disallow the execution of the Export Commands. 

Export Commands 

The Export Commands export a project’s data in various formats. 

The Export Commands available for Metrix Automation include:  

• ExportImposedPDF 

• ExportBarcodedImposedPDF 

• ExportMetrixXML 

• ExportJDFImposition 

• ExportCIP3Cutting 

• ExportJDFCutting 

• ExportCIP3Folding 

• ExportJDFFolding 

• ExportJDFBinding 

• ExportLayoutImages 

• ExportZipFile 

The Auto Plan command 

Overview 

Auto Plan sometimes requires project-specific press and sheet size parameters. For example, when planning 
bound work, you (like an MIS System) may want to produce all the signatures on 24 x 36” or 25 x 38” sheets. 

At other times, it is desirable for Auto Plan just to run on the largest press sheet possible. This could be 
advantageous when gang printing, because it generally costs the same to print on large press sheets as on 
smaller sheets, but more products can usually be placed on larger sheets. 
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Note There is one difference between Auto Plan and Auto Production in Metrix Automation versus the normal 
user-driven Metrix. Whenever Auto Plan and Auto Production create a layout where the printing method 
is Sheetwise or Perfected, and some component pages on side one have colors but no component 
pages on side two have colors, Metrix Automation changes the layout’s printing method to One-Sided. 

Auto Plan use cases 

There are three different ways Metrix can determine which presses and sheet sizes to use when running Auto 
Plan in an automation environment. 

1. The first way the automation Auto Plan works would suit a gang printer with only one or two types of 
presses. The Commands MXML file specifies the one or two presses, and Auto Plan simply finds the 
largest press sheet for each press for the component stocks in the incoming MXML file. Using this 
method, incoming MXML files do not need to define any Layout elements. 

• Commands MXML file: 

• Set AutoPlan@UseLargestDatabasePressSheet = True. 

• Supply one or two AutoPlanProductionMethod/PressRef elements to specify the press or 
presses. 

• Incoming MXML file: Product component stocks will be read and the largest sheets of each in the 
database that can fit on the presses will be used. 

• Summary: Presses and production information defined: in the Commands MXML file using the 
AutoPlanProductionMethod elements. Sheet sizes defined: for each component stock in the 
incoming MXML file (MXML version 1.0 or 1.5) the largest sheet in the database that can fit on the 
press or presses. 

2. The second way the automation Auto Plan works does not define the press or presses, or any other 
production information, in the Commands MXML file. Instead, the press or presses and other production 
information is read when processing an incoming MXML file. Using this method, incoming MXML files 
must define at least one MetrixXML/Project/LayoutPool/Layout element. 

• Commands MXML file: 

• Set AutoPlan@UseLargestDatabasePressSheet = True. 

• Do not supply any AutoPlanProductionMethod elements. 

• Incoming MXML file: 

• The first two unique production scenarios (press, printing method, and page-to-bleed gap) 
contained in the MetrixXML/Project/LayoutPool/Layout elements in the incoming MXML file will 
be used. 

• Product component stocks will be read and the largest sheets of each in the database that can 
fit on the presses will be used. 

• Summary: 

• Presses and production information defined: in the incoming MXML file (MXML version 1.0 or 
1.5) in the first two unique production scenarios. 

• Sheet sizes defined: for each component stock in the incoming MXML file (MXML version 1.0 
or 1.5) the largest sheet in the database that can fit on the press or presses. 

3. The third way the automation Auto Plan works is similar to the second above, except even the sheet 
size information is read from the incoming MXML files, not the Commands MXML file. Like scenario two 
above, using this method incoming MXML files must define at least one MetrixXML/Project/LayoutPool/ 
Layout element. 

• Commands MXML file: 

• Set AutoPlan@UseLargestDatabasePressSheet = False. 

• Do not supply any AutoPlanProductionMethod elements. 
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• Incoming MXML file: 

• The first two unique production scenarios (press, printing method, page to bleed gap, and 
stock sheet sizes) contained in the MetrixXML/Project/ LayoutPool/Layout elements in the 
incoming MXML file will be used. 

• Product component stocks will be read and sheet sizes of each in the database will be found 
that match the sheet sizes contained in the MetrixXML/Project/LayoutPool/Layout elements in 
the incoming MXML file. 

• Summary: 

• Presses, production information, and sheet sizes defined: in the incoming MXML file (MXML 
version 1.0, 1.5, or 1.6) in the first two unique production scenarios. 

One final extra comparison between cases two and three – case three reads all production information (press, 
printing method, page to bleed gap, and sheet size) from the incoming project MXML file, while case two does 
not read the sheet size but instead uses the largest sheet size for the presses. 

The Metrix Automation email process 

Metrix Automation uses email to notify Administrators and Planners of events they may be interested in, or where 
human intervention is required. 

In previous versions of Metrix, users entered the Automation and Email settings in the Initial Setup window. 
Automation settings are now configured in User Preferences, and User email settings are configured in the 
Database window. 

Before you can use Automation, you must enter the following information: 

• SMTP Host 

• Email From Address 

• User Administrator Email 

• User Senior Email 

Notes Automation requires a Senior Planner user to exist in the Database. If there is no Senior 
Planner, Metrix will automatically create one with a random password. 

 Configure Automation settings in the User preferences on the Automation window. 

  

 Configure User Email To addresses in the Database on the User window. 
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If you are using Automation Lite or Pro, enter the following information in User Preferences > Automation: 

• SMTP Host – this will be site specific. 

• Example: smtp.host=mail.comcast.com 

• SMTP Port – commonly 587, but sometimes 465, 25, or 2525. If you don’t know the port, ask your IT 
department or email hosting service. 

• SMTP Account email – site specific, some ISPs require an account to be used for sending emails, 
others don’t. This is not necessarily the recipient of any emails. 

• Example: email.username=joe_blogs@mail.our_isp.com  

• Example: email.username=joe_blogs 

• Password – the SMTP account password. 

• Example: email.password=top_secret! 

• Email From Address – the email address Metrix uses as its “From” when sending emails to the 
Administrator and Planners. 

• Example: do_not_reply@ourplace.com 

In Database > Users, enter the following: 

• Administrator email – the email address of the Administrator user for this site. Emails will be sent to this 
address. One is sent as a test when Metrix Server starts. You can enter multiple addresses, separated 
with a comma. 

• Example: admin@ourplace.com 

• Example: admin@ourplace.com, big_joe@ourplace.com 

• Senior planner email – the email address for emails sent to the Senior Planner, usually when a project 
could not be fully automatically processed and needs someone’s attention. 

• Example: planners@ourplace.com 

• Example: planners@ourplace.com, bigboss@here.com 

The following items give the operator more options regarding how emails will be handled: 

• email.test – Once Metrix is successfully sending email, the test email sent at startup can be switched 
off by adding the line “email.test=false” to the end of your “metrix.properties” file If the line is already 
there, just delete the number sign (#) from before the line to make it active. 

• email.maxexitingtime – When shutting down, the number of seconds to wait after any non­email 
threads have finished being processed, to give the emailer a chance to send all its pending emails. 
Open the “metrix.properties” file with a text editor and add “email.maxexitingtime=” plus a number to the 
end of the file. 
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• Example: email.maxexitingtime=120 

Description of the Metrix email system 

Metrix can send many emails in short succession and some ISPs block such behavior as a strategy to combat 
spam. To avoid this problem, Metrix uses an internal hot folder system to handle emails. 

Here is a table of the email folders with explanations of how Automation Lite or Pro uses them: 

Folder Explanation 

Automation/_Email/Inbox The watched hot folder, email files dropped into this are emailed 
using the configuration settings above (SMTP host, etc.). 

Automation/_Email/ Outbox Files dropped into the inbox are moved by the system to this 
folder. This is in effect the working area. You should not touch this 
folder directly, unless perhaps there are stale files that need to be 
removed. 

Automation/_Email/ Sent If emails are successfully delivered, the email file is moved into this 
folder. Old email files can and should be periodically manually 
deleted. 

Automation/_Email/Failed After so many attempts if an email still has not been delivered 
successfully, they are moved into this folder. After the email 
problem is rectified, files in this folder should be manually moved 
back into the inbox for sending. 

Automation/_Email/ Holding Some emails have the log file attached. These email files are first 
written to this holding folder until the Commands have all been 
executed and the log file has been written. 

Automation Server 

The User Preferences > Automation and Database >User windows are now accessible from Metrix 
Automation Server so you can configure User email addresses and Automation settings without using Metrix 
Client. 

Automation workflows 

Description of Automation workflows 

In Metrix, a great deal of an operator’s time can be spent doing the same repetitive functions, such as running 
auto layout or auto production, applying standards, applying mark sets, exporting the project, etc. 

For those who have licensed the Metrix Automation module, or are running Metrix Automation Server, Metrix 
allows access to Automation workflows, giving the operator the option of offloading many of these repetitive 
tasks. 

Access to Automation workflows is available using Automate in the standard Metrix user interface. 

 

When the operator presses Automate, Metrix presents a window with a list of available Metrix Automation 
workflows. 
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After the operator selects an Automation workflow, and clicks Save, Close, And Send, the project is sent from 
the Metrix client to the Automation workflow, fully automating its processing. 

If you view the computer running Metrix Automation, you can see a list of the functions Metrix will perform, and a 
log of the progress. 

Once all the steps to process the project are complete, the project can be automatically exported and/or saved 
into the Metrix Database. You can view the results of the process in the Output folder. 

In many cases most of what formerly required operator involvement can now be handled in the background by 
Metrix Automation. 

To use Automation workflows 

1. Launch a Metrix license somewhere on your network. Under the File menu, choose Automation Mode. 

2. Click Browse and select the Commands File you wish to load. Which file you select will be determined 
by the commands you wish Metrix Automation to execute automatically when you click Automate. 

Navigate to your Metrix folder, then to the Commands folder, and then to the Inches or Metric folder 
(depending on which measurements you are using). Select the file you wish to load and click Import. 

Note The hot folder properties in the commands file needs to have the Broadcast property set for 
True. Otherwise, Automation Lite or Pro will not be available as an Automation Workflow. Also, 
you may wish to have Broadcast set to False in the commands file if you want a particular 
Automation Workflow to not be available to your Metrix clients. 

3. Click Start to start running the Hot Folder. This makes Automation Lite or Pro available as an 
Automation Workflow on the network. 

4. On the Metrix client where you wish to do your work, create a project with at least one product, or 

import a project/product. 

5. Click Automate. In the window that opens, Metrix will present you with a list of the Automation 
Workflows available on your network. Select the one where you wish to send your project, and then 
click Save, Close And Send. 

The project is saved to the Metrix Database, it is closed, and the project is sent to the Automation workflow. 
Different functions will be performed on the project, depending on the commands loaded in Automation Lite 
or Pro. 

Note You can use the Filter function to look for a particular Automation workflow. You can search 
using Boolean “And” or “Or” functions. Clicking Refresh will update the list of Automation 
Workflows from the Database. 

6. During the automation process, if you view the machine running Metrix Automation, you can watch it 
process the project. 
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7. When Metrix Automation is finished processing the project, you can look in the Output folder to view the 
results of the process. 
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Appendix A: Agfa Apogee Workflow 
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Setting up Metrix for Agfa Apogee 

Follow these steps to prepare your Metrix system to integrate with your Agfa Apogee workflow. 

1. Select Settings> User Preferences 

2. Select General from the list on the left. 

3. Choose Agfa Apogee as your Prepress Workflow from the drop-down list, then click OK. 

4. Close and restart Metrix. 

JDF Imposition for Agfa Apogee 

When Agfa Apogee is selected as the Prepress Workflow, Metrix inserts special “work style” tags in the JDF 
Imposition file that assist proper positioning for double-sided proofing. Customer information is also added to the 
JDF Imposition, for better integration with Apogee, when all products in the project have the same customer. 

Customers of some Agfa Apogee workflows may find that when they export unpopulated (no content files 
assigned) JDF from Metrix, and there is an existing Apogee job with the same name, it would unlink the already 
assigned content in Apogee. If you encounter this problem it is recommended to try the ‘Unspecified’ option in 
the drop­down menu on the Export JDF Imposition screen. 

Note This option is only available if the “Prepress Workflow” setting in User Preferences / General is set to 
“Agfa Apogee.” 

Apogee/Metrix Integration 

Note This plan uses JDF Input TP, and will generate 1­up proof, layout proof and final plates. 

Apogee Hot Ticket Configuration 
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Set “Imposition Selection” to “From JDF Input.” 

 

Metrix configuration 

The following steps will help you set up the Metrix/Apogee configuration. 

1. In Metrix, with any sample job open, click Export in the menu bar. 

2. Then select JDF Imposition and define the JDF and Content Destinations, along with the Content 
Source Folder Location: “./”: 

 

Notes about Hot Ticket shared directory on Mac 

You cannot browse to a network directory from Metrix on the Mac, so keep an alias of the JDF Input Directory 
(see above) in your local Metrix directory. It is a good idea to keep this handy, since Metrix will default to a local 
directory if this hot folder is not mounted. 

Once you use this alias to find the JDF Input directory, you will need to back up on directory level, highlight the 
input folder and click Select. 
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Exporting from Metrix to Apogee 

1. Select a layout in Metrix. 

2. Click Export in the Menu bar. 

3. In the Export window, select JDF Imposition. 

4. Click OK to send the job to Apogee. 

 

The JDF Subscription (or “handshake”) between Metrix and Apogee allows changes to the Metrix job to 
dynamically update the Apogee Prepress job. 

Here is the result in Apogee when a different layout was selected in Metrix: 
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Appendix B: Rampage Workflow 
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Metrix­Rampage Workflow Integration 

Metrix can attach Rampage­specific processing instructions to a Metrix JDF exported to Rampage. 

This chapter explains how to set up and use Metrix to embed Rampage 

Workflows and Rampage Job Templates. For further information on the Rampage system, Rampage Workflow 
and Job Template options, and operation within the Rampage system, contact Rampage Inc. 

See also the documentation that is included with your Rampage installation. 

Setting up Metrix for your Rampage workflow 

Follow these steps to prepare your Metrix system to integrate with your Rampage workflow. 

1. Select Settings> User Preferences. 

2. Select General in the User Preferences window. 

3. Choose Rampage as your Prepress Workflow, and then click OK. 

4. Close and restart Metrix. 

Rampage workflows and job templates 

For those who have set their Prepress Workflow for Rampage (Settings > User Preferences > General > 
Prepress Workflow > Rampage), there are options in the Resources section of the Database to set the 
Rampage Workflows, and the Rampage Job Templates. 

With the Rampage Workflows option selected, you can enter or edit specific workflow names and types, either 
Page or Sheet Side. 

 

With the Rampage Job Templates option selected, you can enter or edit specific workflow names and 
descriptions. 

A Rampage Job Template applies to an entire Metrix project. 

Assigning Rampage workflows in Metrix 

When you select the whole project in Metrix, you can then select any job template listed in the Database using 
the Rampage Job Template property. 

When you select Products, you can then select any Page Rampage Workflow listed in the Database using the 
Page Rampage Workflow property. 

In the Assembly View, you can also view the page workflow applied to any specific page in the Pages window in 
the Rampage Workflow column. 

When you select a layout, you can then select any Side­Specific Rampage Workflow listed in the Database using 
the Side­1 or Side­2 Rampage Workflow property in the Properties Editor. 
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If you want, you can also select a component, and then a specific page, and then a Specific Rampage Page 
Workflow from the Database using the Rampage Workflow Property. 

Using Rampage color aliases 

What is a Rampage color alias? 

A special color name that is used as a spot color alias. This special color name is then automatically swapped for 
the actual job spot colors on the Rampage system. 

How to create spot color marks 

In order to create spot color marks (such as take-off bars) using an alias that will later be remapped 
automatically, the aliases must first be added to the Inks node of the Metrix database. Follow these steps. 

1. Add the spot color aliases by accessing the Metrix Database. 

2. Choose the Inks node and then click New. 

Note You must have the appropriate permissions. 

 

Valid names are: 

rsi_coloralias_1 through rsi_coloralias_28, and they must be lower case. Aliases cannot be mapped to spot 
colors that contain the process names: cyan, magenta, yellow, or black. 

Spot Color colorbars 

Your colorbars must also have the proper Rampage rsi coloralias names to trigger automatic remapping in 
Rampage. A five-color bar, for example, would have patches of cyan, magenta, yellow, black, and a spot color 
named rsi_coloralias_1, for example. To add these special colorbars to Metrix, follow the normal procedure: 

1. Import the PDF mark into the Metrix Database (Database > File Marks > Import). You must have the 
appropriate permissions. 
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Note From Rampage documentation: “if you are using the Rampage rsi_coloralias feature in 
Illustrator, and you save the Illustrator file to an older version, Illustrator may add a number 1 to 
the end of the color name. Rampage will no longer recognize this color as a color alias. If you 
do re-save your Illustrator document, remember to check your spot color names.” 
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Appendix C: Screen TrueFlow Workflow 
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Setting up Metrix for Screen TrueFlow 

Follow these steps to prepare your Metrix system to integrate with your Trueflow workflow. 

1. Select Settings> User Preferences. 

2. In the User Preferences window, select General. 

3. Choose Screen Trueflow as your Prepress Workflow, and then click OK. 

4. Close and restart Metrix. 

Exporting JDF Imposition for Screen Trueflow 

 

 

JDF Imposition Settings for Trueflow 

Setting Explanation 

JDF Destination Folder The destination for the JDF file exported by Metrix. This is a 
location on the Trueflow server, either 

\\Trueflow host name\HFRoot or \\Trueflow host 
name\HFRoot_ Adv. Metrix will write the JDF to the location 
selected. 

The JDF is named with the Project ID followed by a JDF 
extension. All “illegal” characters 

( \ / : , ; * ? ” <> | # = + % & ( ) ~ ) are automatically replaced 
by dash characters (-), and any preceding period (.) is also 
replaced with a dash. For example, if the project name is 
“Project #90943” Metrix will replace the “#” with a dash and 
determine the filename to be “Project -90943.jdf”. 

Content Destination Folder The destination for the PDF Marks Flat, generated by Metrix 
for all JDF Imposition files, and for PDF content files when 
exporting populated JDF. This path should be 

\\Trueflow host name\docpool. When you click OK to export a 
JDF file, a new subfolder is created in this folder with the 
exact same name as the JDF file (including the “.jdf” 
extension). All PDF content and the PDF Marks Flat will then 
be copied into this new subfolder. 

If a subfolder already exists with the name of the JDF file, an 
underscore (_) and number (beginning at “2”) will be added 
to the root part of the file name, and the number will be 
incremented until a folder name is found that does not 
already exist. For example, if the JDF file is named “Project 
­90943.jdf” and a subfolder already exists with this name, 
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Metrix will try “Project -90943_2.jdf”. If this subfolder already 
exists too, Metrix will try “Project -90943_3.jdf” , and so on 
until Metrix finds a new unique folder name. 

Content Source Path JDF folder 

Content Handling Unpopulated (No Content) / Populated (Include Content) 

Copy Content Files True / False 

Handle File Marks Embed in PDF Marks Flat / Reference in JDF File 

Impose To Press Sheet / Plate 

The area to impose to. 

PDF Sheet Bleed Value that specifies the PDF Sheet Bleed margin (default is 
0”) 

You can specify a PDF Sheet Bleed margin when exporting 
Imposed PDF, Barcoded Imposed PDF, and JDF. This bleed 
margin setting is in the Export window; it adds the specified 
margin to the mediabox all around the sheet and sets the 
trimbox to the exact sheet size. This ensures that marks can 
bleed off the edge of the sheet. 

Trim Marks 

Length The trim mark length. 0 (zero) length turns off trim marks. 

Distance from Page Trim The distance from the page trim to the beginning of the trim 
mark. 

Thickness The trim mark thickness or weight. 

Over Page Content True / False 

When True, trim marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

White Knockout Thickness The thickness of the white knockout around the trim marks. 
Can be 2x, 3x, or 5x the thickness of the trim marks. 

External Fold Marks (outside the page trim bounding rectangle) 

Length The fold mark length. 0 (zero) length turns off external fold 
marks. 

Distance from Page Trim The distance from the page trim to the beginning of the fold 
mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted The fold mark line type. 

White Knockout Thickness The thickness of the white knockout around the external fold 
marks. Can be 2x, 3x, or 5x the thickness of the external fold 
marks. 

Internal Fold Marks (inside the page trim bounding rectangle) 
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Maximum Length The maximum length for the fold mark. 0 (zero) length turns 
off internal fold marks. 

Crop Distance from Page Trim The distance from the page trim to the beginning of the fold 
mark. 

Minimum Length The minimum length for the fold mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted 

White Knockout Thickness The thickness of the white knockout around the internal fold 
marks. Can be 2x, 3x, or 5x the thickness of the internal fold 
marks. 

Export Negative Bleeds True / False 

When True, any Negative Bleed area specified in Metrix will 
be cropped. 
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Appendix D: Fujifilm XMF Workflow 
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Setting up Metrix for Fujifilm XMF 

Follow these steps to prepare your Metrix system to integrate with your XMF workflow. 

1. Select Settings> User Preferences. 

2. On the left side of the User Preferences window, select General. 

3. Choose Fujifilm XMF 3.1 or Fujifilm XMF 3.0 and Earlier as your Prepress Workflow, then click OK. 

4. Close and restart Metrix. 

Exporting and Importing 

Exporting XMF job templates as CSV 

You can export your XMF Job Templates as CSV so they can be imported into the Metrix Database. If you are 
not sure how to export your XMF Templates, contact Fujifilm for assistance. 

Importing CSV XMF job templates 

Follow these steps to import XMF Job Templates. 

1. Select Settings > Database. 

2. On the left side of the screen, choose XMF Job Templates. 

3. Click Import. 

4. Select XMF Template.csv. 

5. Click Import. 

 

JDF Imposition Settings for Fujifilm XMF 

Setting Explanation 

JDF Destination Folder The destination for the JDF file exported by Metrix, which must 
be a location accessible to Fujifilm XMF. If you are unsure of 
the exact syntax and path, contact Fujifilm for assistance. 

Content Destination Folder This is the destination for the PDF Marks Flat as well as the 
destination for PDF Content files when Copy Content 
Files=True, for populated JDF Imposition. This must be a 
location accessible to Fujifilm XMF. If you are unsure of the 
exact syntax and path, contact Fujifilm for assistance. 

Content Source Path Be sure to enter this folder name using the proper syntax. If you 
are unsure of the exact syntax and path, contact Fujifilm for 
assistance. 

Content Handling Unpopulated (No Content) / Populated (Include Content) 

Copy Content Files True / False 

When True, Metrix will copy any assigned content files to the 
Content Destination folder. When False, no assigned content 
will be copied. 

Handle File Marks Embed in PDF Marks Flat / Reference in JDF File 

The generally accepted JDF procedure is to Embed in PDF 
Marks Flat. This means that any file marks used in the job are 
part of the data stream processed by XMF. When Reference in 
JDF File is selected, file marks must be copied to the Content 
Destination Folder so XMF has access to them for processing. 
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XMF Job Template The XMF Job Template to use. Select from the list in the Metrix 
database. 

Impose To Press Sheet / Plate 

The area to impose to. 

Trim Marks 

Length The trim mark length. 0 (zero) length turns off trim marks. 

Distance from Page Trim The distance from the page trim to the beginning of the trim 
mark. 

Thickness The trim mark thickness or weight. 

Over Page Content True / False 

When True, trim marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

White Knockout Thickness The thickness of the white knockout around the trim marks. Can 
be 2x, 3x, or 5x the thickness of the trim marks. 

External Fold Marks (outside the page trim bounding rectangle) 

Length The fold mark length. 0 (zero) length turns off external fold 
marks. 

Distance from Page Trim The distance from the page trim to the beginning of the fold 
mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted 

The fold mark line type. 

White Knockout Thickness The thickness of the white knockout around the external fold 
marks. Can be 2x, 3x, or 5x the thickness of the external fold 
marks. 

Internal Fold Marks (inside the page trim bounding rectangle) 

Maximum Length The maximum length for the fold mark. 0 (zero) length turns off 
internal fold marks. 

Crop Distance from Page Trim The distance from the page trim to the beginning of the fold 
mark. 

Minimum Length The minimum length for the fold mark. 

Thickness The fold mark thickness or weight. 

Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted 
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White Knockout Thickness The thickness of the white knockout around the internal fold 
marks. Can be 2x, 3x, or 5x the thickness of the internal fold 
marks. 

Proofing Lines 

Thickness The thickness of all proofing lines. 

Trim Line Color (None) / Select an Ink (from the Metrix database) 

Insert a trim line of the selected color around the bleed of each 
page. 

Trim Line Type Solid / Long Dashed / Short Dashed 

Insert a trim line of the selected type around the trim of each 
page. 

Bleed Line Color (None) / Select an Ink (from the Metrix database) 

Insert a bleed line of the selected color around the bleed of 
each page. 

Bleed Line Type Solid / Long Dashed / Short Dashed 

Insert a bleed line of the selected type around the bleed of each 
page. 

Export Negative Bleeds True / False 

When True, any Negative Bleed area specified in Metrix will be 
cropped. 

Exporting JDF Imposition for Fujifilm XMF 3.0 and Earlier 

 

 

JDF Imposition for Fujifilm XMF 3.0 and Earlier 

Setting Explanation 

JDF Destination Folder The destination for the JDF file exported by Metrix, which must 
be a location accessible to Fujifilm XMF. If you are unsure of 
the exact syntax and path, contact Fujifilm for assistance. 

Content Destination Folder This is the destination for the PDF Marks Flat as well as the 
destination for PDF content files when Copy Content 
Files=True, for populated JDF Imposition. This must be a 
location accessible to Fujifilm XMF. If you are unsure of the 
exact syntax and path, contact Fujifilm for assistance. 



298 ⚫ Productivity Suite | User Guide 

 

 

Content Source Path Be sure to enter this folder name using the proper syntax. If you 
are unsure of the exact syntax and path, contact Fujifilm for 
assistance. 

Content Handling Unpopulated (No Content) / Populated (Include Content) 

Copy Content Files True / False 

When True, Metrix will copy any assigned content files to the 
Content Destination folder. When False, no assigned content 
will be copied. 

Handle File Marks Embed in PDF Marks Flat / Reference in JDF File 

The generally accepted JDF procedure is to Embed in PDF 
Marks Flat. This means that any file marks used in the job are 
part of the data stream processed by XMF. When Reference in 
JDF File is selected, file marks must be copied to the Content 
Destination Folder so XMF has access to them for processing. 

XMF Job Template The XMF Job Template to use. Select from the list in the Metrix 
database. 

Layout Sides All Sides / Plate or Sheet Sizes 

Use this drop-down list to automatically select plate or sheet 
sizes in the project for export. 

Export As One File / Separate File for Each Layout / Separate File for 
Each Layout Side / Separate File for Each Plate and Sheet 
Size 

The JDF file(s) to generate and send to XMF. 

Impose To Press Sheet / Plate 

The area to impose to. 

Trim Marks 

Length The trim mark length. 0 (zero) length turns off trim marks. 

Distance from Page Trim The distance from the page trim to the beginning of the trim 
mark. 

Thickness The trim mark thickness or weight. 

Over Page Content True / False 

When True, trim marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

White Knockout Thickness The thickness of the white knockout around the trim marks. Can 
be 2x, 3x, or 5x the thickness of the trim marks. 

External Fold Marks (outside the page trim bounding rectangle) 

Length The fold mark length. 0 (zero) length turns off external fold 
marks. 

Distance from Page Trim The distance from the page trim to the beginning of the fold 
mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

Line Type Solid / Dashed / Dotted 
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The fold mark line type. 

White Knockout Thickness The thickness of the white knockout around the external fold 
marks. Can be 2x, 3x, or 5x the thickness of the external fold 
marks. 

Internal Fold Marks (inside the page trim bounding rectangle) 

Length The fold mark length. 0 (zero) length turns off internal fold 
marks. 

Distance from Page Trim The distance from the page trim to the beginning of the fold 
mark. 

Thickness The fold mark thickness or weight. 

Over Page Content True / False 

When True, fold marks will overprint page content. 

Color All Separations / Select an Ink (from the Metrix database) 

The color for trim marks. 

White Knockout Thickness The thickness of the white knockout around the internal fold 
marks. Can be 2x, 3x, or 5x the thickness of the internal fold 
marks. 

Proofing Lines 

Thickness The thickness of all proofing lines. 

Trim Line Color (None) / Select an Ink (from the Metrix database) 

Inserts a trim line of the selected color around the bleed of each 
page. 

Trim Line Type Solid / Long Dashed / Short Dashed 

Inserts a trim line of the selected type around the trim of each 
page. 

Bleed Line Color (None) / Select an Ink (from the Metrix database) 

Inserts a bleed line of the selected color around the bleed of 
each page. 

Bleed Line Type Solid / Long Dashed / Short Dashed 

Inserts a bleed line of the selected type around the bleed of 
each page. 

Export Negative Bleeds True / False 

When True, any Negative Bleed area specified in Metrix will be 
cropped. 
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Appendix E: Keyboard Shortcuts 
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Keyboard Shortcuts 

Action Windows Mac 

Zoom In on the Layout CTRL + + CMD + + 

Zoom Out on the Layout CTRL + + CMD + - 

Redo CTRL + Y CMD + Y 

Delete Press Delete Press Delete 

Delete Instance and Product Press Delete Press Delete 

Delete Layout and Products Press Delete Press Delete 

Select All CTRL+A CMD+ A 

Undo CTRL+Z CMD+ Z 

Automate… SHIFT+CTRL+T CMD + T 

Open Project CTRL + O CMD + O 

New Project CTRL + N CMD + N 

Close Project CTRL + W CMD + W 

Save Project CTRL + S CMD + S 

Save Project As… SHIFT + CTRL + S SHIFT + CMD + S 

Apply Standard SHIFT + CTRL + A SHIFT + CMD + A 

Exit Standards Manager CTRL + W CMD + W 

Automatic Layout CTRL + L CMD + L 

Rotate 90 degrees CW CTRL + R CMD + R 

Rotate 90 degrees CCW SHIFT + ALT +R SHIFT + OPT + R 

Step and Repeat Layouts ALT + drag (snap to bleed 
edge) or CTRL + ALT + 
drag (snap to trim edge) 

OPT + drag (snap to bleed 
edge) or CMD + OPT + 
drag (snap to trim edge) 

Add Mark Set CTRL + M CMD + M 

Copy Selected Marks SHIFT + ALT + C SHIFT + OPT + C 

Paste On Selected Layout(s) SHIFT + ALT + V SHIFT + OPT + V 

Select All Marks SHIFT + ALT + A SHIFT + OPT +A 

Add New Product CRTL + D CMD + D 

Add New Layout CTRL + T CMD + T 

Clone SHIFT + CTRL + C SHIFT + CMD + C 

Clone Multiple… SHIFT + CTRL + M SHIFT + CMD + M 

Select All CTRL + A CMD + A 

Undo CTRL + Z CMD + Z 

Close Project CTRL + W CMD + W 

Database CTRL + B CMD + B 

Stale Locks CTRL + K CMD + K 

User Preferences CTRL + U or CTRL CMD + U 

Refresh F5 Not applicable 

Full View SHIFT + CTRL + F SHIFT + CMD + F 

Previews SHIFT + CTRL + P SHIFT + CMD + P 

Print Project Report CTRL + P CMD + P 

Preview Project Report CTRL + R CMD + R 
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Hide Metrix CTRL + H CMD +H 

Hide Others CTRL + ALT + H CMD + OPT + H 

Quit Metrix CTRL + Q CTRL + Q 

Scale to Fit CTRL + 0 CMD + 0 

Pan across on the Layout – hold down 
these keys 

CTRL + spacebar OPT + spacebar 

Turn cursor into Marquee Zoom Tool- 
hold down these keys 

CTRL + ALT + spacebar CTRL + OPT + spacebar 

Step-and-Repeat product instances, 
snap to bleed edge. For more 
information, see Step and Repeat 
using Drag and Drop. 

ALT + drag OPT + drag 

Step-and-Repeat product instances, 
snap to trim edge. For more 
information, see Step and Repeat 
using Drag and Drop. 

CTRL + ALT + drag CMD + OPT + drag 

Nudge product instance (moves 1mm 
or 1/16”). For more information, see 
Nudging product instances.  

CTRL + CMD + 

Step and repeat marks. For more 
information, see Creating Step and 
Repeat Marks.  

ALT + drag OPT + drag 

Select multiple product instances. SHIFT + click or drag + 
select 

SHIFT + click or drag + 
select 

Drag and snap to bleed edge. For 
more information, see Drag and drop 
product instances.  

Drag to blue outline Drag to blue outline 

Drag and snap to trim edge. For more 
information, see Drag and drop 
product instances. 

CTRL + drag to blue outline CMD + drag to blue outline 

Open “Assign Component(s) to 
Layout” 

CTRL + SHIFT + L CMD + SHIFT + L 

Automatic Production Plan CTRL + ALT + A CMD + OPT + A 

Export File CTRL + E CMD + E 

Side 1 of layout CTRL + 1 CMD +1 

Side 2 of layout CTRL + 2 CMD+ 2 
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Appendix F: The Metrix Page Reordering Tool (PRT) 
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Using the Metrix Page Reordering Tool (PRT) 

Since the pages in a PDF are not always in the proper order to work with the way Metrix performs folding, Metrix 
ships with a stand-alone application that can quickly and easily reorder the pages in a PDF document. You can 
follow these steps to use or create reordering actions for your PDF documents. 

1. On your desktop, open the folder containing the PDF files you would like to reorder. Here is an example 
of a 6-page sample file, and how the pages look when opened in Acrobat (or some other PDF reader). 

 

2. Now go to: C: > Program Files > Metrix Software > Metrix (on Windows) 

Hard Drive > Applications > Metrix Software > Metrix (on Mac) 

3. Double-click the MetrixPRT.exe (MetrixPRT.app) file to open the Metrix Page Reordering Tool (PRT). A 
window will open on the desktop showing the sample reordering actions that are already included in the 
MetrixPRT. As you can see from the menu called Select Action above the list of actions, the selected 
action is “Example_6-pager-1, 3, 6, 2, 4, 5-.re-numbered.” 

 

4. Drag the PDF file you wish to reorder anywhere on the open window of the Page Reordering Tool 
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5. When the PDF file is processed, Metrix displays a message in the MetrixPRT window, and places the 
processed file in the same folder as the original file. 

Note The name of the new file has the extra text designated by the action used to process the PDF 
file. The reordering process is very fast, even with very large documents. 

6. Open the reordered PDF file in Acrobat. You will see that the pages are now in the order designated by 
the action selected in the Metrix Page Reordering Tool. 

 

Of course, the Page Reordering Tool becomes useful when you make your own reordering actions. 

7. When you close the MetrixPRT for the first time, a file called “MetrixPRT.properties” will be generated in 
the Metrix folder in the ProgramData folder on your hard drive. So, if you have not closed the MetrixPRT 
yet, do so now. 

8. Now, navigate to the MetrixPRT.properties file at: 

 C: > ProgramData > Metrix Software > Metrix (on Windows) Hard Drive > Applications > Metrix 
Software > Metrix (on Mac) and double-click to open it in text-editing mode. 
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9. You will probably want to remove all of the example actions that ship with the MetrixPRT. When you 
have done that, place your cursor after the last line, and type your new action following this order: 

 [Action Name][=][Page numbers followed by commas][Separator (such as . or -)] 

 [Extra text to designate the new file (such as “reordered,” “re­numbered,” or “changed”)] 

Note There should be no spaces in the entire string of text. 

In the example below, the Action Name is “6-Page-Brochure,” then the “=” sign, then the numbers 
(followed by commas), a separator character, and the extra text, resulting in: 6-Page-Brochure-
1,4,3,2,5,6, changed. 

 

Note Because this order is related to Metrix folding, the content of the pages is irrelevant. Only the 
order of the pages is considered by the MetrixPRT. For example, the “2” in this sample action 
means that the second page of the original PDF should become the 4th page in the new PDF. 
The content on that page does not matter to the PRT. 

10. Once you have completed the new action, close the MetrixPRT.properties file, allowing the text-editing 
program to save the changes to the file. You can only save changes to the MetrixPRT.properties file 
while the PRT is not running. 

 Now go back and open the MetrixPRT.exe file. Your new action should be listed in the Select Action 
menu. If it is not, then use the menu to select your new action. 

 Now drag the PDF file called “6­Page Sample” onto the window of the PRT. 
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11. When you drop the file onto the PRT window, the PRT will process the file, give you a message in the 
PRTwindow, and tell you that a new file has been saved in the same folder as the original file. 

 The new file will have the same name as the original sample file, but with the extra text you designated 
when you created the action. 

12. Open the new PDF file in Acrobat (or some other PDF reader). You should see the pages reordered 
according to the sequence you designated in the action you created. 

 

Tip If you have different PDF files that need to be reordered on a regular basis, you can create 
multiple actions in the MetrixPRT.properties file, and then save the properties file. (Remember: 
You can only save changes to the MetrixPRT. properties file while the PRT is not running.) 
Then open multiple copies of the MetrixPRT.exe file by double-clicking the file multiple times. 

13. Now select a different action for each copy of the PRT you have open. You can then drag PDF files into 
different windows to reorder them in different ways. 

Notes If you are working on the Mac, you will need to make multiple copies of the MetrixPRT program, 
and open one copy for each action you wish to run. 

 Remember that the number of pages in the PDF file must always match the number of pages in 
the MetrixPRT action. 


